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m About the Axiom™ 2.0 Assay 384HT Array Format Automated Workflow ...................... 9

m Overview of the Axiom™ 2.0 Assay 384HT Array Format Automated Workflow on the
Biomek™ i7 Automated Workstation

About the Axiom™ 2.0 Assay 384HT Array Format
Automated Workflow

The Axiom™ 2.0 Assay 384HT Array Format Automated Workflow is a workflow for high-throughput
microarray genotyping. The workflow includes:

* Automated DNA target preparation on the Beckman Coulter™ Biomek™ i7 Automated Workstation:
DNA amplification, fragmentation, purification, and resuspension of the target in hybridization
cocktail.

¢ Transfer of hybridization-ready target DNA to the Applied Biosystems™ GeneTitan™ Multi-Channel
(MC) Instrument followed by automated, hands-free hybridization, staining, washing, and imaging.

* Processing of CEL files that are generated by the GeneTitan™ MC Instrument, using the Axiom™
Genotyping Algorithm version 1 (Axiom GT1), available through Applied Biosystems™ Analysis
Power Tools or Axiom™ Analysis Suite v2.0 or later.

Traceability of samples is enabled with the use of barcoded consumables.

The Axiom™ 2.0 384HT Reagent Kit provides all necessary reagents for target preparation in volumes
that are optimized for processing on the Biomek™ i7.

About the Axiom™ Genotyping Solution

The Axiom™ 2.0 Assay 384HT Array Format Automated Workflow is part of the Axiom™ Genotyping
Solution. The Axiom™ Genotyping Solution is a genotyping microarray platform that includes novel
assay biochemistry, array configuration and processing, and automated target preparation on various
array plate formats. It offers the capability to genotype approximately 65,000 variants (of single
nucleotide polymorphisms (SNPs) and insertion/deletion polymorphisms (indels) from diploid species
or 43,000 variants from polyploid species, with a processing throughput of greater than 3,000 samples
per week.

Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7 9
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About the Axiom™ 2.0 Assay 384HT Array Format Automated Workflow

High-throughput genotyping through microarray technology has applications in human disease research
and basic and applied agriculture research.

* For human disease research applications, Thermo Fisher Scientific conducted an empirical screen
of genomic content from dbSNP (ncbi.nim.nih.gov/projects/SNP/). The screen included markers
from HapMap and the 1,000 Genomes Project and other sources, using HapMap phase 3 samples
and/or the original 270 HapMap samples. All this information has gone into creating a proprietary
database of verified markers that can be interrogated using the Axiom™ 2.0 Assay.

* For agriculture applications, the Axiom™ Genotyping Solution can genotype samples using DNA
extracted from leaves and seeds, playing an important role in genotype-trait association studies
and marker-assisted selection in both plant and animal breeding programs.

* For molecular breeding programs, where turn-around time, accuracy, and ease-of-use are all
important, the Axiom™ Genotyping Solution is ideal for high-throughput screening.

The Axiom™ 96-array layout and the Axiom™ 384HT-array layout retain full compatibility with the existing
Axiom™ instrumentation platform and downstream data analysis.

10 Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7
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Overview of the Axiom™ 2.0 Assay 384HT Array Format
Automated Workflow on the Biomek™ i7 Automated
Workstation

Genomic DNA preparation
Day 1 Chapter 2, Genomic DNA preparation
v

Target preparation

Day 1 Stage 1: Amplify the genomic DNA o
(Biomek™ i7) 23-hour of Amplification Plate at
37°C.
Optional stopping point.
v
Day 2 “Stage 2A: Fragment and precipitate the DNA” on page 66 Overnight precipitation at —20°C.
(Biomek™ i7)
v
Day 3 Stage 2B: Centrifuge and dry pellets @
(Off-deck) Optional stopping point.
v

Day 3  Stage 3: Prepare the resuspension and hybridization reagent mixture
(Biomek™ i7 and off-deck)

v
Day 3 Stage 4: Reassemble Hybridization Ready Plate and perform sample QC @
(Biomek™ i7) Optional stopping point.
v
Day 3 Stage 5: Denature sample and transfer to hybridization tray 23.5 to 24-hour array hybridization
(Biomek™ i7 and off-deck) in the GeneTitan™ MC Instrument.
v
Day 4 Stage 6: Prepare GeneTitan™ reagents

(Biomek™ i7)
Array processing

Day 5 Process array plates with the GeneTitan™ instrument (page 119) Fluidics: 5 hours

Array processing is completed with the GeneTitan™ MC Instrument and Scan: ~5.5 hours

GeneChip™ Command Console™ software v4.3 or later.

Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7 11
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Overview of the Axiom™ 2.0 Assay 384HT Array Format Automated Workflow on the Biomek™ i7 Automated Workstation

Multiplate workflows

Thermo Fisher Scientific supports high-throughput workflows that allow you to run a set of samples and
array plates through the protocol using a minimum number of personnel and an extended week. The
timing of steps is critical because of the following limits:

* Incubation for DNA amplification is 22—24 hours.

* Hybridization in the GeneTitan™ MC Instrument is 24 hours.

* Reagent trays for wash/stain/imaging must be prepared as hybridization finishes.

* Limits to when a second hybridization tray and array plate can be loaded into the GeneTitan™ MC
Instrument.

Contact your local support representative for more information.

GeneTitan™ reagent tray barcodes

12

GeneTitan™ MC Instrument consumables and Applied Biosystems™ GeneChip™ Command Console™
(GCC) are required for the preparation of the Axiom™ 2.0 stain reagents. Each tray has a unique part
number and barcode that offers traceability. These trays have the following labels and barcodes:

384 Layout GeneTitan™ Stain Tray applled FOR RESEARCH
00 AR v || BOSSes i —@
384 Layout Axiom™ Stain2 Tray applied R EEEAREY
5013941234567070914598 PT'PS;/?EG_TS USE ONLY _@
y Thermo Fisher Slentific
384 Layout Axiom™ Ligation Tray app"ed FOR RESEARCH
00 AR e ey || B | R | —@)
384 Layout Axiom™ Stabilization Tray app"ed FOR RESEARCH
LA e sebtzsion || BRysies | hEaat | —@

Figure 1 GeneTitan™ reagent tray barcodes and color-coded labels.

(@) Stain 1 Tray—Part No. 501279 (3 Ligation Tray—Part No. 501398
(2 Stain 2 Tray—Part No. 501394 (@) Stabilization Tray—Part No. 501396

The unique barcodes along with the GeneChip™ Command Console™ v3 or later software prevents
users from making errors when placing the trays in the GeneTitan™ MC Instrument during stage 3 of the
array processing (“Stage 3—Ligate, wash, stain, and scan” on page 134).

It is critical to place the trays in the correct position on the Biomek™ i7 deck and then scan the labware
barcodes with the handheld barcode scanner exactly as shown in the Biomek™ i7 deck setup window.

After the trays have been prepared on the Biomek™ i7 deck, ensure that the trays are placed in
the appropriate drawer location in the GeneTitan™ MC Instrument. Failure to place the proper tray
in the correct location results in an error and the GeneTitan™ MC Instrument will not proceed with
the processing of the trays. See “Proper tray alignment and placement” on page 143 for detailed
instruction.
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Overview of the Axiom™ 2.0 Assay 384HT Array Format Automated Workflow on the Biomek™ i7 Automated Workstation

GeneChip™ Command Console™ v4.3 or later also offers the facility for queuing a second plate for
scanning before the first scan is complete. The software automatically moves the second plate into the
scanner when the first plate has completed scanning. See “Queue a second plate for scanning” on
page 133 for instructions.
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The general requirements for genomic DNA (gDNA) sources and extraction methods are described

in this chapter. The success of this assay requires uniform amplification of the genome starting with
relatively intact gDNA. To achieve uniform amplification, the gDNA must be of high quality, and must be
free of contaminants that can affect the enzymatic reactions to be performed.

Sources of genomic DNA

The following sources of gDNA have been successfully tested in the laboratories at Thermo Fisher
Scientific for DNA that meets the requirements for the Axiom™ 2.0 Assay.

Source Sample type

Human | ¢ Blood
* Saliva
* (Cellline

*  WGA preamplified DNA: Genomic DNA amplified with the REPLI-g™ Kit (a whole-genome
amplification kit, QIAGEN™, Cat. No. 150025) has been tested successfully with the Axiom™
2.0 Assay. The REPLI-g™ Kit was used to amplify 20-ng genomic DNA, and the resulting
yields quantitated by a PicoGreen™ assay. The amplified products (either 100 ng or
200 ng amplified DNA as required according to the Axiom™ array type) were used (without
purification) as the input DNA sample in the subsequent steps in the Axiom™ 2.0 Assay. The
stability of this amplified product to storage and repeated cycles of freeze/thaw has not been
evaluated by Thermo Fisher Scientific.

Animallll| ¢ Blood

e Semen

* Nasal swabs
* Hair bulbs

* Ear punch tissue

14 Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7



Chapter 2 Genomic DNA preparation 5
General requirements

(continued)

Source Sample type

Plant | ® Seeds
* |eaves

' Success with sample types other than human depend on quality (degree of degradation, level of purity, and so on) and quantity of
gDNA extracted.

Note: DNA derived from formalin-fixed paraffin-embedded (FFPE) blocks must not be used with this
assay.

General requirements

¢ Starting DNA must be double-stranded for accurate concentration determination.

¢ DNA must be of high purity. DNA must be free of DNA polymerase inhibitors. Examples of inhibitors
include high concentrations of heme (from blood) and high concentrations of chelating agents (that
is, EDTA). The gDNA extraction and purification method must create DNA that is salt-free because
high concentrations of particular salts can also inhibit enzyme reactions. Assess DNA purity by
measuring the OD260/OD280 and OD260/0D230 ratios. The OD26Q/OD280 ratio should be between
1.8 and 2.0 and the OD5gq/ODo3 ratio should be greater than 1.5. We recommend that DNA
samples that do not meet these criteria be cleaned up as described in “Clean up genomic DNA” on
page 17.

* DNA must not be degraded. The average size of gDNA can be evaluated on a 1% agarose gel
using an appropriate size standard control. Approximately 90% of the DNA must be greater than
10 Kb in size. Control DNA can be run on the same gel for comparison.

Note: DNA size integrity is important for successful assay performance. It is strongly advised to
assess gDNA by gel electrophoresis as described in this chapter. This is of particular importance
for DNA extracted from saliva and buccal cells, sample types prone to DNA degradation.

Special requirements

Preampilification area

Precautions are required when manipulating genomic DNA to avoid contamination with foreign DNA
amplified in other reactions and procedures. It is recommended that genomic DNA manipulations are
performed in a dedicated preamplification room or area separate from the main laboratory.

This preamplification area requires a dedicated set of pipettes and plasticware. If no dedicated area is
available, use of a dedicated bench or a dedicated biosafety hood and dedicated pipettes is suggested.
If no dedicated bench or biosafety hood is available, a set of dedicated pipettes is recommended.

Ideally, this preamplification area would be separate from the amplification staging area, however, these
areas may be combined due to space and equipment limitations.

Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7 15
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General requirements

Evaluate the quality of genomic DNA with 1% agarose E-Gel™

We recommend this quality control step to evaluate the quality of the gDNA before starting the assay.

Equipment and reagents required

Unless otherwise indicated, all materials are available through thermofisher.com.

ltem Source
E-Gel™ Power Snap Plus Electrophoresis Device G9110
iBright™ CL750 Imaging System A44116
Invitrogen™ E-Gel™ 48 Agarose Gels, 1% G800801
Invitrogen™ RedilLoad™ Loading Buffer 750026
Invitrogen™ E-Gel™ 96 High Range DNA Marker 12352019

Guidelines for preparing the gDNA Sample Plate for gel analysis

The following guidelines are recommended when preparing the gDNA Sample Plate for gel analysis.

* Load a DNA mass of 10 ng to 20 ng per well (recommended). If lower amounts are loaded,
omission of the loading dye is recommended to improve visualization. Loading =25-ng gDNA per
well can improve the image.

* Add 3 pL of 0.1X of RediLoad™ Loading Buffer (RediLoad™ Loading Buffer dye diluted 10-fold with
nuclease-free water) dye to each sample.

* Bring each sample to a total volume of 20 pL using nuclease-free water. For example, if the volume
of genomic DNA is 5 pL, add 3 pL of RediLoad™ Loading Buffer, then bring to 20 pL total by adding
12 uL of water.

* Seal, vortex, and centrifuge briefly.
Run a 48-lane 1% agarose E-Gel™
1. Insert the E-Gel™ 48 Agarose Gels, 1% into the electrophoresis unit.
2. Remove 2 combs.
3. Load 20 pL of gDNA samples onto the E-Gel™ 48 Agarose Gels, 1%.

4. If needed, load 15 pL of diluted E-Gel™ 96 High Range DNA Marker (1:3 dilution or ~0.34X from
stock) into all marker wells.

5. Fill all empty wells with water.
6. Run the gel for ~27 minutes.

When run time is reached (the ladder band reaches the end of the lane), the system automatically shuts
off. The gel is ready for imaging.

16 Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7
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Chapter 2 Genomic DNA preparation 5
Genomic DNA extraction and purification methods

E-Gel™ results

The following figure shows gel images of intact gDNA (that is appropriate for use in the Axiom™

2.0 Assay) and degraded gDNA samples. For gDNA that is degraded perform a test experiment to
investigate the performance of the samples in the Axiom™ 2.0 Assay before starting any large-scale
genotyping projects.

10 kb —
4 kb —

2kb —

0.8 kb —

0.4 kb —

® ®

Figure 2 Gel images with intact gDNA and degraded gDNA.

@ Intact samples @ Degraded samples

Genomic DNA extraction and purification methods

Genomic DNA extraction and purification methods that meet the general requirements that are outlined
are expected to yield successful results. Methods that include boiling or strong denaturants are

not acceptable because the DNA would be made single-stranded and can no longer be accurately
quantified using a PicoGreen™-based assay.

Clean up genomic DNA
If a gDNA preparation is suspected to contain inhibitors, the following cleanup procedure can be used.
1. Add 0.5 volumes of 7.5 M NH,OAc, 2.5 volumes of absolute ethanol (stored at —20°C), to gDNA.
2. Vortex, then incubate at —20°C for 1 hour.
3. Centrifuge at 12,000 x g in a microcentrifuge at room temperature for 20 minutes.
4. Remove supernatant, then wash pellet with 80% ethanol.
5. Centrifuge at 12,000 x g at room temperature for 5 minutes.
6. Remove the 80% ethanol, then repeat the 80% ethanol wash 1 more time.

7. Resuspend the pellet in Reduced EDTA TE Buffer (10 mM Tris-HCI pH 8.0, 0.1 mM EDTA).
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Genomic DNA preparation

This step must be done before proceeding with the DNA amplification stages for automated target

preparation.

The genomic DNA (gDNA) you process using the Axiom™ 2.0 Assay must meet the general
requirements that are listed earlier in this chapter. The amount of gDNA depends on which Axiom™
array is used in the downstream protocol. “Genomic DNA input requirements” on page 18 details the
sample input requirements for Axiom™ 2.0 Assay 384HT Array Format Automated Workflow.

Genomic DNA input requirements

Sample type Volume per well Input mass per well gDNA concentration
Human 8.7 L 100 ng 11.5 ng/pL
Diploid plants and animals 8.7 uL 150 ng 17.2 ng/pL
Polyploid plants and animals 8.7 uL 200 ng 23 ng/pL

Time required

Allow 30-60 minutes for reagents to thaw and 30 minutes for setup.

Equipment, consumables, and reagents required

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Equipment and consumables required

Quantity

Item

As required

Adhesive seals for plates

1

Ice bucket, filled with ice

1 each Pipettes: single channel P10 or P20
Optional: multichannel P10 or P20
As required | Pipette tips

18
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Genomic DNA preparation

(continued)
Quantity Item
1 384 deepwell plate
* Axygen™ 384-well clear V-bottom 240 pL polypropylene deepwell nontreated plate, sterile
(Cat. No. P-384-240SQ-C-S).
Note: The 384 deepwell plate is used to store the gDNA samples and are processed in
the target preparation method using the Biomek™ i7. To avoid error, see Chapter 4, “Target
preparation with the Biomek™ i7 Automated Workstation (method version 1.1, AB kit)” for the
correct deepwell plate to use.
A CAUTION! Using the wrong 384 deepwell plate type will result in physical
interference into the Thermoshake adapter and prevent the run from proceeding.
1 Plate centrifuge
1 Plate spectrophotometer
Required only if no OD measurements are available for samples.
1 Vortexer
Reagents

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Reagent Source

Axiom™ Genomic DNA Standard (Ref 103), -20°C 951957
(use as a positive control if genotyping human samples).

Thermo Scientific™ Reduced EDTA TE Buffer (10 mM Tris-HCI pH 8.0, 0.1 mM EDTA). | Fisher Scientific™,

AAJ75793AE

Positive control gDNA (if genotyping nonhuman samples).

Ultra-pure water, from a purification system or equivalent. MLS

Thaw samples and control

Thaw the following components to room temperature.

¢ 9gDNA samples

* gDNA positive control sample. For human studies, use Genomic DNA Standard (Ref 103).

To thaw, either:

¢ Place items on the bench top for 60 minutes.
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¢ Thaw in a water bath.
— Fill a small plastic dish with ultra-pure water. Do not overfill to prevent the level of the water
overflowing when the sample tubes or plates are placed in the bath.

— Thaw the sealed gDNA Sample Plate and reference sample for 30 minutes.

—  Wipe off the gDNA Sample Plate after removing from the water bath, and before removing the
lid. Wiping off the gDNA Sample Plate minimizes the chances that the water enters the wells,
then causes contamination or reaction failure.

Quantitate and dilute gDNA
1. Gently vortex (50% maximum), then centrifuge the gDNA and control DNA.

2. Recommendation: Quantitate each sample (for example, using the Quant-iT™ PicoGreen™ dsDNA
Assay Kit).

3. Using reduced EDTA TE buffer, dilute each sample to a concentration of:

* 11.5 ng/pL for human DNA samples
* 17.2 ng/pL for diploid plant and animal DNA samples
* 23 ng/pL for polyploid plant and animal DNA samples

4. Seal, vortex, then centrifuge.

Aliquot the diluted samples and the control

The samples and control are placed in a 384 deepwell 250-pL plate for target preparation.

1. Aliquot 8.7 L of each diluted gDNA sample to the deepwell plate (this amount is the equivalent of
100-200 ng of gDNA, as required by the sample type).

2. Aliquot 8.7 pL of the control DNA to the deepwell plate.

Note: We recommend including at least 1 positive control on each plate.

3. Seal, then centrifuge.

Freeze or proceed

Do one of the following:

* Store the gDNA Sample Plate at —20°C.

* Proceed to DNA amplification for automated target preparation (see Chapter 4, “Target preparation
with the Biomek™ i7 Automated Workstation (method version 1.1, AB kit)”).

Note: If proceeding immediately to DNA amplification, you can leave the gDNA Sample Plate at
room temperature.

20 Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7



Chapter 2 Genomic DNA preparation ~ [#5¥¥
GeneTitan™ Array Plate Registration file

GeneTitan™ Array Plate Registration file

Each array plate has a barcode for tracking and each row and column number identifies an individual
array. The GeneTitan™ Array Plate Registration file is where you enter the sample information for

each individual array of the array plate to be run. It is important to create and upload a GeneTitan™
Array Plate Registration file before loading the array plate and hybridization tray onto the GeneTitan™
Multi-Channel (MC) Instrument or the GeneTitan™ MC Fast Scan Instrument. We recommend that you
create, but not upload, this file while you prepare your plate of genomic DNA. When samples are ready
for hybridization, scan the array plate barcode and upload the file to Applied Biosystems™ GeneChip™
Command Console™ (GCCQC).
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Create and save a GeneTitan™ Array Plate Registration file

This procedure creates and saves a GeneTitan™ Array Plate Registration file but does not upload the
file to GeneChip™ Command Console™. The array plate and hybridization tray are scanned, and the
GeneTitan™ Array Plate Registration file is uploaded when you are ready to load the plate and samples
onto the GeneTitan™ MC Instrument for processing.

1. From the Launcher window, open GCC Portal » Samples » GeneTitan™ Array Plate
Registration.

2. In the GeneTitan Array Plate Registration window, click to select a registration file template to
use.

3. Select the GeneTitan™ Array Plate Type from the dropdown list.
4. Select the project for the sample files.
5. Click Download.

6. Inthe Samples tab of the GeneTitan™ Array Plate Registration window, enter a unique name for
each sample and any additional information.

For more information on the GeneTitan™ Array Plate Registration file, see GeneChip™ Command
Console™ User Guide.

7. Save the file. Do not upload the file at this point.

Details for the array plate and hybridization tray scanning steps, and the GeneTitan™ Array Plate
Registration file uploading steps are in Chapter 5, “Process array plates with the GeneTitan™
instrument”.
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o

GeneTitanArrayPlateRegistration_40.xlsx [Compatibility Mode] - Microsoft Excel non-commercial use - X
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1 |Sample File Path Project Plate Type Probe Array Type Probe Arr Barcode Sample File Name Array Name Hyb Tray Barcode:*:Text Sample Tray Barcode:™:Text

2 Default 384 AIMS-384 384 AIMS AD1 "5504121127111111111000 Sample A01 Sample_A01 202757 2027123

3 Default 384_AIMS-384 384_AIMS A2 £504121127111111111000 ISamEIe A02 _|Samp\e_A[]2 202757 2027123

4 Default 384 AIMS-384 384 AIMS AD3 5504121127111111111000  Sample_A03 Sample_A03 202757 2027123

5 Default 384_AIMS-384 384_AIMS A4 5504121127111111111000  Sample_A04 Sample_A04 202757 2027123

6 Default 384 AIMS-384 384 AIMS AD5 5504121127111111111000  Sample_A05 Sample_A05 202757 2027123

[ Default 384_AIMS-384 384_AIMS A0B 5504121127111111111000  Sample_A06 Sample_A06 202757 2027123

8 Default 384 AIMS-384 384 AIMS AOT £504121127111111111000  Sample_A07 Sample_A0T 202757 2027123

9 Default 384_AIMS-384 384_AIMS A8 5504121127111111111000  Sample_A08 Sample_A08 202757 2027123

10 Default 384 AIMS-384 384 AIMS A0S £504121127111111111000  Sample_A09 Sample_A09 202757 2027123

11 Default 384_AIMS-384 384_AIMS A10 5504121127111111111000  Sample_A10 Sample_A10 202757 2027123

12 Default 384 AIMS-384 384 AIMS A1 5504121127111111111000 Sample_A11 Sample_A11 202757 2027123

13 Default 384_AIMS-384 384_AIMS A12 5504121127111111111000  Sample_A12 Sample_A12 202757 2027123

14 Default 384 AIMS-384 384 AIMS A13 5504121127111111111000  Sample_A13 Sample_A13 202757 2027123

15 Default 384_AIMS-384 384_AIMS A4 5504121127111111111000  Sample_A14 Sample_A14 202757 2027123

16 Default 384 AIMS-384 384 AIMS A15 5504121127111111111000  Sample_A15 Sample_A15 202757 2027123

17 Default 384_AIMS-384 384_AIMS A16 5504121127111111111000  Sample_A16 Sample_A16 202757 2027123

18 Default 384 AIMS-384 384 AIMS A1T £504121127111111111000  Sample_A17 Sample_A17 202757 2027123

19 Default 384_AIMS-384 384_AIMS Al 5504121127111111111000  Sample_A18 Sample_A18 202757 2027123

20 Default 384 AIMS-384 384 AIMS A9 5504121127111111111000  Sample_A19 Sample_A19 202757 2027123

21 Default 384_AIMS-384 384_AIMS A20 5504121127111111111000  Sample_A20 Sample_A20 202757 2027123

22 Default 384 AIMS-384 384 AIMS A21 5504121127111111111000 Sample_A21 Sample_A21 202757 2027123

23 Default 384_AIMS-384 384_AIMS A22 5504121127111111111000  Sample_A22 Sample_A22 202757 2027123

24 Default 384 AIMS-384 384 AIMS A23 5504121127111111111000  Sample_A23 Sample_A23 202757 2027123

25 Default 384_AIMS-384 384_AIMS A24 5504121127111111111000  Sample_A24 Sample_A24 202757 2027123

26 Default 384 AIMS-384 384 AIMS B01 5504121127111111111000  Sample_A25 Sample_A25 202757 2027123

27 Default 384_AIMS-384 384_AIMS B02 5504121127111111111000  Sample_A26 Sample_A26 202757 2027123

28 Default 384 AIMS-384 384 AIMS B03 £504121127111111111000  Sample_A27 Sample_A27 202757 2027123

29 Default 384_AIMS-384 384_AIMS B4 5504121127111111111000  Sample_A28 Sample_A28 202757 2027123

30 Default 384 AIMS-384 384_AIMS B05 5504121127111111111000  Sample_A29 Sample_A29 202757 2027123

N Default 384_AIMS-384 384_AIMS BO6 5504121127111111111000  Sample_A30 Sample_A30 202757 2027123

32 Default 384 AIMS-384 384_AIMS BO7 5504121127111111111000  Sample_A31 Sample_A31 202757 2027123

33 Default 384_AIMS-384 384_AIMS B03 5504121127111111111000  Sample_A32 Sample_A32 202757 2027123

M Default 384 AIMS-384 384_AIMS B09 5504121127111111111000  Sample_A33 Sample_A33 202757 2027123

35 Default 384_AIMS-384 384_AIMS B10 £504121127111111111000  Sample_A34 Sample_A34 202757 2027123

36 Default 384 AIMS-384 384_AIMS B11 5504121127111111111000  Sample_A35 Sample_A35 202757 2027123

37 Default 384_AIMS-384 384_AIMS B12 £504121127111111111000  Sample_A36 Sample_A36 202757 2027123

38 Default 384_AIMS-384 384_AIMS B13 £504121127111111111000  Sample_A37 Sample_A37 202757 2027123

39 Default 384_AIMS-384 384_AIMS B14 £504121127111111111000  Sample_A38 Sample_A38 202757 2027123

40 Default 384_AIMS-384 384_AIMS B15 £504121127111111111000  Sample_A39 Sample_A39 202757 2027123

M Default 384_AIMS-384 384_AIMS B16 £504121127111111111000  Sample_A40 Sample_A40 202757 2027123

42 Default 384_AIMS-384 384_AIMS B17 £504121127111111111000 Sample_A41 Sample_A41 202757 2027123

43 Default 384_AIMS-384 384_AIMS B18 5504121127111111111000  Sample_A42 Sample_A42 202757 2027123

44 Default 384_AIMS-384 384_AIMS B19 5504121127111111111000  Sample_A43 Sample_A43 202757 2027123

45 Default 384 AIMS-384 384 AIMS B20 5504121127111111111000  Sample_Ad4 Sample_A44 202757 2027123

M 4 » M| Samples %1 I_ Jil

Ready [EEEET e

Figure 3 Example of a GeneTitan™ Array Plate Registration file for Axiom™ 384HT Array Plate.
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This chapter contains information describing the procedures, equipment, and materials required for
running the Axiom™ 2.0 Assay 384HT Array Format Automated Workflow. To help ensure operator safety
and assay performance, operators must be familiar with this content before starting target preparation
described in Chapter 4, “Target preparation with the Biomek™ i7 Automated Workstation (method
version 1.1, AB kit)”. Additional information for the Biomek™ i7 Automated Workstation is in the user
documents from Beckman Coulter™. See Appendix H, “Documentation and support” for details.

Equipment required

Applied Biosystems™ equipment required

4 Item Cat. No.
I~ | GeneTitan™ Multi-Channel Instrument('] Contact Thermo Fisher Scientific

[~ | Digital Scanner/Barcode Reader (to enable barcode tracking) 74-0016

External Barcode Reader Holder (to enable barcode tracking) 00-0093

' For a complete list of all equipment and supplies required for GeneTitan™ Multi-Channel Instrument installation and operation, consult
the GeneTitan™ Multi-Channel Instrument Site Preparation Guide (Pub. No. MAN0025571)

Oven requirements

We

recommend using either the Thermo Scientific™ Heratherm™ Advanced Protocol Microbiological

Incubator, BINDER™ ED 56 Drying and Heating Chamber, or the BINDER™ BD 56 Standard-Incubator
with natural convection that are listed in the following table. If another oven is used, it must meet the
following requirements.

24

Be able to maintain a constant temperature of 37°C for at least 24 hours, and have a temperature
accuracy of +1°C, and

Be able to maintain a constant temperature of 48°C for at least 24 hours, and have a temperature
accuracy of +1°C.
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Equipment required
Unless otherwise indicated, all materials are available through thermofisher.com.
v |ltem Source
I | Thermo Scientific™ Heratherm™ Advanced Protocol Microbiological
Incubator, capacity 66 L e 51028066
e 120V, 60 Hz e 51028133

* 230V, 50/60 Hz

I | BINDER™ ED 56 Drying and Heating Chamber
e EDO056UL-120V Voltage: 120 V 1~60 Hz .
e ED056-230V Voltage: 230 V 1~50/60 Hz .

BINDER™ 9010-0334
BINDER™ 9010-0333

I | BINDER™ BD 56 Standard-Incubator with natural convection

* GeneChip™ Hybridization Oven 645!"]

e BDO056UL-120V Voltage: 120V 1~60 Hz e BINDER™ 9010-0324
* BD056-230V Voltage: 230 V 1~50/60 Hz e BINDER™ 9010-0323
I Optional—for low throughput of 3 or fewer array plates per week: e 00-0331

' The GeneChip™ Hybridization Oven 640 is currently not supported with the Axiom™ 2.0 Assay. However, to use it in the workflow
contact your field service engineer (FSE) or Thermo Fisher Scientific Technical Support regarding the compatibility of this oven with

the Axiom™ 2.0 Assay.
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Equipment required
Spectrophotometer
Unless otherwise indicated, all materials are available through thermofisher.com.
Quantity ltem Source
1 Multiskan™ Sky Microplate Spectrophotometer 51119600

Thermal cycler

Unless otherwise indicated, all materials are available through thermofisher.com.

We have verified the performance of this assay using the following off-deck thermal cyclers in their
384-well block configurations:

* ProFlex™ 2 x 384-well PCR System (Cat. No. 4484077)
* GeneAmp™ PCR System 9700 with dual 384-well sample block module (gold, silver, or aluminum)

The performance of this assay has not been verified with other thermal cyclers. Use of other thermal
cyclers can result in assay failure and may violate the Axiom™ Array and Reagent Replacement policy.

Shakers

Unless otherwise indicated, all materials are available through thermofisher.com.

We recommend using one of the following shakers.

ltem Source
Thermo Scientific™ Digital Microplate Shaker 88882005 or 88882006
Thermo Scientific™ Compact Digital Microplate Shaker Fisher Scientific™ 88880023 or 88880024
Jitterbug™ Boekel Scientific™: 130000 (115V), 130000-2 (230V)
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Equipment required

Plate centrifuge

One plate centrifuge is required for the Axiom™ 2.0 Assay. The plate centrifuges listed in Table 1 are
recommended for the Axiom™ 2.0 Assay 384HT Array Format Automated Workflow. When centrifuging
and drying pellets, the centrifuge must be able to centrifuge plates at:

¢ rcf: 3,200 x g with an appropriate rotor/bucket combination (4,000 rpm for the Eppendorf™
Centrifuge 5810 R that is described in Table 1)

* Temperature: 4°C
Relative centrifugal force (rcf) is calculated using the following formula:
ref =(1.118 x 105 R S2

where R is the radius of the rotor in centimeters, and S is the speed of the centrifuge in revolutions per
minute.

In addition, the bottom of the rotor buckets must be soft rubber to helps ensure that the deepwell plates
do not crack. Do not use buckets where the plates sit directly on a metal or hard plastic bottom. For the
Eppendorf™ Centrifuge 5810 R, do not use the A-4-62 rotor with a WO-15 plate carrier (hard bottom).

Table 1 Plate centrifuge recommendations for the Axiom™ 2.0 Assay 384HT Array Format Automated
Workflow.

v Item Source

[ | Thermo Scientific™ Sorvall™ X4R Pro-MD Centrifuge (refrigerated), with: * 75009520(240V, 50 Hz)
o 75009521 (120 V)
e 75009620 (220 V, 60 Hz)

[~ TX-1000 Swinging Bucket Rotor Body 75003017 (rotor)
* |~ Adapter for TX-1000 Swinging Bucket Rotor ® 75007303 (adapter, pack of 4)
® |~ Buckets for TX-1000 Rotor * 75003001 (buckets, set of 4)
Eppendorf™ Centrifuge 5810 R, with: 022625551 (230 'V, 50-60 Hz)
[~ Rotor A-4-81, with 4 MTP/Flex buckets 022625501 (120 V, 50-60 Hz, 15 A)

022625101 (120 'V, 50-60 Hz, 20 A)
022638807 (rotor)
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Required materials

Other equipment required

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

v ltem Supplier | Cat. No.
Common laboratory equipment
I | Freezer, -20°C MLS -
r Refrigerator, 2°C to 8°C MLS -
I | Vortexer MLS —
I | Mini microcentrifuge, for 2 mL tubes. MLS —
[ | Bel-Art Cryo-Safe Mini Cooler, —15°C. Equivalent items from other manufacturers are MLS -
acceptable.
I llce bucket, 4 to 9 liters MLS —

Required materials

28

This section lists the labware, reagents, and consumables required for target preparation.

“Images of labware used on the Biomek™ i7 Automated Workstation deck” on page 29
“Axiom™ 2.0 384HT Reagent Kit” on page 36

“Consumables required for target preparation” on page 37

“Pipette tips” on page 38

“Axiom™ 384HT GeneTitan™ High Volume Consumables Kit” on page 39
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Images of labware used on the Biomek™ i7 Automated Workstation deck

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that the material is available from

fisherscientific.com or another major laboratory supplier.

Table 2 Labware images and ordering information.

Name in the Biomek™

1,025 pL filter tips (orange)

Labware Source Image software method
vi.101

Pipette tips, i-Series 50 pL Beckman Coulter™, B85888 BC50F

filter tips (pink)

Pipette tips, i-Series 190 pL Beckman Coulter™, B85911 BC190F

filter tips (green)

Pipette tips, i-Series Beckman Coulter™, B85955 BC1025F
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Table 2 Labware images and ordering information. (continued)

Labware

Source

Image

Name in the Biomek™
software method
v1.101

96 PCR plate

Available as a component of the
Axiom™ 384HT Consumables Kit
for Biomek™ i7-AB, Cat. No.
952472

Order separately:
Blue plate: Bio-Rad™, HSP9631
White plate: Bio-Rad™ HSP9601

Note: The Bio-Rad™Hard-Shell™
96-Well PCR Plate, low profile,
full skirted is available in several
different colors. Any color plate
can be substituted and used
successfully in this assay.
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00000000-
00000000+
00000000-

BioRad_96_Hardshell

384 PCR plate

Available as a component of the
Axiom™ 384HT Consumables Kit
for Biomek™ i7-AB, Cat. No.
952472

Order separatelyl?: , AB0937 or
952435 (10-pack)
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AbGene384PCR

96 deepwell 2-mL plate

Available as a component of the
Axiom™ 384HT Consumables Kit
for Biomek™ i7-AB, Cat. No.
952472

Order separately?: AB0932
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AbGene_96DeepSquar
e
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https://www.thermofisher.com/order/catalog/product/952472
https://www.fishersci.com/us/en/catalog/search/products?keyword=AB0932
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Table 2 Labware images and ordering information. (continued)

Name in the Biomek™

Order separatelyl?!: Fisher
Scientific™, AB1178

Barcoded plates in the
consumables kit are used for the
sample plate and non-barcoded
plates in the consumables kit are

used everywhere else.

Labware Source Image software method
vi.10l
384 deepwell 250-uL plate | Available as a component of the B === Axygen384ConePPDe
Axiom™ 384HT Consumables Kit H =) ep
for Biomek™ i7-AB, Cat. No. FREE e
952472 SESESSSESSSaREiSEsRime)

Deep 96 full reservoir

Available as a component of the
Axiom™ 384HT Consumables Kit
for Biomek™ i7-AB, Cat. No.
952472

Order separately: Thomas
Scientific™, 1149J12

| v s e

Deep96FullReservoir_
EK

384 UV plate

Available as a component of the
Axiom™ 384HT Consumables Kit
for QC Cat. No. 902289

Order separately: Thomas
Scientific™, 1184Q88

Greiner384UV

Frame for Modular
Reservoirs

Beckman Coulter™, 372795
Fisher Scientific™, NC9337243

ModularReservoir
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https://www.thermofisher.com/order/catalog/product/952472
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https://www.thermofisher.com/order/catalog/product/952472
https://www.thermofisher.com/order/catalog/product/902289

& Table2 Labware images and ordering information. (continued)

Name in the Biomek™
software method
v1.101

Image
Half Reservoir, 75 mL Beckman Coulter™, 372786 N/A
Fisher Scientific™, NC9226465 ‘

|
Quarter Reservoir, 40 mL Beckman Coulter™, 372790 N/A

Labware Source

sjeLgewW palinbay
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Fisher Scientific™, NC9168864

Quarter Reservoir, Divided Beckman Coulter™, 372792 N/A
by Width, 19 mL per Fisher Scientific™, NC9209505
section
Reagent block Tube block adapter for peltier, 24 BCTubeBlock_2mITub
positions es
Beckman Coulter™, A83054
24-Position Tube Rack Beckman Coulter™, 373661 T’_?ﬁ’_’«—’?’i”- RT_Tube_Rack
||.’l |‘Ifu 'IF’EI.%' (o

Insert, 11 mm, for 1.5-mL
Microfuge Tubes, 373696

At least two inserts in positions
A1 and B1 are required.
Additional inserts can be

present.
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Table 2 Labware images and ordering information. (continued)

Name in the Biomek™

the Axiom™ 384HT Starter Kit
for Biomek™ i7-AB, 952469 or
952471

Labware Source Image software method
vi.10l
384-Well PCR Plate Collar | Available as a component of the N/A
Axiom™ 384HT Starter Kit for -
Biomek™ i7-AB, 952469 e
Order separately: 952400
Plastic plate lid Available as a component of PlasticPlateLid

384 deep-well adapter

Available as a component of

SPelt_384_DeepWell_

Replacement PCR Plate
Sealing Pads

Replace pad according
to the manufacturer's
recommendations.

the Axiom™ 384HT Starter Kit Adapter
for Biomek™ i7-AB, 952469 or | ==
952471
Microseal™ 'P' Reusable Bio-Rad™, MSP1003 N/A
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@  Table 2 Labware images and ordering information. (continued)

N
Name in the Biomek™
Labware Source Image software method
vi.10l
Reagent block templates Axiom™ 2.0 384HT Reagent Kit (|2, = 7= gl ™ =™ 9 N/A

3|

Templates for reagent block

Thermo Fisher Scientific, Part
No. 15-0448, Part No. 15-0451

Available as a component of the
Axiom™ 384HT Starter Kit for
Biomek™ i7-AB, 952469

sjeLgewW palinbay
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Table 2 Labware images and ordering information. (continued)

Name in the Biomek™

Axiom™ 384HT Starter Kit for
Biomek™ i7-AB, 952469

Water Empty
% Reservoir | Y Reservoir

GeneTitan™ PREP (P15) — Axiom™ 2.0 384 SAMPLES (Biomek i7)

Holdin,
Empty Bufferg Empty Empty

Y Reservoir | 14 Reservoir V. Reservoir | ¥ Reservoir

FRAG & PRECIP (P10) — Axiom™ 2.0 384 SAMPLES (Biomek i7)

Frag Buffer Empty Stop Soln
% Reservoir | Vi Reservoir | Y Reservoir

RESUSP & HYB PREP (P15) — Axiom™ 2.0 384 SAMPLES (Biomek i7)

Resusp
uffer Hyb Buffer Empty

Y Reservoir | /4 Reservoir IR

DNA AMPLIFICATION (P8) — Axiom™ 2.0 384 SAMPLES (Biomek i7)

Amp Soln Empty
% Reservoir % Reservoir

GeneTitan™ PREP (P14) — Axiom™ 2,0 384 SAMPLES (Biomek i7)
Lig Buffer
Rear Empty Wash A

s Reservoir . Reservoir

Labware Source Image software method
v1.101
Reservoir frame stickers Available as a component of the fr oo RS Ess S N/A

[l The names of the labware in this column may appear different than those in the “Source” column; however, it does not affect the functionality of the methods. Use the consumables and

accessories described in the “Source” column to run method v1.1.
[ When ordered separately, this item does not have a barcode. A custom barcode is required and must be applied before running the method.
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B2 Chapter 3 Set up the Biomek™ i7 Automated Workstation
Required materials

Axiom™ 2.0 384HT Reagent Kit

Each Axiom™ 2.0 384HT Reagent Kit, Cat. No. 902245, is sufficient for one Axiom™ 384HT Array Plate.

Note: Axiom™ 2.0 384HT Reagent Kit only states "Axiom™ 2.0" on Module 1.

Component and cap color Storage
Module 1 —25°C to -15°C
Axiom™ 2.0 Denat Soln 10X Axiom™ 2.0 Amp Soln
Axiom™ 2.0 Neutral Soln Axiom™ 2.0 Amp Enzyme

Axiom™ Water

Module 2—Pouch 1 of 2 -25°C to -15°C
Axiom™ Frag Enzyme Axiom™ Hyb Buffer
Axiom™ 10X Frag Buffer Axiom™ Hyb Soln 1

Axiom™ Precip Soln 2

Module 2—Pouch 2 of 2 2°Cto 8°C
Axiom™ Frag Diluent Axiom™ Resusp Buffer
Axiom™ Frag Rxn Stop Axiom™ Hyb Soln 2

Axiom™ Precip Soln 1

Module 3 Room temperature
Axiom™ Wash Buffer A Axiom™ Water

Axiom™ Wash Buffer B

Module 4—Pouch 1 of 2 -25°C t0 -15°C
@~ xiom™ Ligate Buffer @~xiom™ Probe Mix 1

@~xiom™ Ligate Enzyme @~Axiom™ Stain Buffer

@~ xiom™ Ligate Soln 1 Axiom™ Stabilize Soln

Module 4—Pouch 2 of 2 2°C to 8°C
@~xiom™ Ligate Soln 2 @~Axiom™ Stain 2-A

@~xiom™ Probe Mix 2 @~ xiom™ Stain 2-B

.Axiomm Wash A Axiom™ Stabilize Diluent

@~xiom™ Stain 1-B Axiom™ Water

@~xiom™ Stain 1-A ()Axiom™ Hold Buffer
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Chapter 3 Set up the Biomek™ i7 Automated Workstation — EF=i®
Required materials

Consumables required for target preparation

IMPORTANT! The 384 deepwell plate used in the Axiom™ 2.0 Assay 384HT Array Format Automated
Workflow on the Biomek™ i7, method v1.1, is the Abgene™ AB1178 deepwell plate.

Axiom™ 384HT Consumables Kit for Biomek™ i7-AB
384 deepwell 250-pL plate (Abgene™ AB1178 deepwell
plate)

IMPORTANT! The 96 deepwell plate used in the Axiom™ 2.0 Assay 384HT Array Format Automated
Workflow on the Biomek™ i7, method v1.1, is the Abgene™ deepwell plate.

Axiom™ 384HT Consumables Kit for Biomek™ i7-AB H
96 deepwell 2-mL plate (Abgene™ deepwell plate) [

CAUTION! Using the wrong type of 96 deepwell plate results in liquid transfer error such as
insufficient volume being transferred or dispense tip bottoming out in the wells. Such liquid transfer
errors cause instrument interruption resulting in potential assay failure.

Table 3 Consumables required for target preparation on the Biomek™ i7 Automated Workstation,
Biomek™ method 1.1.

Contents Image per run with QC | per run without QC

Available in the Axiom™ 384HT Consumables Kit for Biomek™ i7-AB (Cat. No. 952472)!1]

384 deepwell 250-pL plate (With barcode. This is
the gDNA-containing sample plate.)

384 deepwell 250-pL plate (Without barcode.) 5 3
96 PCR plate 2 2
Deep 96 full reservoir 7 5
96 deepwell 2-mL plate 5 5
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P28 Chapter 3 Set up the Biomek™ i7 Automated Workstation
Required materials

Table 3 Consumables required for target preparation on the Biomek i7 Automated Workstation,
Biomek method 1.1. (continued)

Contents Image per run with QC | per run without QC
384 PCR plate 1 1
Additional consumables required for target preparationl?!
Half Reservoir 3 3
Quarter Reservoir 13 13
Quarter Reservoir, Divided by Width 1 1
384 UV plate 1 0

' Contains sufficient quantities to process five 384-reaction runs.
[l See Table 2 for ordering information.

Pipette tips

The following table provides the pipette tip usage for one full run of the Axiom™ 2.0 Assay 384HT Array
Format Automated Workflow on the Biomek™ i7 workstation.

Step i-'Serie.s 50 pL filter i'-Series 190 pL filter i.-Series 1,025 pL filter
tips (pink), BC50F tips (green), BC190F tips (orange), BC1025F

DNA amplification - 480 tips 35 tips
Fragmentation and precipitation — 488 tips 26 tips
Resuspension and hybridization — 384 tips 21 tips
preparation
Plate reassembly and QC 384 tips 96 tips —
Plate reassembly (without QC) 384 tips — —
Transfer samples to hybridization tray 384 tips - —
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Chapter 3 Set up the Biomek™ i7 Automated Workstation =08

(continued)

P
Required materials

i-Series 50 pL filter

i-Series 190 L filter

i-Series 1,025 pL filter

ST tips (pink), BC50F tips (green), BC190F tips (orange), BC1025F
GeneTitan™ reagent preparation - 170 tips 74 tips
Totals: with QC option 768 tips 1,618 tips 156 tips
without QC option 768 tips 1,522 tips 156 tips

Axiom™ 384HT GeneTitan™ High Volume Consumables Kit

Each Axiom™ 384HT GeneTitan™ High Volume Consumables Kit is sufficient to process 5 . These trays
are required for processing Axiom™ 384HT array format plates on the GeneTitan™ MC Instrument. See
Appendix A, “Recommended techniques for GeneTitan™ MC Instrument operation” for information on

aligning and loading trays onto the GeneTitan™ MC Instrument.

IMPORTANT! All covers must have barcodes. Discard any cover without a barcode.

Table 4 Axiom™ 384HT GeneTitan™ High Volume Consumables Kit (Cat. No. 902629).

Contentsl'] Amount Storage
384-Layout GeneTitan™ Stain Tray (Stain 1) 10
384-Layout Axiom™ Stain 2 Tray 5
384-Layout Axiom™ Stabilization Tray 5
384-Layout Axiom™ Ligation Tray 5 Room temperature
384-Layout GeneTitan™ Hybridization Tray 5
384-Layout GeneTitan™ Scan Tray 5
384-Layout GeneTitan™ Scan and Stain Tray Cover 30

[ See Table 5 for detailed descriptions of each component.

Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7
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[ Q]

Required materials

Chapter 3 Set up the Biomek™ i7 Automated Workstation

Table 5 Axiom™ GeneTitan™ tray consumables (from the Axiom™ 384HT GeneTitan™ High Volume
Consumables Kit (Cat. No. 902629).

Item

Part No.

Image

Details

384-Layout
GeneTitan™ Scan
Tray!

(@ Scan tray
protective base

@ 384-Layout

Tray

@ Barcoded scan
tray cover

GeneTitan™ Scan

The Axiom™ scan tray package includes the following:

* The GeneTitan™ scan tray includes a scan tray
cover. The tray cover should be used to cover the
scan tray before placing the tray in the GeneTitan™
MC Instrument.

* The scan tray must be protected at all times from
damage or exposure to dust. The scan tray must
be in the blue plate cover at all times except when
loaded into the GeneTitan™ MC Instrument.

* The blue scan tray protective base in the package
is used to protect the bottom of the scan tray glass
from damage. Remove the protective base from
the scan tray before loading the scan tray with the
scan tray cover in the GeneTitan™ MC Instrument.

384-Layout
GeneTitan™ Scan
Tray on blue base

This combination of the GeneTitan™ scan tray on
the protective blue base is to be placed on the
Biomek™ i7 deck during the GeneTitan™ reagent
preparation method.

Blue scan tray
protective base

202096

The blue scan tray protective base in the package is
used to protect the bottom of the scan tray glass from
damage. The blue scan tray protective base is distinct
from the blue array plate protective base and must not
be used with the array plate.

Remove the protective base from the scan tray before
loading in the GeneTitan™ MC Instrument

384-Layout
GeneTitan™ Scan
Tray with cover

Scan tray
501280

Cover 501315

The GeneTitan™ scan tray must be loaded with the
scan tray cover into the GeneTitan™ MC Instrument.

Do not load the scan tray with the protective base.

40
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Chapter 3 Set up the Biomek™ i7 Automated Workstation

gl
Required materials

Table 5 Axiom GeneTitan tray consumables (from the Axiom 384HT GeneTitan High Volume Consumables

Kit (Cat. No. 902629). (continued)

Item

Part No.

Image

Details

384 Layout
GeneTitan™ Stain
Trays

501279 - Stain
1

501394 - Stain
2

The stain trays are packaged in zip-top bags to keep
them free of dust. Each stain tray is uniquely barcoded.

IMPORTANT! Each stain tray is labeled with a name
and an individual barcode. Ensure that you always use

Hybridization Tray

@ Hybridization
tray cover to be
discarded.

501398 - the appropriate tray with the correct reagent on the
Ligation Biomek™ i7 deck. Failure to do so can result in the
501396 - wrong stain in the wrong location on the GeneTitan™
Stabilization MC Instrument and assay failure. When transferring
(@ Stain 1 tray the trays to the GeneTitan™ MC Instrument, ensure
(2 Stain 2 tray that the trays are placed in the proper location in
@ Ligation tray the drawer. Failure to do so results in an error and
(@ stabilization tray | the GeneTitan™ MC Instrument will not proceed with
processing trays.
384-Layout 501315 The 384-Layout GeneTitan™ Scan and Stain Tray
GeneTitan™ Scan Covers are provided to prevent evaporation of the
and Stain Tray GeneTitan™ reagents in stain trays and the array
Cover holding buffer in the scan tray. The GeneTitan™ scan
and stain tray covers are barcoded.
Stain tray cover, Cover 501315 The stain trays must be placed in the GeneTitan™ MC
shown on top of Instrument with the stain tray cover.
the stain tray
384-Layout 501278 The 384-Layout GeneTitan™ Hybridization Trays are
GeneTitan™ 1 | packaged in white pouches with the label "384 Layout

GeneTitan™ Hyb Tray" ref# 501278 (pouch)/902278
(box)

The hybridization trays are packaged with a protective
cover that should be discarded before use. 384
hybridization tray cover, Part No. 203006

[ After aliquoting the appropriate solution to each tray type, the tray should be loaded into the GeneTitan™ MC Instrument with the barcode
facing away from the operator. That is, the barcode should be on the back side.

Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7
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»i7 Chapter 3 Set up the Biomek™ i7 Automated Workstation
P28 Guidelines for use

Guidelines for use

Biomek™ i7 light curtain

For your safety, the Biomek™ i7 is equipped with a light curtain that covers the front of the instrument
and sides that are protected by plexiglass. The light curtain senses when an object, such as a hand or
an arm, enters the space surrounding the deck. Any penetration from outside the deck breaks the light
curtain and all movement on the workstation halts. Activity is resumed when the operator either clicks
OK to continue the activity that was taking place, or aborts the activity by clicking Stop on the toolbar.
Incubation timers are not interrupted unless the method is aborted.

Biomek Software

A light curtain violation has occurred. When you are ready to resume, press OK. The pods will move
back to where they were before the error, and the method will resume. If you wish to abort the method,
you may press the stop button on the toolbar now.

9/14/2017 10:48:54 AM

Figure 4 A message window is displayed when the light curtain has been penetrated.

Guidelines for handling plates and tubes

Unless otherwise stated in the protocol, adhere to the following guidelines when instructed to seal,
vortex, and centrifuge plates or reagent tubes.

¢ Seal plates: We recommend using MicroAmp™ Clear Adhesive Film to seal your plates.

IMPORTANT! Always ensure that your plates are tightly sealed. A tight seal prevents sample loss
and cross-well contamination.

Blot-dry: Before sealing plates, check the top of the plate to ensure that there are no droplets. If
droplets are present, blot-dry the top of the plate before sealing to help ensure a tight seal.

— To remove droplets before sealing, overlay a sheet of laboratory tissue across the top of the
plate and gently pat down to dry.
— Lift the sheet off the plate and discard. Ensure that the top of the plate is dry and seal the plate
as usual.
¢ Vortex reagent vials:
Vortex 3 times for 1 second each time at the maximum setting.
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Chapter 3 Set up the Biomek™ i7 Automated Workstation ~ [#a0¢
Guidelines for use

* Vortex plates:
— Vortex deepwell plates for 5 seconds in each of the 5 sectors. See the sectors in Figure 5.

— Vortex PCR plates for 2 seconds in each of the 5 sectors.

Note: In the procedures, vortex twice means to repeat the vortexing step.

Yeloleleleleleleolelelele
JolE T olole olelelriile
- OCLO00000ED0
> 00000 G JOOOO
- O0000LL 00000
* OO0 0 00OIFDO
cOCLO00000TO0
+ 000000000000

Figure 5 The 5 plate sectors.

* Centrifuge: When instructed to centrifuge plates or reagent vials, follow these guidelines unless
otherwise instructed.

— Plates:
— Centrifuge plate to 1,000 rpm at room temperature.

— Do not centrifuge for more than 1 minute.
— Reagent vials: Briefly centrifuge for 3 seconds.

Guidelines for a run on the Biomek™ i7

Observe the following guidelines when running the assay on the Biomek™ i7.

* When barcode tracking preference is enabled, scan the barcode label on labware after it has been
placed onto the instrument deck position to prevent error.

* Position all plates and the chilled reagent block with A1 in the upper left corner of the frame.

* Centrifuge all reagent tubes before placing in block to avoid loss of solution volume to the cap and
sides of the tube.

* Remove caps from the reagent tubes and press tubes into the block to ensure that they are fully
seated.

* All labware and reagents must be in the proper locations as illustrated in the deck setup prompt.
* Always discard the used multichannel pipette tips.
¢ Always store the reagent block at 4°C.
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Set up the instrument for the first time

Set up the instrument for the first time

Thermoshake plate adapter installation

The Thermoshake 384 deepwell plate adapter that is used with the Axiom™ 2.0 Assay 384HT Array
Format Automated Workflow method is designed specifically to fit the 384 deepwell 250-pL plate.
Proper installation is critical to ensuring even heating of the samples and proper liquid transfer in the
fragmentation step.

The Thermoshake 384 Deepwell Plate Adapter is a component of the Axiom™ 384HT Starter Kit for
Biomek™ i7-AB (Cat. No. 952469) or the Axiom™ 384HT Upgrade Kit for Biomek™ i7-AB (Cat. No.
952471).

Install the Thermoshake plate adapter

1. Ensure that the 2 notched corners are oriented facing the front of the Thermoshake 384 Deepwell
Plate Adapter.

Figure 6 Thermoshake 384 Deepwell Plate Adapter orientation on the Biomek™ i7 deck.

2. Press down firmly to ensure that adapter is evenly seated on the shaker and that the bottom
surface of the Thermoshake adapter is flush on the top surface of the shaker.

Place the reservoir labels on the reservoir frames

The reservoir labels are stick-on labels for the modular reagent reservoir frames for the different stages
of the automated workflow. These labels are color-coded to match the colors that are on the caps of
the reagent tubes in the Axiom™ 2.0 384HT Reagent Kit. Using these labels helps ensure the proper
placement of reservoirs and reagents for each step.

There are three reservoir holders that are used in the Axiom™ 2.0 Assay 384HT Array Format Automated
Workflow method. Each of the reservoir holders require templates on two sides for a total of six
templates.

Remove the protective surface from the back of the label and place on the reservoir frames as directed
in the following figures.
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Chapter 3 Set up the Biomek™ i7 Automated Workstation

DNA AMPLIFICATION (P10) — Axiom™ 2.0 384 SAMPLES (Biomek i7)

Empty

Ya Reservoir

GeneTitan™ PREP (P15) — Axiom™ 2.0 384 SAMPLES (Biomek i7)

Empty
Y4 Reservoir

Holding
Buffer
Y4 Reservoir

Empty
Y2 Reservoir

Empty
Y2 Reservoir

Figure 7 Reservoir frame 1, two sides.

DNA AMPLIFICATION (P8) — Axiom™ 2.0 384 SAMPLES (Biomek i7)

Empty
Y2 Reservoir

Lig Buffer
Rear

Empty
Y Reservoir

GeneTitan™ PREP (P14) — Axiom™ 2.0 384 SAMPLES (Biomek i7)

Wash A
Y Reservoir

Figure 8 Reservoir frame 2, two sides.

FRAG & PRECIP (P10) — Axiom™ 2.0 384 SAMPLES (Biomek i7)

Frag Buffer
Y2 Reservoir

Empty
Y4 Reservoir

Stop Soln
s Reservoir

RESUSP & HYB PREP (P15) — Axiom™ 2.0 384 SAMPLES (Biomek i7)

Resusp
Buffer

Y4 Reservoir

Hyb Buffer

Y4 Reservoir

Empty

Ya Reservoir

Figure 9 Reservoir frame 3, two sides.
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Set up the instrument for the first time

Set the method preferences

IMPORTANT! The method preferences must be selected before starting the method. These settings
are not prompted for at runtime. Typically, the Thermo Fisher Scientific field application scientist (FAS)
sets the method preferences during method installation.

1. Open the Biomek™ Software using one of the following methods:

* Double-click the Biomek 5 icon f¥ on the desktop.
* In the Windows Search box, enter Biomek 5.

2. Click File » Open.

3. For Look in of the Open Method window, select Axiom 384 on i7.

Open Method

Look in: | Axiom 384 on i7 ~ | Search:
[ New Folder Select a method:
(& Methods Name

Tl Recyded Methods () 1 ONA Ampiification Ax334_i7

D 2 Fragmentation and Predpitation Ax384_i7

D 3 Resuspension and Hybridization Preparation Ax384_i7
[ 4 Plate Reassembly and QC Ax384_i7

[ 5 Transfer samples to Hybridization Tray Ax384_i7

D 6 GeneTitan Reagent Preparation Ax384_i7

£ >

Method Mame: oK

Cancel

4. Click to select a method, then click OK.

46 Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7
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Set up the instrument for the first time

5. In the Method View panel, click the line that reads Click Here to Select Method Preferences
(Figure 10).

@ Biemek Software - 1 DNA Amplification Ax384_i7 [Revision 1]
0@ A >

Method Setup & Device Steps Liquid Hand
> ® &

IP Single Step
Manual  Home

Control Al Axes

Run  Pause Stop

Execution
R start
El Initialization Script
H-(2) Initialize Pelts

L 4 |[EBF2] — Click Here to Select Method Preferences —
~{+3 Initialization and Procedures

)

j@ Prepare Denature MM™=

+-{2) Prepare Denature Distribution Plate™
j@ Prepare Amp MM*

j@ Transfer Denature MM to Sample Plate™
=) Transfer Amp MM to Open Reservoir®
+-{) Prepare Neutral Soln Distribution Plate™
j@ Prepare AMP MM Distribution Plate
(=) Wait For Incubation

j@ Transfer Meutral Soln to Sample Plate®
+-() Transfer AMP MM to Sample Plate™
J@ End of Method Prompt and Pelt Initialization
- ] Finish

Figure 10 Click to select method preferences.
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Set up the instrument for the first time

6. Click to select the method preferences.

? Biomek Software - 1 DNA Amplification Ax384_i7 [Revision 1]
ODEA >

Method Setup 8 Device Steps Liquid Handling Steps Data Steps Control Steps Preconfigured Steps Ltilities

> pingese O A B | ¥ TR Q

Run  Pause Stop Manual  Home B Properties Cut  Copy Paste Select Delete Disable
Control  All Axes All
Execution Details Steps

Initislization Script

%Imﬁaﬁzapam Appred Axiom™ 2.0 Assay 384HT Array Format
& T biosystemns ' Y Y

(2) Initialization and Procedures
@ Prepare Denature MM™
@ Prepare Denature Distribution Plate® Select method preferences

() Prepare Amp MM*

(=) Transfer Denature MM to Sample Plate™

Logging:
@ Transfer Amp MM to Open Reservoir™ 99ing
--€2) Prepare Neutral Soln Distribution Plate™ Barcode Tracking
€2 Prepare AMP MM Distribution Plate Log Name | Default ¥ ||BarcodelogB8758118A01.txt

-€=) Wait For Incubation
@ Transfer Meutral Soln to Sample Flate®
() Transfer AMP MM to Sample Plate™
(=) End of Method Prompt and Pelt Initialization
| Finish ¥ Verify reagent module barcodes

Log Path | Default ¥ ||C:\Users\Public\Documents'Axiom 2.0 384%

Custom run options:

¢ Verify GeneTitan™ labware setup
¥/ prepare gel and OD plates for QC

Test mode

Axiom™ 2.0 Assay 384HT Array Format
Version 1.1

600822
d Affymetrix Inc, 3450 Central Expressway, Santa Clara, CA 95051 USA @
Support thermofisher.com/support

For Research Use Only. Mot for use in diagnostic procedures.
©2020 Thermo Fisher Scientific Inc. All Rights Reserved.

@ Method v1.1 information.
Logging options.
* Barcode Tracking: This feature is enabled by default. It is highly recommended to use the
barcode tracking feature to support accuracy in processing the samples. Consult with a FAS

if it is necessary to disable the barcode tracking feature. When selected the barcode tracking
feature performs the following actions:

— Prompts you to enter the barcode information on sample plates, Axiom™ reagent
modules, and GeneTitan™ consumables.

— Records barcode information into a log file.

— Helps ensure that the correct amplification time for the samples has elapsed (minimum of
22 hours) before starting the fragmentation and precipitation step.

— Helps ensure that the splitting and reassembly of samples are correctly associated to the
starting sample plate.

Note: If using custom barcodes for plates, only use alpha-numeric, hyphen, or underscore
characters.

Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7



Chapter 3 Set up the Biomek™ i7 Automated Workstation — EF=i®
Set up the instrument for the first time

Note: The barcode tracking feature is intended to track samples that go through the entire
target preparation process on one instrument.

* Log Name: The log name is the name of the barcode log file. The default name is
BarcodelLog[InstSN].txt, where "InstSN" is the serial number of the instrument. Naming of
the log file is possible by selecting Other in the dropdown list for the setting. If using a custom
log name, ensure that the name ends with ".txt" otherwise the file type will not be associated
correctly. After entering a custom name, click the Apply to the right of the log name field.

* Log Path: The log path is the barcode log file location. The log path is:
C:\Users\Public\Documents\Axiom 2.0 384\

Custom run options.

¢ Verify Reagent Module barcodes: When selected this feature helps ensure that the correct
Axiom™ reagent is used in the specified target preparation step.

¢ Verify GeneTitan Labware Setup: When selected, this feature helps ensure that the
GeneTitan™ reagents that are prepared on the Biomek™ i7 are correctly associated with the
GeneTitan™ plate type.

* Prepare gel and OD plates for QC: the workstation prepares two plates of resuspended
samples that are properly diluted for the fragmentation gel QC and OD quantification process
control checks.

See Appendix B, “Fragmentation quality control gel protocol” and Appendix C, “Sample
quantification after resuspension” for instructions and result assessment guidelines.

IMPORTANT! For troubleshooting and support purposes, we strongly recommend that you
perform the gel QC and OD quantification process controls after resuspension.

* Test Mode: Select this option to skip all the incubation timers in a step. If selected, a prompt
is displayed asking you to ensure that you want to run a step in test mode. Use this option to
perform runs using deionized water only, not actual reagents or samples.

CAUTION! Never process samples in test mode. Processing samples in test mode results
in assay failure and loss of samples and reagents.
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Requirements for plate barcode tracking

To use the barcode tracking feature in the Axiom™ 2.0 Assay 384HT Array Format Automated Workflow
method, each plate in the assay that contains sample must be labeled with a scannable barcode.
User-generated barcode labels can be of any length, but must only use alpha-numeric, hyphen, or
underscore characters. The following is a list of plates requiring barcodes.

IMPORTANT! Using the wrong deepwell plate-Thermoshake adapter combination will result in
physical interference on the Biomek™ i7 deck.

Az e (method version 1.0 (method version 1.1

gDNA samples 384 deepwell 250-pL plate: Abgene™ 384-Well 250 pL Polypropylene Storage Plate

(Cat. No. AB1178),

To avoid error, see Chapter 4, “Target preparation with the Biomek™ i7 Automated

Workstation (method version 1.1, AB kit)” for the correct deepwell plate to use.
Precipitation, Q1 96 deepwell 2,000-pL plate 96 deepwell 2-mL plate
Precipitation, Q2 96 deepwell 2,000-pL plate 96 deepwell 2-mL plate
Precipitation, Q3 96 deepwell 2,000-uL plate 96 deepwell 2-mL plate
Precipitation, Q4 96 deepwell 2,000-uL plate 96 deepwell 2-mL plate
HybRxn 384 PCR plate

Five 384-layout stain ® 2 x 384-Layout GeneTitan™ Stain Tray (Stain 1)
trays e 384-Layout Axiom™ Stain 2 Tray

® 384-Layout Axiom™ Ligation Tray

® 384-Layout Axiom™ Stabilization Tray

GeneTitan™ 384-Layout GeneTitan™ Hybridization Tray
hybridization tray

GeneTitan™ scan tray 384-Layout GeneTitan™ Scan Tray

Sample barcode tracking

The Axiom™ 2.0 Assay 384HT Array Format Automated Workflow method enables sample plate and
reagent module tracking by using barcodes. The barcode tracking option is accessed in the Method
Preferences section of the target preparation step of the method.

Barcode entry

Barcodes are easily entered into the method by scanning with a hand-held barcode scanner during
deck setup. Each deck setup prompt has editable fields over each labware location requiring barcode
entry. To identify a barcode field, find any labware position with an input field that is highlighted in
yellow. If either the Barcode Tracking or Verify GeneTitan labware setup option is enabled, fields that
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are designated as LW BARCODE are used with plates containing samples and with stain trays. Fields
for reagents are indicated by the module number as MODULE or MOD plus the number of the module.

IMPORTANT! To prevent errors, scan the barcodes after the labware has been placed on the proper
deck position.

The TAB key can be used to jump between input fields when entering barcodes manually.

If using the Zebra™ DS9808 Digital Scanner, we recommend configuring the barcode scanner to speed
up barcode entry during deck setup by sending the TAB key automatically after a barcode is scanned.
To configure the scanner, sequentially scan the configuration barcodes that are shown in Table 6.

Table 6 Zebra™ DS9808 Digital Scanner configuration barcodes.

Step Command Barcode

1 | Begin new rule ‘Hl
2 | Send all data that remains ‘ ‘ H I‘
3 |Send tab key | H‘
4 |Saverule ‘ ‘

Barcode entries are added to a single text file found at the following location:
c:\Users\Public\Documents\Axiom 2.0 384.The method automatically generates a log file
and is named BarcodeLog[InstrumentNumber].txt. To view, open the log file in any text editor. Each
method step that is recorded has a start and complete status entry. Log files can be changed to a more
readable format.

Note: For troubleshooting information on barcode verification errors, see “Runtime errors” on
page 172.
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View log files in Microsoft™ Excel™

1. Open the log file in Microsoft™ Excel™, then highlight column A.

2. Select Data » Text to Column.

3. In the Convert Text to Columns Wizard select Delimited, then click Next.
4. Select Comma, then click Next.

5. Click Finish.

Set up the Biomek™ i7 prerun

Assemble the reagent block templates with the reagent block

The Axiom™ 384HT Reagent Kit Templates fit precisely onto the top of the chilled reagent block, and
are held in place by the metal posts on the block. Using these templates helps ensure the proper
placement of reagent tubes onto the block for each method. One template is used for the DNA
amplification, fragmentation, precipitation, and resuspension and hybridization preparation steps. The
second template is used for the GeneTitan™ reagent preparation step. The Axiom™ 384HT Reagent Kit
Templates are available as a component of the Axiom™ 384HT Starter Kit for Biomek™ i7-AB (Cat. No.

952469).
/O Axiom™ 384HT Reagent Kit Template # 1-384 Samples O\
A1 s
o
\O ©2013 Thermofisher Scientific Inc. All rights reserved. /
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/O Axiom™ 384HT Reagent Kit Template # 2-384 Samples

150448 Revt ()
%

\O ©2013 Thermofisher Scientific Inc. All rights reserved /

Assemble the plastic plate lid with the Microseal™ 'P' Pad plate seal

The plastic plate lid is used on the Fragmentation Plate and must be assembled with a reusable
Microseal™ 'P' Pad plate seal before use. Proper placement of the pad helps ensure even coverage
when placed on the Fragmentation Plate. To assemble, remove the protective backing on the pad and
place on the center of the underside of the plate lid. Press down across to enable even adhesion of the
pad to the plate lid.

Figure 11  Plastic plate lid with the Microseal™ 'P' Pad plate seal.

@ Microseal™ 'P' Pad
@ Fence of the plastic plate lid facing up

Perform the prerun checklist

The following actions are required before the first operation of the Biomek™ i7 Automated Workstation
at the start of the day or the start of a run. Some or all these steps can be required depending on the
current state of the Biomek™ workstation.

Power on the Biomek™ i7 Automated Workstation

1. Power on the workstation using the switch that is on the right side of the instrument.

2. If desired, power on the LED deck light by pressing the round button on the right side of the
Biomek™ i7.
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D

3. Ensure that all the peripherals are powered on.

* INHECO Peltier Controllers—Power on from the power strip that is in the middle of the four

Peltier controllers.

* Computer and monitor.

4. Open the Biomek Software using one of the following methods:

* Double-click the Biomek icon §¥ on the desktop.
* In the Windows Search box, enter Biomek 5.

Home all axes

1. In the Biomek™ Software window, click Method » Home All Axes.

Warning

T

| e

e

CAUTION: Before selecting OK to home all axes, make sure:
« The pod and gripper are positioned as shown in the image above.
+ The gripper is not holding any labware.

+ The gripper is able to rotate freely without contacting the head or sides of the
instrument.

+ No disposable tips are loaded.

2. Ensure that all conditions in the warning message are met, then click OK.

The Biomek™ i7 homes the pod, gripper, and head. When complete, the status light remains blue
indicating the workstation is ready for use.
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Biomek™ i7 Automated Workstation
(method version 1.1, AB kit)

B Stage 1: Amplify the genomic DNA . . ... e 56
B Stage 2A: Fragment and precipitate the DNA . ... ... . e 66
B Stage 2B: Centrifuge and dry pellets . ... ..o e 76
B Stage 3: Prepare the resuspension and hybridization reagent mixture ....................... 78
B Stage 4: Reassemble Hybridization Ready Plate and perform sample QC .................... 86
B Stage 5: Denature sample and transfer to hybridizationtray ................ ... ... .. L. 97
B Stage 6: Prepare GeneTitan™ reagents .. ......vuueeine it 105

This chapter is for users running the Beckman Coulter™ Biomek™ i7 software on a Windows™ 10
operating system.

Note: This chapter provides target preparation instructions when running the Axiom™ 2.0 384HT Array
Format Biomek™ method version 1.1 with the Axiom™ 384HT Consumables Kit for Biomek™ i7-AB, Cat.
No. 952472.

IMPORTANT! A gDNA Sample Plate must be prepared before starting DNA amplification. See
Chapter 2, “Genomic DNA preparation”.

CAUTION! Using the wrong 384 deepwell plate type will result in physical interference into the
Thermoshake adapter and prevent the run from proceeding.

CAUTION! Using the wrong type of 96 deepwell plate results in liquid transfer error such as
insufficient volume being transferred or dispense tip bottoming out in the wells. Such liquid transfer
errors cause instrument interruption resulting in potential assay failure.
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Stage 1: Amplify the genomic DNA

Stage 1: Amplify the genomic DNA

Note: For this protocol, the term samples include the positive control.

Time required

Note: A 22-24 hour incubation is required at the end of this stage.

Activity Time
Hands-on timel'] 15 minutes
Biomek™ i7 37 minutes

1 Hands-on time is the estimated time required by the user for handling samples and reagents and setting up the i7 deck and it does
not include sample and reagent thawing time.

Input and output plates

Plate Description Volume | Deck position
Input plate 384 deepwell 250-pL plate (QDNA Sample Plate) AB1178 8.7 uL Peltier1
Output plate 384 deepwell 250-pL plate (Amplification Plate) AB1178 1741 pL Peltier1

Materials, labware, and reagents required

Equipment and labware required

Quantity | [tem

As required | Adhesive seals for plates

As required | Laboratory tissues

1 Mini microcentrifuge (microcentrifuge with microtube rotor)

1 Oven (must maintain a constant temperature of 37°C for at least 24 hours with a temperature
accuracy of £1°C)

* >3 array plates per week—we recommend using the BINDER™ ED 56 or Heratherm™
Advanced Protocol Microbiological Incubator, capacity 66 L

* 3 array plates per week—okay to use the GeneChip™ Hybridization Oven 645, the
BINDER™ ED 56, or Heratherm™ Advanced Protocol Microbiological Incubator, capacity

66 L
1 Vortexer
1 Plate centrifuge (set to room temperature)
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Stage 1: Amplify the genomic DNA

(continued)

Quantity | [tem

Biomek™ i7 Automated Workstation labware

Pipette tips
* 5boxes | ® i-Series 190 L filter tips (green)
* 1 box * -Series 1,025 pL filter tips (orange)

2 Deep 96 full reservoir

1 96 PCR plate

2 384 deepwell 250-uL plate (AB1178)
2 Half Reservoir

2 Quarter Reservoir

1 Reagent block, chilled to 4°C

Sample Plate | One plate of genomic DNA samples prepared in Chapter 2, “Genomic DNA preparation” in
384 deepwell 250-pL plate (AB1178)
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Reagent and sample plate handling

Thaw and prepare reagents and sample plate according to the following table.

Module |Quantity| Reagent and cap color Place at room temperature Deck loading instructions

Reagents from the Axiom™ 2.0 384HT Reagent Kit

o Axiom™ 2.0 Denat v Vortex and centrifuge.
Soln 10X Place in a chilled reagent block.

Axiom™ 2.0 Neutral Soln | v Thaw in room temperature | Vortex for 30 seconds.

water bath. Pour in reservoir.
o Axiom™ 2.0 Amp Soln v Thaw in room temperature | Vortex for 30 seconds.
Module 1 water bath. Pour in reservoir.
—20°C
1 Axiom™ Water v Thaw in room temperature | Vortex for 30 seconds.
water bath. Pour in reservoir.
Axiom™ 2.0 Amp ® Do not thaw. Keep at —20°C | Immediately before use: Gently
° Enzyme until ready to use. flick tube 3 times, then

centrifuge. Place in the chilled
reagent block.

Note: Estimated reagent thawing time is 1 hour.

Sample Plate

Thaw the Sample Plate at room temperature, then centrifuge.

Note: Do not place a frozen Sample Plate directly on the Biomek™ i7 workstation deck.

Perform the pre-run checklist

The Biomek actions in the pre-run checklist are the same as described under “Perform the prerun
checklist” on page 53. See this section for details. Some or all these steps are required depending on
the current state of the Biomek™ i7 Automated Workstation.

1. Preheat the oven to 37°C.
2. Power on the Biomek™ i7 and all peripherals.
3. Check the waste container, then empty as required.

4. Open the Biomek™ Software using one of the following methods:

* Double-click the Biomek™ icon §¥ on the desktop.
* |nthe Windows Search box, enter Biomek 5.

5. Home all axes.
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Run the DNA amplification step
1. Click File » Open.
2. For Look in of the Open Method window, select Axiom 384 on i7.
3. Select 1 DNA Amplification Ax384_i7, then click OK.

4. At the top of the Biomek Software window, click - Run to start the DNA amplification step.
The deck layout for the DNA amplification step is displayed.

LABWARE & REAGENT SETUP DNA Amplification

DNA Amplification

--ﬂmmmm
TL10
mmmmmmmm

1) Set up reagent reservoirs and tubes as indicated below
2) Enter or scan plate barcodes as indicated above (Barcode Tracking enabled)

Neut - Open Reservoir (P3) AmpMM - Modular Reservoir (P8) DenatMM - Modular Reservoir (P10) Cold Tubes (Peltier 3)
Empty
172
Reservoir
P start | B ~vort |

Figure 12 DNA amplification step deck layout.

5. Place the labware and reagents on the deck as directed in the following figures and table:

* Figure 12—Deck layout.
* Figure 13—Deck positions on the Biomek™ i7.

* Table 7—Table detailing the labware, reagent, and modular reservoir placement for the deck
layout.
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* Figure 14—Reagent block.
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Figure 13 Deck positions on the Biomek™ i7 Automated Workstation.

P14 TL1

Table 7 Labware and reagent locations on the deck for the DNA amplification method.

Deck position Labware Scanl!! Reagent or sample
TL4 i-Series 190 pL filter tips (green)
TL5 i-Series 190 pL filter tips (green)
TL6 i-Series 190 pL filter tips (green)
TL7 i-Series 190 pL filter tips (green)
P1 384 deepwell 250-uL plate
Peltier1 Abgene™ 384-Well 250 pL Polypropylene | Il gDNA Sample Plate
Storage Plate (AB1178) over the 384 deep-well
adapter
P3 Deep 96 full reservoir
P4 384 deepwell 250-pL plate (AB1178)
P5 96 PCR plate
P8 Reservoirs in frame:
* Half Reservoir (1)
¢ Half Reservoir (2) @ @

@ Pour 2 bottles Axiom™ 2.0
Amp Soln into reservoir 1.

(2) Leave reservoir 2 empty.

P9 Deep 96 full reservoir
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Table 7 Labware and reagent locations on the deck for the DNA amplification method. (continued)

Deck position Labware Scanl!! Reagent or sample

P10 Reservoirs in frame:
* Quarter Reservoir (1)
* Quarter Reservoir (2) @ @

@ Pour 1 bottle Axiom™ Water
into reservoir 1.

@ Leave reservoir 2 empty.

Peltier3 Reagent block, chilled to 4°C | Il See Figure 14.
TL11 i-Series 1,025 pL filter tips (orange)
TL15 i-Series 190 pL filter tips (green)

[ Scan labware or reagent module barcode. Do not scan the image in this table.

Denat
Solution
10X

Figure 14 Placement of reagents on chilled reagent block for DNA amplification step.

IMPORTANT! Flick and centrifuge the Axiom™ 2.0 Amp Enzyme before placing in the chilled
reagent block.

6. Check the deck layout to ensure that all labware and reagents are in the proper locations.
7. Scan the labware and reagent barcodes.

8. Click Start.
The DNA amplification step on the Biomek™ i7 Automated Workstation starts. When complete, a
message window appears.
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Biomek Software

DMA Amplfication setup is complete.

Do the following:

1. Remove sample plate from deck and seal then place in 37 deg C oven for ovemight incubation
2. Discand used labware and reagents

3. Discard used tips

4. Store unused tips

5. Store cold block at 4 deg C

IME2018 7:00:42 PM

9. Complete the following:
a. Remove the Sample Plate from the Peltier1 deck position.

b. Blot the top of the Sample Plate with a laboratory tissue to remove any droplets that are
present.

c. Tightly seal the Sample Plate.
d. Centrifuge the Sample Plate at 1,000 rpm for 30 seconds.

e. Place the Sample Plate in a preheated oven, then incubate at 37°C for 23 +1 hour.

Note: If using a GeneChip™ Hybridization Oven 645, place the plate on the bottom of the
oven. Do not rotate the plates.

f. Store the unused BC1025F tips from deck position TL11.

g. Discard the tubes from the cold block at the Peltier3 deck position. Store the cold block at
4°C.

h. Discard the remaining labware and tips on the deck. Store the reservoir frames. Click OK
when done.

10. After 22 to 24 hours of incubation, do one of the following:

* Proceed directly to “Stage 2A: Fragment and precipitate the DNA” on page 66.
* Tightly seal and store the amplified samples at —20°C.
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Workflow for Stage 1: Amplification

Prepare Denaturation Master Mix and Distribution Plate

®_

2x

2x313 uL

40 L / Well
5,634 pL

@

>
@

@ Axiom™ 2.0 Denat Soln 10X (Peltier 3)
@ Axiom™ Water (P10)

(3 Denat MM (P10)

(@) DenatDist-1 (P5)

Prepare Amplification Master Mix

®_ 2x582.4 L

2x
4°C

52.4 mL

©)

@ Axiom™ 2.0 Amp Enzyme (Peltier 3)
(2 Axiom™ 2.0 Amp Soln (P8)
(3 Amp MM (P8)

Transfer Denaturation Master Mix to Sample Plate

00
000/
000+
000/

8.7 uL/well

0000
0

0

0
000
00000

5
000
000

00000000+
00000000+

00

0

©

(1) DenatDist-1 (P5)
(@ Sample Plate (Peltier 1)

Incubate Sample Plate

Incubate Sample Plate on deck for 10 minutes at 22°C.
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These steps occur during the 10 minute Transfer Amplification Master Mix to open reservoir
incubation.

Reservoir contents

| E—
@
() Amp MM (P8)
(@ AmpMM-Full (P9)

v

Transfer Axiom™ 2.0 Neutral Soln to Neutralization
Distribution Plate

65 pL/well

(@ Axiom™ 2.0 Neutral Soln (P3)
(2 NeutDist_1 (P1)

v

Prepare Amplification Master Mix Distribution Plate

115 plL/well

() AmpMM (P9)
(® AmpMM_1 (P4)

Transfer Neutralization Solution to Sample Plate

56.6 uL/well

(D NeutDist_1 (P1)
(2 Sample Plate (Peltier 1)
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Transfer Amplification Master Mix to Sample Plate

@ 74 L

Final volume = 174.1 pL/well

(D AmpMM_1 (P4)
@ Sample Plate (Peltier 1)

v

Incubate Sample Plate offline for 23 +1 hrs at 37°C
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Stage 2A: Fragment and precipitate the DNA

During this stage, the 384 deepwell 250-pL plate of fragmented samples is split into four 96 deepwell
2-mL plates for precipitation. To avoid mislabeling samples, be careful to preserve the order of the four
plates and avoid interchanging these plates with those derived from another 384-well sample plate.

An overnight incubation is required at the end of the stage.

Time required

Activity Time
Hands-on timel'] 20 minutes
Biomek™ i7 1.5 hours

' Hands-on time is the estimated time required by the user for handling samples and reagents and setting up the i7 deck and does not
include sample and reagent thawing time.

Input and output plates

Plate Description Volume Deck position
Input plate 384 deepwell 250-pL plate 1741 pL Peltier1
(Amplification Plate)
Output plate Q1 96 deepwell 2-mL plate 572.6 L P12
Output plate Q2 96 deepwell 2-mL plate 572.6 L P17
Output plate Q3 96 deepwell 2-mL plate 572.6 yL P13
Output plate Q4 96 deepwell 2-mL plate 572.6 uL P18

Materials, labware, and reagents required

Equipment and labware required

Quantity Item

As required | Adhesive seals for plates

1 Ice bucket, filled with ice

As required | Laboratory tissue

1 Mini microcentrifuge (minifuge with microtube rotor)
1 Plate centrifuge
1 Vortexer (for plates and microtubes)
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/

(continued)
Quantity Item
Biomek™ i7 Automated Workstation
Pipette tips:
®* 6 boxes ® i-Series 190 pL filter tips (green)
. 1 box ® -Series 1,025 pL filter tips (orange)
2 Deep 96 full reservoir
1 96 PCR plate
1 384 deepwell 250-uL plate (AB1178)
4 96 deepwell 2-mL plate (Abgene™ deepwell plate)
1 Plastic plate lid (FRAG LID)
1 Reagent block, chilled to 4°C
3 Quarter Reservoir
Sample Plate | One plate of amplified DNA from Stage 1 in a 384 deepwell 250-pL plate (AB1178)

Reagent and sample plate handling

Thaw and prepare reagents and sample plate according to the following table.

Reagent and cap Thaw, then Place on Place at Deck loading
Module Qty . . . .
color place on ice ice room temp instructions
Reagents from the Axiom™ 2.0 384HT Reagent Kit
Axiom™ Frag ® Do not thaw. Keep at —20°C until ready to | Immediately before
Enzyme use. use: Gently flick
5 tube 3 times,
centrifuge. Place
in chilled reagent
block.
Module 2-1
-20°C 5 Axiom™ v/ Thaw in a small Vortex. Pour in
10X Frag Buffer | water bathl] reservoir.
Axiom™ Precip Vortex, then
5 Soln 2 v centrifuge. Place
in chilled reagent
block.
Module 2-2 5 Axiom™ Precip v Vortex. Pour in
2-8°C Soln 1 reservoir.
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(continued)
Module aty Reagent and cap Thaw, thfan Plal.ce on Place at [.)eck Ioa'dlng
color place on ice ice room temp instructions
Axiom™ Frag Vortex, then
Diluent centrifuge. Place
2 v . .
Module 2-2 in chilled reagent
2-8°C block.
5 Axiom™ Frag v Vortex. Pour in
Rxn Stop reservoir.

Note: Estimated reagent thawing time is 30 minutes.

Amplified Sample Plate

Follow reagent handling steps only if the Place the deep-well | Centrifuge at 1,000 rpm
Amplified Sample Plate was frozen after the plate in a small for 30 seconds.
DNA amplification step. water bathl] for

1 hour until all wells
have thawed.

' For example, on the benchtop at room temperature, pour ultra-pure water into a small tray.

Perform the pre-run checklist
The following actions are the same as described under “Perform the prerun checklist” on page 53.

See this section for details. Some or all these steps are required depending on the current state of the
Biomek™ i7 Automated Workstation.

1. Power on the Biomek™ i7 and all peripherals.
2. Check the waste container, then empty as required.

3. Open the Biomek™ Software using one of the following methods:

* Double-click the Biomek™ icon §¥ on the desktop.
* In the Windows Search box, enter Biomek 5.

4. Home all axes.
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Run the fragmentation and precipitation step
1. Click File » Open.
2. For Look in of the Open Method window, select Axiom 384 on i7.
3. Select 2 Fragmentation and Precipitation Ax384_i7, then click OK.

4. At the top of the Biomek Software window, click p» Run to start the fragmentation and
precipitation step.
The deck layout for the DNA fragmentation and precipitation step is displayed.

| 2

LABWARE & RZAGENT SETUP  Fragmentation

DNA Fragmentation and Precipitation

- - Precip_1-QUiFFs ] Precip_1- qga
Precip_1-Q3° " W Frecip_1-Q4
| e [
— E;“'”;m,:} [ } - ] |2
— 19
o v [ e [ [ [ [

1) Set up reagent reservaoirs and tubes as indicated below

2) Enter or scan plate barcodes as indicated above (Barcode Tracking enabled)

Iso-1 - Open Reservoir (P2) PrecipSoln - Open Reservoir (PT) Frag and Stop Res - Modular Reservoir (P10) Cold Tubes (Peltier 3)

R S S
@ @ @
Isopropanol Precipitation Frag Empty Stop
{User-supplied) Solution 1 Buffer 1/4 Soln
120 mL 2 Bottles 2 Bottles || Reservoir || 2 Bottles @

> Sstart | [ | Abort|

Figure 15 DNA fragmentation and precipitation step deck layout.

5. Place the labware and reagents on the deck as directed in the following figures and table: deck

layout.

* Figure 15—Deck layout.
¢ Figure 16 —Deck positions on the Biomek™ i7

* Table 8 —Table detailing the labware, reagent, and modular reservoir placement for the deck

layout.
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* Figure 17—Reagent block.

£ 21 K 3 I3 I I

3 1 3 I3 I I
I T I T )
23 I Y I
Y I I I )

Figure 16 Deck positions on the Biomek™ i7 Automated Workstation.

Table 8 Labware and reagent locations on the deck for the fragmentation and precipitation step.

Deck position Labware Scanl!l Reagent or sample

IMPORTANT!
. Remove the seal from the amplified sample plate before placing on the deck.

. Ensure that the P-pad that is attached to the plastic plate lid is cleaned with 70% ethanol before and after use.

TL4 i-Series 190 pL filter tips (green)
TL5 i-Series 190 pL filter tips (green)
TL6 i-Series 190 pL filter tips (green)

TL7 i-Series 190 pL filter tips (green)

Peltier1 384 deepwell 250-uL plate over the 384 || I Amplified DNA Sample Plate from
deep-well adapter (AB1178) stage 1

P2 Deep 96 full reservoir Isopropanol 120 mL

P3 Plastic plate lid (FRAG LID)

P4 384 deepwell 250-pL plate (AB1178)

P5 96 PCR plate

P7 Deep 96 full reservoir Axiom™ Precip Soln 1, 2 bottles
P10 Reservoirs in frame: || |

* Quarter Reservoir (1)

® Quarter Reservoir (2) @ @ @

® Quarter Reservoir (3)

@ Pour 2 bottles Axiom™
10X Frag Buffer into
reservoir 1.

@ Leave reservoir 2 empty.

(® Pour 2 bottles Axiom™ Frag
Rxn Stop into reservoir 3.
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Stage 2A: Fragment and precipitate the DNA

Table 8 Labware and reagent locations on the deck for the fragmentation and precipitation
step. (continued)

Deck position Labware Scanl! Reagent or sample

PL12 96 deepwell 2-mL plate Tip: Label the plate I’ I Precipitation Plate, quadrant 1
"Q1" for easier visualization during deck
loading.

PL13 96 deepwell 2-mL plate Tip: Label the plate I’ I Precipitation Plate, quadrant 3
"Q3" for easier visualization during deck
loading.

PL17 96 deepwell 2-mL plate Tip: Label the plate || I Precipitation Plate, quadrant 2
"Q2" for easier visualization during deck
loading.

PL18 96 deepwell 2-mL plate Tip: Label the plate I’ I Precipitation Plate, quadrant 4
"Q4" for easier visualization during deck
loading.

Peltier3 Reagent block, chilled to 4°C || I See Figure 17.

TL11 i-Series 1,025 pL filter tips (orange)

TL12 i-Series 190 pL filter tips (green)

TL15 i-Series 190 pL filter tips (green)

[ Scan labware or reagent module barcode. Do not scan the image in this table.

Precip
Sollétion

Precip
Soltétion

Frag
Diluent

Frag
Diluent

Figure 17 Placement of reagents on chilled reagent block for the fragmentation and precipitation
step.

IMPORTANT! Flick and centrifuge the Axiom™ Frag Enzyme before placing in the block.

6. Check the deck layout to ensure that the labware, reagents, and samples are in the proper
locations.

7. Scan the labware and reagent barcodes.
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Stage 2A: Fragment and precipitate the DNA

8. Click Start to continue.
The fragmentation and precipitation step on the Biomek™ i7 Automated Workstation starts. When
complete, a message window appears.

Biomek Software

Fragmentation and precipitation steps are complete.

Do the following:

1. Remove Precip plates and perform the precipitation procedure as instructed in the user manual
2. Discard used labware and reagents

3. Discard used tips

4. Store unused tips

5. Store cold block at 4deg C

3MS2018 71518 PM

9. Complete the following:
a. Remove the 4 precipitation plates that are found at deck positions P12, P13, P17, and P18.

b. Blot the top of all 4 precipitation plates with a laboratory tissue, then seal each plate tightly.
c. Place all 4 precipitation plates in a —20°C freezer overnight to precipitate the samples.

d. Store the unused BC1025F tips from deck position TL11 and unused BC190F tips from deck
position TL12.

e. Discard the tubes from the cold block at the Peltier3 deck position. Store the cold block at
4°C.

f. Discard the remaining labware and tips on the deck. Store the reservoir frames. Click OK
when done.

Workflow for Stage 2: Fragmentation and precipitation

fragmentation incubation

Incubate on deck

20 minutes at 65°C 24.8 pLiwell

@ 174.1 pL

(1 Sample Plate (Peltier 1) (@ Axiom™ Frag Rxn Stop (P10)
(2 SPelt (Pettier 1) @) StopDist_1 (P4)

‘ @) 14
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Prepare Fragmentation Master Mix

O 10,920.2 pL
>
2x1,216.8 uL
2x
4°c
®
2x1312pL
2x
4°C

®

(D) Axiom™ 10X Frag Buffer (P10)
@ Axiom™ Frag Diluent (Peltier 3)
@ Axiom™ Frag Enzyme (Peltier 3)
(@) Frag MM (P10)

Prepare Fragmentation Master Mix Distribution Plate

120 pL/well

»
®

(@) Frag MM (P10)
(2) FragDist-1 (P5)

Transfer Fragmentation Master Mix to Sample Plate

24.8 ulL/well

@ 1t

(@) FragDist-1 (P5)
@ Sample Plate (Peltier 1)
Incubate on deck 20 minutes at 39.5°C
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Stage 2A: Fragment and precipitate the DNA

Move plate lid onto Sample Plate

Dilute Axiom™ Precip Soln 2

Incubate

®

(@ Plate lid (P3)
@ Shaking peltier + Sample Plate (Peltier 1)

2 x720 yL

(720 pL per tube) D—@

(1) Axiom™ Precip Soln 1 (P7)
@ Axiom™ Precip Soln 2 (Peltier 3)

Prepare Precipitation Master Mix

<:>_D 2 x 888 uL
(

888 pL per tube)
2 x

4°C

@ Axiom™ Precip Soln 2 (Peltier 3)
@ Axiom™ Precip Soln 1 (P7)

Transfer Precipitation Master Mix to precipitation plates

(@) Precip MM (P7)
@ Precipitation plates (P12, P13, P17, P18)

Transfer isopropanol to precipitation plates

261 pL/well

@ Iso-1 (P2)
@ Precipitation plates (P12, P13, P17, P18)
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Move plate lid to deck position P8

P8

® O

(D Plate Lid (Peltier 1)
@ Deck position P8

Transfer Stop Solution to Sample Plate

8.3 uL/well

@ @ 198.9 uL1

Final volume = 207.2 pL/well

(1) StopDist_1 (P4)
(2 Sample Plate (Peltier 1)

Transfer samples to precipitation plates

Plate contents

@

Final volume = 572.6 uL/well

@ Sample Plate (Peltier 1)
@ Precipitation plates (P12, P13, P17, P18)

Offline precipitation

Incubate precipitation plates containing samples at
—20°C freezer overnight.

-20°C
®
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Stage 2B: Centrifuge and dry pellets

Time required

Activity Time
Hands-on time 15 minutes
Biomek™ i7 Not required
Off deck equipment
* Centrifugation * 40 minutes
* Drying * 25 minutes

Input and output plates

Plate Description Volume Deck position
Input plate Q1 96 deepwell 2-mL plate 572.6 pL off-deck
Input plate Q2 96 deepwell 2-mL plate 572.6 L off-deck
Input plate Q3 96 deepwell 2-mL plate 572.6 uL off-deck
Input plate Q4 96 deepwell 2-mL plate 572.6 uL off-deck
Output plate Q1 96 deepwell 2-mL plate Pelleted sample off-deck
Output plate Q2 96 deepwell 2-mL plate Pelleted sample off-deck
Output plate Q3 96 deepwell 2-mL plate Pelleted sample off-deck
Output plate Q4 96 deepwell 2-mL plate Pelleted sample off-deck

Equipment and consumables required

Quantity ltem

As required | Adhesive seals for plates

As required | Laboratory tissue

1 Plate centrifuge, precooled to 4°C

1 Oven, preheated to 37°C

Use an oven that can sustain a constant temperature of 37°C and has a temperature
accuracy of £1°C. We recommend the BINDER™ ED 56 or Heratherm™ Advanced Protocol
Microbiological Incubator, capacity 66 L.

Sample plates | Four plates of precipitated samples from Stage 2 in 96 deepwell 2-mL plates
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Stage 2B: Centrifuge and dry pellets

Note: Keep the centrifuge ready at 4°C.

CAUTION! During this step, handle the plate gently to avoid disturbing the pellets. Do not bump or
bang the plates.

Centrifuge and dry the pellets

1. Centrifuge the four 96-well precipitation plates for 40 minutes at 4°C at 3,200 x g.

WARNING! Use rotor buckets with a soft rubber bottom to ensure that the deep-well plates
do not crack. Do not use buckets where the plates sit directly on a metal or hard plastic

bottom, such as the A-4-62 rotor with a WO-15 plate carrier (hard bottom) for the Eppendorf
5810R centrifuge. Use of hard bottom plate carriers can result in cracked plates, loss of sample,
unbalanced centrifugation, damage to the instrument and possible physical injury.

2. Immediately after the 40-minute centrifugation time frame, empty the liquid from each plate using
the following procedure:

a. Remove the seal.
b. Invert the plates over a waste container, then allow the liquid to drain.

c. As the plate is inverted, gently press the plates on a pile of laboratory tissues on a bench,
then allow them to drain for five minutes. Transfer the plates to a new pile of laboratory tissues
twice during the 5-minute time frame.

3. Turn the plates right side up and place in an oven for 20 minutes at 37°C to dry.

Note: If using a GeneChip™ Hybridization Oven 645, place the plate on the bottom of the oven. Do
not rotate the plates.

4. Do one of the following:

* Proceed directly to “Stage 3: Prepare the resuspension and hybridization reagent mixture” on
page 78, even if some droplets of liquid remain. Leave the sample plate at room temperature.
It is helpful to start preparing reagents for stage 3 during centrifuging and drying pellets.

* Store the plates for resuspension later in the same day. Tightly seal the plates.
— If resuspension is carried in 4 hours, keep the plates at room temperature.

— If resuspension is carried out in more than 4 hours, store the plates in a refrigerator (2—
8°C).

* To process the plates for resuspension on another day, tightly seal the plates and store at
—20°C.
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Stage 3: Prepare the resuspension and hybridization
reagent mixture

Note: In this stage, a resuspension and hybridization reagent mixture is prepared and delivered to
the four plates of pelleted DNA by the Biomek™ i7 Automated Workstation. The samples are then
resuspended by shaking off deck.

Time required

Activity Time
Hands-on timel! 10 minutes
Biomek™ i7 17 minutes
Off deck equipment—shaking 15 minutes

' Hands-on time is the estimated time required by the user for handling samples and reagents and setting up the Biomek™ i7 deck and
does not include sample and reagent thawing time.

Input and output plates

Plate Description Volume Deck position
Input plate Q1 96 deepwell 2-mL plate Pelleted sample P12
Input plate Q2 96 deepwell 2-mL plate Pelleted sample P17
Input plate Q3 96 deepwell 2-mL plate Pelleted sample P13
Input plate Q4 96 deepwell 2-mL plate Pelleted sample P18
Output plate Q1 96 deepwell 2-mL plate 50 yL P12
Output plate Q2 96 deepwell 2-mL plate 50 pL P17
Output plate Q3 96 deepwell 2-mL plate 50 yL P13
Output plate Q4 96 deepwell 2-mL plate 50 pL P18

Materials, labware, and reagents required

Equipment and labware required

Quantity Item

As required | Adhesive seals for plates

1 Mini microcentrifuge (minifuge with microtube rotor)

1 Plate centrifuge at room temperature
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(continued)
Quantity Item
1 Shaker, either:
* Thermo Scientific™ Digital Microplate Shaker, 88882005 or 88882006
* Thermo Scientific™ Compact Digital Microplate Shaker, 88880023 or 88880024
* Boekel™ Jitterbug™
1 Vortexer

Biomek™ i7 Automated Workstation

Pipette tips:
* 4 boxes * i-Series 190 pL filter tips (green)
* 1box * i-Series 1,025 L filter tips (orange)
1 Reagent block, chilled to 4°C
1 96 deepwell 2-mL plate (Abgene™ deepwell plate)
3 Quarter Reservoir
1 384 deep-well adapter

Reagent handling

Thaw and prepare reagents according to the following table.

Module |Quantity| Reagent and cap color |Place at room temperature Deck loading instructions

Reagents from the Axiom™ 2.0 384HT Reagent Kit

2 Axiom™ Hyb Buffer v Vortex. Pour in reservoir.
Module 2-1
—20°C 5 Axiom™ Hyb Soln 1 v Vortex, then centrifuge. Place in
chilled reagent block.
2 Axiom™ Resusp Buffer v Vortex. Pour in reservoir.
Module 2-2
2-8°C 5 Axiom™ Hyb Soln 2 v Vortex, then centrifuge. Place in

chilled reagent block.

Note: Estimated reagent thawing time is 1 hour.

IMPORTANT! The resuspension reagents must be at room temperature for 7 hour before proceeding
with this step. Failure to equilibrate to room temperature causes incomplete resuspension of pellets and
compromises results.
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Prepare pelleted DNA
Guidelines for pelleted DNA plates

IMPORTANT! DNA pellets must be at room temperature before resuspension.

Plates of fresh pelleted DNA

¢ If proceeding with the resuspension and hybridization protocol in 4 hours, plates with fresh pellets
can be kept at room temperature.

* |f plates with fresh pellets are not processed in 4 hours but are processed the same day,
these plates can be transferred to a refrigerator (2-8°C). However, it is critical to equilibrate the
plate to room temperature for at least 30 minutes before proceeding with the resuspension and
hybridization protocol.

Plates of frozen pelleted DNA

Plates with frozen pellets (for example, on day 5 of the 8-plate workflow) must be equilibrated to room
temperature for at least 1.5 hours before proceeding with resuspension and hybridization.

Perform the pre-run checklist

The following actions are the same as described under “Perform the prerun checklist” on page 53.
See this section for details. Some or all these steps are required depending on the current state of the
Biomek™ i7 Automated Workstation.

1. Power on the Biomek™ i7 and all peripherals.
2. Check the waste container, then empty as required.

3. Open the Biomek™ Software using one of the following methods:

* Double-click the Biomek™ icon ¥ on the desktop.
* Inthe Windows Search box, enter Biomek 5.

4. Home all axes.

Run the resuspension and hybridization preparation step
1. Click File » Open.
2. For Look in of the Open Method window, select Axiom 384 on i7.
3. Select 3 Resuspension and Hybridization Preparation Ax384_i7, then click OK.

4. At the top of the Biomek Software window, click p» Run to start the resuspension and
hybridization step.
The deck layout for the resuspension and hybridization preparation step is displayed.
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LABWARE & REAGEMT SETUP - Resuspension and Hykridization Preparation

Resuspension and Hybridization Preparation

] [ [ [
T e

W - W
i — 0 A D )
23 K 1 I T )

1) Set up reagent reservoirs and tubes as indicated below

2) Enter or scan plate barcodes as indicated above (Barcode Tracking enabled)

HybMMRes - Modular Reservoir (P15) Cold Tubes (Peltier 3)

QIRI0LS
o | o o e ®
2 Bottles | 2 Bottles [H==Samng Q Q @
QO ©

P Start | B Abort|

Figure 18 Resuspension and hybridization preparation step deck layout.

5. Place the labware and reagents on the deck as directed in the following figures and table: deck
layout.

* Figure 18 —Deck layout.
¢ Figure 19—Deck positions on the Biomek™ i7

¢ Table 9—Table detailing the labware, reagent, and modular reservoir placement for the deck
layout.
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* Figure 20—Reagent block.

oy 0 0 I3 A I I
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Figure 19 Deck positions on the Biomek™ i7 Automated Workstation.

TL3 TL8

Table 9 Labware and reagent locations on the deck for the resuspension and hybridization preparation
step.

Deck position Labware Scanl'l Reagent or sample

TL4 i-Series 190 pL filter tips (green)

TL5 i-Series 190 pL filter tips (green)

TL6 i-Series 190 pL filter tips (green)

TL7 i-Series 190 pL filter tips (green)

Peltier1 384 deep-well adapter (no other labware)

P12 96 deepwell 2-mL plate (Use plate labeled "Q1" Pelleted samples, quadrant 1
from stage 2)

P13 96 deepwell 2-mL plate (Use plate labeled "Q3" Pelleted samples, quadrant 3
from stage 2)

P14 96 deepwell 2-mL plate

P15 Reservoirs in frame: [ lszeeememal

* Quarter Reservoir (1)

® Quarter Reservoir (2) @ @ @

® Quarter Reservoir (3)

@ Pour 2 bottles Axiom™
Resusp Buffer into reservoir
1.

@ Pour 2 bottles Axiom™ Hyb
Buffer into reservoir 2.

(3 Leave reservoir 3 empty.

P17 96 deepwell 2-mL plate (Use plate labeled "Q2" Pelleted samples, quadrant 2
from stage 2)

P18 96 deepwell 2-mL plate (Use plate labeled "Q4" Pelleted samples, quadrant 4
from stage 2)
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Table 9 Labware and reagent locations on the deck for the resuspension and hybridization preparation
step. (continued)

Deck position Labware Scanl'l Reagent or sample
Peltier3 Reagent block, chilled to 4°C I Il See Figure 20.

TL11 i-Series 1,025 L filter tips (orange)

[ Scan labware or reagent module barcode. Do not scan the image in this table.

Hyb
Solution
1

Hyb
Soll%tion

Hyb
Solution
2

Hyb
Solution
2

Figure 20 Placement of reagents on chilled reagent block for the resuspension and hybridization
preparation step.

6. Check the deck layout to ensure that the labware, reagents, and samples are in the proper
locations.

7. Scan the labware and reagent barcodes.

8. Click Start to continue.
The resuspension and hybridization preparation step on the Biomek™ i7 Automated Workstation
starts. When complete, a message window appears.

Biomek Software

Resuspension and Hyb Prep is complete.

Do the following:

1. Remove Precip plates and perform the resuspension procedure as instructed in the user manual
2. Discard used labware and reagents

3. Discard used tips

4. Store unused tips

5. Store cold block at 4 deg C

382018 7:20:34 PM

9. Complete the following tasks:
a. Remove the 4 precipitation plates from deck positions P12, P13, P17, and P18.

b. Blot the top of the precipitation plates with a laboratory tissue to remove any droplets present.

c. Tightly seal the precipitation plates.
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d. Follow the instructions in “Complete resuspension by off deck shaking” on page 84 to carry
out the resuspension by off deck shaking.

e. Store the unused BC1025F tips from deck position TL11.

f. Discard the tubes from the cold block at the Peltier3 deck position. Store the cold block at
4°C.

g. Discard the remaining labware and tips on the deck. Store the reservoir frames. Click OK
when done.

Complete resuspension by off deck shaking

On completion of the on-deck method to prepare the resuspension and hybridization mixture and
deliver this mixture to the four 96 deepwell 2-mL plate containing the samples, resuspension is carried
out by shaking off deck using the following steps:

1.

2.

84

Seal the 4 plates tightly. Check to see that blue pellets are visible at the bottom of the wells.
Centrifuge the 4 plates at room temperature for 30 seconds.

Place all 4 plates onto the shaker and shake the plates at 900 rpm for 15 minutes.

Inspect the 4 plates from the bottom. If the pellets are not dissolved, repeat the shaking step.
Centrifuge the 4 plates at room temperature for 30 seconds.

Proceed to “Stage 4: Reassemble Hybridization Ready Plate and perform sample QC” on
page 86.
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Stage 3: Prepare the resuspension and hybridization reagent mixture

Workflow for Stage 3: Resuspension and hybridization preparation

Prepare Hybridization Master Mix

O— 2 x66.5 L
2 x

4°C

2x 1,197 pL
2x

4°C

|

9,295 uL

@]
©)

18,753.6 pL

®[]

(D Axiom™ Hyb Soln 1 (Peltier 3)
@ Axiom™ Hyb Soln 2 (Peltier 3)
@ Axiom™ Resusp Buffer (P15)
(@ Axiom™ Hyb Buffer (P15)

(® Hyb MM (P15)

Transfer Hybridization Master Mix to distribution plate

280 pL/well

(D Hyb MM (P15)
(@ Hyb MM (P14)
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Transfer Hybridization Master Mix to precipitation plates

(D Hyb MM (P14)

Final volume = 50 pL/well

@ Precipitation plates containing dried pellets (P12, P13, P17, P18)

Off-line resuspension

Shake the four sample plates on an off-deck shaker for 15 minutes.

Stage 4: Reassemble Hybridization Ready Plate and
perform sample QC

Time required

Activity

Time

Hands-on timel'!

15 minutes

Biomek™ i7

19 minutes (with sample QC)
5 minutes (without sample QC)

Off deck equipment (if performing sample QC)

30 minutes

' Hands-on time is the estimated time required by the user for handling samples and reagents and setting up the Biomek™ i7 deck and

does not include sample and reagent thawing time.

Input and output plates

Plate Description Volume | Deck position
Input plate Q1 96 deepwell 2-mL plate 50 yL P12
Input plate Q2 96 deepwell 2-mL plate 50 pL P17
Input plate Q3 96 deepwell 2-mL plate 50 yL P13
Input plate Q4 96 deepwell 2-mL plate 50 pL P18

86
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Stage 4: Reassemble Hybridization Ready Plate and perform sample QC

(continued)

Plate Description Volume | Deck position
Output plate 384 PCR plate 45 L P9
Output plate (if QC selected) 384 UV plate 30 uL P5
Output plate (if QC selected) 384 deepwell 250-uL plate (AB1178) 62 pL P11

Materials, labware, and reagents required

Equipment and labware required

Quantity Item
As required | Adhesive seals for plates
1 Laboratory tissue

Biomek™ i7 Automated Workstation

Pipette tips:

* 4 boxes * i-Series 50 pL filter tips (pink)

* 1 box * i-Series 190 pL filter tips (green)(!]
2 Deep 96 full reservoirl!
1 384 deepwell 250-pL platel'l (AB1178)
1 384 deepwell 250-pL platel! (AB1178)
1 384 PCR plate
1 384 UV platelll

Sample Plate | Four plates of resuspended DNA from Stage 3 in 96 deepwell 2,000-uL plate

1 Plate collar

1 384 deep-well adapter

' QC labware. Not required if QC was disabled in method preferences.
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Reagent handling

Prepare reagents according to the following table.

Quantity Reagent Handling

User supplied reagents

75 mL | Nuclease-free water, ultrapure MB gradel'] Add 75 mL of nuclease-free water to the

(Thermo Fisher Scientific, Cat. No. 71786; for OD water reservoir (Deep 96 full reservoir)
and gel plate preparation)

35mL | Gel diluentl] Add 35 mL of diluted loading dye to the

(see Appendix B, “Fragmentation quality control gel dye reservoir (Deep 96 full reservoir).

protocol” for dilution instructions)

' QC user-supplied reagents. Not required if QC is disabled in method preferences.
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Stage 4: Reassemble Hybridization Ready Plate and perform sample QC
Perform the pre-run checklist
The following actions are the same as described under “Perform the prerun checklist” on page 53.

See this section for details. Some or all these steps are required depending on the current state of the
Biomek™ i7 Automated Workstation.

1. Power on the Biomek™ i7 and all peripherals.
2. Check the waste container, then empty as required.

3. Open the Biomek™ Software using one of the following methods:

* Double-click the Biomek™ icon §¥ on the desktop.
* |nthe Windows Search box, enter Biomek 5.

4. Home all axes.

Run the plate reassembly and QC step

Note: We strongly recommend that you run 2 quality process controls after this step.
. A gel to view fragmentation.

. An OD quantification of each resuspended sample to check DNA yield.

The Biomek™ i7 Automated Workstation can be set to prepare fragmentation and OD plates that are
ready for processing. These process controls must be selected as a run preference before starting a
run. See “Set the method preferences” on page 46.

1. Click File » Open.
2. For Look in of the Open Method window, select Axiom 384 on i7.
3. Select 4 Plate Reassembly and QC Ax384_i7, then click OK.

4. At the top of the Biomek Software window, click P Run to start the plate reassembly and QC
step.

The deck layout for the plate reassembly and QC step is displayed.
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|~ |

LABWARE 8 REAGEMNT SETUP - Plate Reassembly and QC

ﬁPIate Reassembly and QC

Plecip._!-(ll-'ﬁ_!-‘" Precip_1-Q2F0%
ol W] [ | o [ o [ o
Mﬂﬂﬂ@@mw

e[

1) Set up reagent reservoirs as indicated below

2) Enter or scan plate barcodes as indicated above (Barcode Tracking enabled)
3) Ensure Plate Collar is properly placed on HybRxn_1 PCR plate

Water - Open Reservoir (P15) GelDiluent - Open Reservoir (P16)

Water

(User-supplied)
75 mlL

P> Start |

Figure 21 Plate reassembly and QC step deck layout.

B Abort|

@ If Prepare gel and OD plates for QC is not enabled, these plates and tips do not appear in the deck layout. See “Set the
method preferences” on page 46 for more information.

5. Place the labware and reagents on the deck as directed in the following figures and table: deck
layout.
* Figure 21—Deck layout.
* Figure 22 —Deck positions on the Biomek™ i7 Automated Workstation.

* Table 10—Table detailing the labware, reagent, and modular reservoir placement for the deck
layout.
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Stage 4: Reassemble Hybridization Ready Plate and perform sample QC "

IMPORTANT! In this stage of the assay, the four 96 deepwell 2-mL plates of resuspended
samples are reassembled into one 384 PCR plate. To avoid mislabeling samples, it is critical that
the four 96 deepwell 2-mL plates of resuspended samples are:

. All derived from one original 384-well genomic DNA sample plate and not mixed with those of
another plate being processed.

. Placed on the Biomek™ i7 Automated Workstation deck in the same order as used in “Stage 3:
Prepare the resuspension and hybridization reagent mixture” on page 78.

The barcode tracking feature of the method (see “Sample barcode tracking” on page 50) helps in
associating and maintaining the order of the four plates of resuspended samples.

oy 0 0 I I I

K3 1 ) I 3 )
I 3 2 I I
I K I
I I I

Figure 22 Deck positions on the Biomek™ i7 Automated Workstation

Table 10 Labware and reagent locations on the deck for the plate reassembly and QC step

Deck position Labware Scanl'] Reagent or sample
TL4 i-Series 50 pL filter tips (pink)
TL5 i-Series 50 pL filter tips (pink)
TL6 i-Series 50 pL filter tips (pink)
TL7 i-Series 50 pL filter tips (pink)
Peltier1 384 deep-well adapter (no other labware)
P5 384 UV platel?
P9 384 PCR plate with plate collar | || Hybridization reaction plate
P10 384 deepwell 250-pL platel?! (AB1178)
P11 384 deepwell 250-pL platel?! (AB1178)
P12 96 deepwell 2-mL plate (Use plate labeled "Q1" | || Resuspended samples,
from stage 3) quadrant 1
P13 96 deepwell 2-mL plate (Use plate labeled "Q3" | || Resuspended samples,
from stage 3) quadrant 3
P15 Deep 96 full reservoirl?! Nuclease-free water,
ultrapure MB grade
P16 Deep 96 full reservoirl?! Gel diluent
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Table 10 Labware and reagent locations on the deck for the plate reassembly and QC step (continued)

Deck position Labware Scanl'! Reagent or sample
P17 96 deepwell 2-mL plate (Use plate labeled "Q2" | | Resuspended samples,
from stage 3) quadrant 2
P18 96 deepwell 2-mL plate (Use plate labeled "Q4" | | Resuspended samples,
from stage 3) quadrant 4
TL15 i-Series 190 pL filter tips (green)l

[ Scan labware or reagent module barcode. Do not scan the image in this table.
[l QC labware. Not required if QC was disabled in method preferences.

6. Check the deck layout to ensure that the labware, reagents, and samples are in the proper
locations.

7. Place the 384 PCR plate at deck position P9, scan the labware barcode, then place the plate collar
on top of the 384 PCR plate.

IMPORTANT! Ensure that the plate collar is cleaned with 70% ethanol before and after use.

8. Scan the remaining labware barcodes.

9. Click Start to continue.
The Plate reassembly and QC step on the Biomek™ i7 Automated Workstation starts. When
complete, a message window appears.

Biomek Software

Plate Reassembly and QC is complete.

Do the following:

1. Store Hyb Rxn plate

2. Remove Gel QC plate and perform the gel analysis procedure as instructed in the user manual
3. Remove OD QC plate and perform the plate reader analysis procedure as instructed in the user
manual

4, Discard used lsbware and reagents

5. Discard used tips

6. Store unused tips

2018 7.24.58 PM

10. Complete the following tasks:

a. Remove and tightly seal the Hyb Rxn Plate from deck position P9. This plate contains the
hybridization ready samples. Store at —20°C if you will not proceed to “Stage 5: Denature
sample and transfer to hybridization tray” on page 97 following assessment of the QC
results.

b. Perform the gel assessment of the fragmentation pattern using the Gel QC Plate from deck
position P11 as described in Appendix B, “Fragmentation quality control gel protocol”. (Skip
this step if not preparing QC plates.)

¢. Perform the OD quantification on the OD QC Plate from deck position P5, then evaluate the
results as described in Appendix C, “Sample quantification after resuspension”. (Skip this step
if not preparing QC plates.)
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Stage 4: Reassemble Hybridization Ready Plate and perform sample QC
d. (Optional) Seal the Dilution (Dil_1) Plate if repeating any QC analysis is required.
e. Discard the remaining labware and tips on the deck. Click OK when done.

11. If the gel and OD quantification results are acceptable, do one of the following:

* Proceed to “Stage 5: Denature sample and transfer to hybridization tray” on page 97 if the
GeneTitan™ MC Instrument is available for hybridization.

e Store the Hyb Rxn Plate of hybridization ready samples at —20°C.
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Workflows for Stage 4: Hybridization ready plate reassembly and sample QC
Workflow for Stage 4: Plate reassembly (QC enabled)

Fill Dilution QC Plate with water

155 pL/well

(@ Water (P15)
(@ Dil_1 (P10)

v

Fill OD QC Plate with water

22 ul/well

() Water (P15)
(2 oD_1 (P5)

v

Fill Gel QC Plate with gel diluent

58 pLiwell

(D Gel diluent (P16)
@ Gel_1 (P11)

94 Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7



Chapter 4 Target preparation with the Biomek™ i7 Automated Workstation (method version 1.1, AB kit) M
Stage 4: Reassemble Hybridization Ready Plate and perform sample QC [ =0

Transfer hybridization ready samples to Hyb Rxn Plate

50 pL/well

@ Precipitation plate x 4 (P12, P13, P17, P18)
(@ HybRxn_1 (P9)

v

Transfer hybridization ready samples to Dilution QC Plate

5 pL/well
@ 50 pL
x4 ( HybRxn_1 (P9)
( Dil_1 (P10)
v

Transfer diluted samples to OD QC Plate

8 uL/well

@ 22 uL

Final volume = 30 uL/well

() Dil_1 (P10)
(@ oD_1 (P5)

v

Transfer diluted samples to Gel QC Plate

4 yL/well

58 pL

Final volume = 62 pL/well

() Dil_1 (P10)
® Gel_1 (P11)
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Stage 4: Reassemble Hybridization Ready Plate and perform sample QC

Next steps

* QC plates—perform off-line analysis with QC plates.
* Hyb reaction plate—proceed to off-line denaturation or store samples.

Workflow for Stage 4: Plate reassembly (QC disabled)

Continued from off-line resuspension

Transfer hybridization ready samples to Hyb Rxn Plate

£ B2238E3RR3RRIRRAIRARRIRR

45 pLiwell |: g i
- -

dis ]

8883883838

Final volume = 45 pL/well

x4

@ Precipitation plate x 4 (P12, P13, P17, P18)
(@ HybRxn_1 (P9)

Proceed to off-line denaturation or store samples
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Stage 5: Denature sample and transfer to hybridization tray

Stage 5: Denature sample and transfer to hybridization tray

Note: Before denaturing samples see Chapter 5, “Process array plates with the GeneTitan™
instrument” (“Stage 2—Hybridize plates in the GeneTitan™ MC Instrument” on page 122 to ensure

that the GeneTitan™ MC is ready for use.

IMPORTANT! GeneTitan™ Wash and Rinse bottles must be filled with reagents at prompt when setting

up hybridization.

Time required

Activity Time
Hands-on timel'! 5 minutes
Biomek™ i7 3 minutes
Off deck equipment—denaturation in a thermal cycler 15 minutes

' Hands-on time is the estimated time required by the user for handling samples and setting up the Biomek™ i7 deck and does not

include sample and reagent thawing time.

Input and output plates

Plate Description

Volume

Deck position

Input plate 384 PCR plate

45 pL

P9

Output plate 384 hybridization tray

35 L

P10

Equipment and labware required

Quantity ltem

As required | Laboratory tissue

1 Thermal cycler: ProFlex™ 2 x 384-well PCR System

Biomek™ i7 Automated Workstation

4 boxes Pipette tips, i-Series 190 L filter tips (green)

1 Plate collar

1 384 deep-well adapter

(Cat. No. 902234)

1 Hybridization tray (Part No. 501278) from the Axiom™ 384HT GeneTitan™ Consumables Kit

Sample plate | One plate of hybridization ready samples from Stage 4 in a 384 PCR plate
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Thermal cycler requirements

The recommended thermal cycler is the ProFlex™ 2 x 384-well PCR System (Cat. No. 4484077). The
thermal cycler must be programmed with the Axiom 2.0 Denature protocol of:

1. 95°C x 10 minutes
2. 48°C x 3 minutes
3. 48°C hold

Use the heated lid option when setting up or running the protocol

IMPORTANT! Evaporation during denaturation can negatively affect assay performance. Use the
thermal cycler, consumables, and sealing film that is recommended in the site preparation guide
to eliminate condensation and evaporation. Always use the heated lid option when programming
protocols.

Perform the pre-run checklist
The following actions are the same as described under “Perform the prerun checklist” on page 53.

See this section for details. Some or all these steps are required depending on the current state of the
Biomek™ i7 Automated Workstation.

1. Power on the Biomek™ i7 and all peripherals.
2. Check the waste container, then empty as required.

3. Open the Biomek™ Software using one of the following methods:

* Double-click the Biomek™ icon §¥ on the desktop.
* |n the Windows Search box, enter Biomek 5.

4. Home all axes.

Prepare the array plate and the Hyb Ready Sample Plate (if stored at -20°C)
Prepare the Hyb Ready Sample Plate that was stored at -20°C

1. Warm up the Hyb Ready Sample Plate at room temperature for five minutes. It is not necessary to
equilibrate the plate for longer lengths of time.

2. Make sure the Hyb Ready Sample Plate is sealed well. If the plate is not sealed well:
a. Centrifuge the plate and carefully remove the old seal.

b. If there is condensation on the top of the plate, blot dry gently with a laboratory tissue.
c. Use a fresh seal and tightly reseal the plate.
3. Vortex the Hyb Ready Sample Plate briefly, then centrifuge at 1,000 rpm for 30 seconds.

4. Place the Hyb Ready Sample Plate at room temperature.
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Stage 5: Denature sample and transfer to hybridization tray

Prepare the array plate

Warm up the array plate on the benchtop before setting up hybridization on the GeneTitan™ MC
Instrument.

1. Equilibrate the array plate in the sealed pouch at room temperature for at least 25 minutes.

2. At the end of the array warm-up time, open the pouch, then scan the array plate barcode into
the GeneTitan™ Array Plate Registration file as described in Appendix D, “Register samples in
GeneChip™ Command Console™”.

WARNING! Do not remove the array plate from the protective base or touch the surface of any
arrays.

Prepare the GeneTitan™ MC Instrument

Before you denature the Denaturation Plate samples, ensure that the GeneTitan™ MC Instrument is
ready for use. Follow the instructions in “Stage 2 —Hybridize plates in the GeneTitan™ MC Instrument”
on page 122 and Appendix D, “Register samples in GeneChip™ Command Console™”. The following is
a brief summary of the steps to perform.

1. Launch the GeneChip™ Command Console™ software, then select GCC GeneTitan Instrument
Control.

2. From the Launcher window, open GCC Portal » Samples » GeneTitan™ Array Plate Registration.

3. Upload the GeneTitan™ Array Plate Registration file.

If you do not upload your registration file before scanning the array plate barcode, the software
assigns default names to your samples.

Note: When creating the GeneTitan™ Array Plate Registration file, you can add the barcode
of the hybridization tray as a sample file attribute. Adding the barcode as an attribute enables
traceability in the system. See the GeneChip™ Command Console™ User Guide, for details on
adding attributes to sample files.

4. From GCC GeneTitan Instrument Control, select the System Setup tab.
5. For Setup Option, select Hyb-Wash-Scan.
6. Click Next.

7. Complete the following in the Plate information section:
a. Barcode: Scan or manually enter the array plate barcode, then click Next.

b. Protocol Name: Select the protocol name, then click Next.

8. Fill the Wash A, Wash B, and Rinse bottles with Axiom™ Wash Buffer A, Axiom™ Wash Buffer B,
and Axiom™ Water, respectively.
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oA

10.

11.

12.

Empty the Waste bottle.

Press the confirmation button on the GeneTitan™ MC Instrument to continue.
A fluidics check is run (~1 minute).

Open the trash bin and empty, then press the confirmation button to continue.
If already empty, the trash bin remains locked and the Status pane reads "Trash bin is empty".

Remove used trays and plates when drawers open, then press the confirmation button to continue.
If there are no consumables to remove, the Status pane reads "Drawers are empty".

Denature the Hyb Ready Sample Plate with an off deck thermal cycler

1.

3.

Ensure that the thermal cycler is powered on and the Axiom 2.0 Denature protocol with the
heated lid option has been selected.

Open the lid of the thermal cycler, then place the sealed Hyb Ready Sample Plate on the thermal
cycler. Check the integrity of the seal as evaporation can negatively affect assay performance.

Close the lid, then start the Axiom 2.0 Denature protocol.

Run the transfer denatured samples to hybridization tray step

As the hybridization ready samples are denaturing, set up the Biomek™ i7 deck for the Transfer
Denatured Samples to Hybridization Tray step.

1.

2.

100

Click File » Open.
For Look in of the Open Method window, select Axiom 384 on i7.
Select 5 Transfer Samples to Hybridization Tray Ax384 _i7, then click OK.

At the top of the Biomek Software window, click pp» Run to start the transfer denatured samples
to hybridization tray step.

The deck layout for the transfer denatured samples to hybridization tray step is displayed.
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LABWARE & REAGENT SETUP - Transfer Denatured Samples to Hybridization Tray

Transfer Denatured Samples to Hybridization Tray

o == I3 I 3 O
o nDnmmmm
o | [ [ [ [
| o [ [ [ e [
1 £ £ I3 T T 0 K

1) Enter or scan plate barcodes as indicated above (Barcode Tracking enabled)

2) Ensure Plate Collar is properly placed on HybRxn_1 PCR plate

| }Stan' ’.Abort'

Figure 23 Transfer denatured samples to hybridization tray deck layout

5. Place the labware and reagents on the deck as directed in the following figures and table:

* Figure 23—Deck layout.

* Figure 24—Deck positions on the Biomek™ i7
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* Table 11—Table detailing the labware, reagents, and modular reservoir placement for the deck
layout.

IMPORTANT!

. Write only on the proper location of the hybridization tray (on the edge in front of wells
A1 and F1) as illustrated in Figure 49. Do not write on any other side, as the writing can
interfere with sensors inside the GeneTitan™ MC Instrument and result in experiment failure.

. Ensure to remove the hybridization tray cover before loading the hybridization tray onto the
deck.

oy 0 I I I

K3 i1 ) I 3 )
o e e e e e e
I I I
I I I

Figure 24 Deck positions on the Biomek™ i7 Automated Workstation

Table 11 Labware and reagent locations on the deck for the transfer denatured samples to hybridization
tray step

Deck position Labware Scanl'! Reagent or sample

TL4 i-Series 50 pL filter tips (pink)

TL5 i-Series 50 pL filter tips (pink)

TL6 i-Series 50 pL filter tips (pink)

TL7 i-Series 50 pL filter tips (pink)

Peltier1 384 deep-well adapter (no other labware)

P9 384 PCR plate from stage 4 with plate collar I” ”I Hybridization ready samples
P10 Hybridization tray I” ”I Hybr|d|za'c|o:a'cr:]aglI :s)r denatured

[ Scan labware or reagent module barcode. Do not scan the image in this table.

6. After setting pipette tips and hybridization tray on deck, return to the thermal cycler, then retrieve
the denatured hybridization ready plate immediately after the Axiom 2.0 Denature protocol has
completed.

IMPORTANT! Avoid letting the samples sit at room temperature for an extended amount of time
after denaturation. Do not remove the denatured hybridization ready plate from the thermal cycler
unless both the GeneTitan™ MC Instrument and Biomek™ i7 Automated Workstation are ready.

7. Remove seal from the denatured hybridization ready plate, then place the plate on the deck at
position P9.
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8. Scan labware barcodes, then place the plate collar on the Hyb Reaction (HybRxn_1) Plate.

9. Click Start immediately after the denatured hybridization ready sample plate is placed on the deck.
The method begins. After the step is complete, a message window appears.

Biomek Software

Transfer Samples to Hyb Tray is complete.

Do the following:
1. Remove Hyb Tray and process in GeneTitan as instructed in the user manual

2. Discard used multi-channel tips

31872018 7:28:01 PM

10. Immediately load the hybridization tray plate from deck position P10 into the GeneTitan™ MC
Instrument.

11. Discard the remaining labware and tips on the deck. Click OK when done.

Load hybridization tray and array plate into the GeneTitan™ MC Instrument

1. Immediately on completion of the Transfer Denatured Samples to Hyb Tray step on the Biomek™ i7,
load the hybridization tray and array plate into the GeneTitan™ MC Instrument following the
instructions in “Stage 2 —Hybridize plates in the GeneTitan™ MC Instrument” on page 122.

2. Near the end of the 23.5 to 24-hour hybridization in the GeneTitan™ MC Instrument, proceed to
“Stage 6: Prepare GeneTitan™ reagents” on page 105.
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Continued from off-line denaturation

v

Transfer denatured samples to hybridization tray

35 pL/well

0 o

Final volume = 35 pL/well

(D HybRxn_1 (P9)
(2 Hybridization tray (P10)

v

Process hybridization tray on the GeneTitan™ Multi-Channel Instrument
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Stage 6: Prepare GeneTitan™ reagents

IMPORTANT! The reagent trays that are prepared in this stage are for the continued processing of an
Axiom™ array plate that is:

. Already on the GeneTitan™ MC Instrument.

. Has completed the hybridization stage.

. Is ready for transfer to the GeneTitan™ MC fluidics area.

The reagent trays for the fluidics stage on the GeneTitan™ MC Instrument cannot be prepared in

advance. Do not prepare these plates if there is no array plate ready for the fluidics stage. After
prepared, these plates must be loaded onto the instrument as soon as possible and cannot be stored.

Time required

Activity Time
Hands-on timel'l 30 minutes
Biomek™ i7 54 minutes

' Hands-on time is the estimated time required by the user for handling reagents and setting up the Biomek™ i7 deck and does not
include reagent thawing time.

Materials, labware, and reagents required

Equipment and labware required

Quantity Item

As required | Laboratory tissue

1 Mini microcentrifuge (microcentrifuge with microtube rotor)

1 Vortexer

Biomek™ i7 Automated Workstation

Items required from the Axiom™ 384HT GeneTitan™ Consumables Kit (Cat. No. 902234)
® Scan tray with cover and protective base

* 1 * Stain trays

* Covers for stain trays

Pipette tips:
* 2boxes | ® i-Series 190 pL filter tips (green)
* 1 box ® i-Series 1,025 pL filter tips (orange)

1 Reagent block, chilled to 4°C

1 Quarter Reservoir, Divided by Width
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(continued)
Quantity Item
5 Quarter Reservoir
1 Half Reservoir
1 Deep 96 full reservoir
1 24-position tube rack with 2 inserts (room temperature rack)

Reagent handling

Prepare reagents according to the following table.

Thaw,
Module |Qty G I then Plallce on FLEJC Deck loading instructions
color place ice room temp
on ice
2 | @Axiom™ Ligate v Vortex for 30 seconds. ' Pour in
Buffer reservoir.
2 .Axiom” Ligate ® Do not thaw. Keep at —20°C until Immediately before use: Gently
Enzyme ready to use. flick tube 3 times, then
centrifuge. Place in chilled
reagent block.
Module 4-1 2 .Axiom” Ligate v Vo.rtex, then centrifuge. Place in
_20°C Soln 1 chilled reagent block.
2 .Axiomm Probe v Vortex, then centrifuge. Place in
Mix 1 chilled reagent block.
2 .Axiomm Stain v Vortex, then centrifuge. Place in
Buffer chilled reagent block.
2 Axiom™ Stabilize v Vortex, then centrifuge. Place in
Soln chilled reagent block.
2 .Axiom“ Ligate v Vortex, then centrifuge. Place in
Soln 2 chilled reagent block.
2 .Axiomm Probe Gently flick tube 3 times,
Mix 212] v then centrifuge. Place in chilled
Module 4-2 reagent block.
2°Cto8C| @~xiom™ Wash A v Vortex for 30 seconds.[l Pour in
reservoir.
2 | @Axiom™ Stain 1-AP Gently flick tube 3 times,
v then centrifuge. Place in chilled
reagent block.
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LA

(continued)
Thaw,
Module |Qty Reagent and cap then Plalce on Place at Deck loading instructions
color place ice room temp
on ice
2 | @Axiom™ Stain 1-B2 Gently flick tube 3 times,
v then centrifuge. Place in chilled
reagent block.
2 | @Axiom™ Stain 2-AP Gently flick tube 3 times,
v then centrifuge. Place in chilled
reagent block.
Module 4-2| 2 @~Axiom™ Stain 2-BF] Gently flick tube 3 times,
2°C to 8°C v then centrifuge. Place in chilled
reagent block.
2 Axiom™ Stabilize v Vortex, then centrifugel'l. Place
Diluent in chilled reagent block.
1 Axiom™ Water v Pour in reservoir.
2 | Axiom™ Hold v Vortex for 30 seconds.

Bufferl

Pour in reservoir.

Estimated reagent thawing time is 1 hour.

' Check for precipitate.
[l These solutions are light sensitive. Keep tubes out of direct light for a prolonged length of time.

Notes on handling reagents with precipitates

Prepare Axiom™ Wash A

1.

2.

Vortex for 30 seconds.

Place on the benchtop at room temperature for 30 minutes.

Examine the reagent for precipitate (look into the top of the bottle).

If precipitate is still present, vortex again for 30 seconds.

Pour Axiom™ Wash A into the appropriate reagent reservoir.

Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7

107



78  Chapter 4 Target preparation with the Biomek™ i7 Automated Workstation (method version 1.1, AB kit)
Stage 6: Prepare GeneTitan™ reagents

Prepare Axiom™ Stabilize Diluent

During storage of the Axiom™ Stabilize Diluent (in Module 4-2 stored at 4°C), precipitation in the form
of clear crystals can sometimes occur. Therefore, use the following procedure to ensure that any
precipitate is returned to solution prior to use.

The presence of some precipitate is okay and does not adversely impact assay performance. Use the
following procedure to resuspend any precipitate before use.

1. Vortex, then centrifuge briefly.
2. Examine the reagent for precipitate.
3. If precipitate is observed, warm the tube to room temperature, vortex, then centrifuge again.

Prepare Axiom™ Ligate Buffer

White precipitate is sometimes observed when the Axiom™ Ligate Buffer is thawed. The presence
of some precipitate is okay and does not adversely impact assay performance. Use the following
instructions to resuspend most precipitate before use.

1. Vortex for 30 seconds.
2. Examine the buffer for precipitate.
3. If precipitate is still present, warm the bottle with your hands, then vortex again for 30 seconds.

4. Pour the Axiom™ Ligate Buffer into the appropriate reagent reservoir.

Perform the pre-run checklist

The following actions are the same as described under “Perform the prerun checklist” on page 53.
See this section for details. Some or all these steps are required depending on the current state of the
Biomek™ i7 Automated Workstation.

1. Power on the Biomek™ i7 and all peripherals.
2. Check the waste container, then empty as required.

3. Open the Biomek™ Software using one of the following methods:

* Double-click the Biomek™ icon £ on the desktop.
* In the Windows Search box, enter Biomek 5.

4. Home all axes.

Run the GeneTitan™ reagent preparation step
1. Click File » Open.

2. For Look in of the Open Method window, select Axiom 384 on i7.
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3. Select 6 GeneTitan Reagent Preparation Ax384._i7, then click OK.

4. At the top of the Biomek Software window, click - Run to start the GeneTitan™ reagent
preparation step.
The deck layout for the GeneTitan™ reagent preparation step is displayed.

LABWARE & REAGENT SETUP - GeneTitan Reagent Preparation

GeneTitan™ Reagent Preparation

| o ISR e | R | s | e
=i

Sample Plate |— SELECT USER — ¥ || DATE — ¥ ||~ SAMPLE PLATE BARCODE — ¥ |

1) Set up reagent reservoirs and tubes as indicated below
2) Enter or scan plate barcodes as indicated above (Barcode Tracking enabled)

GT-2 - Modular Reservoir (P14) GT-1 - Modular Reservoir (P15) RT_Tube_Rack - Room Temp Tube Rack (P13) Cold Tubes (Peltier 3)

Empty Holding Empty Empty
174 Buffer /4 174
Reservoir || 2 Bottles || Reservoir || Reservoir

P start | B Abort|

Figure 25 GeneTitan™ reagent preparation deck layout.
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5. Place the labware and reagents on the deck as directed in the following figures and table: deck
layout.

Figure 25—Deck layout.

Figure 26 —Deck positions on the Biomek™ i7.

Table 12 —Table detailing the labware, reagent, and modular reservoir placement for the deck
layout.

£ 21 K 3 A I

K3 1 3 I3 I I
I T I I T )
TL2 TL7 § TL10 P10 P15
TL3 TL8 [ Pelier2 m P11 P16

Figure 26 Deck positions on the Biomek™ i7 Automated Workstation.

_|

Table 12 Labware and reagent locations on the deck for the GeneTitan™ reagent preparation step.

Deck position Labware Scanl'l Reagent or sample
Peltier1 384 deep-well adapter (no other labware)
P2 Axiom™ Stabilization Tray (green label)
P3 Axiom™ Stain2 Tray (blue label)
P4 Axiom™ Ligation Tray (yellow label)
P5 GeneTitan™ Stain Tray (white label)
P6 GeneTitan™ Stain Tray (white label)
P11 Deep 96 full reservoir
P13 24-Position Tube Rack See Figure 28.
P14 Reservoirs in frame:
* Quarter divided by width reservoir (1 and @
2) ® ©®
® Quarter reservoir (3) @
* Half reservoir (4)

@ Pour 2 bottles Axiom™ Ligate
Buffer into reservoir 1.

@ Pour 17 mL Axiom™ Water into
reservoir 2.

@ Leave reservoir 3 empty.

@ Pour 2 bottles of Axiom™
Wash A into reservoir 4.
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Table 12 Labware and reagent locations on the deck for the GeneTitan reagent preparation
step. (continued)

Deck position Labware Scanl' Reagent or sample

P15 Reservoirs in frame:

1
2
3
4

e Quarter reservoir
® Quarter reservoir

® Quarter reservoir

—_— o~ o~ o~

)
) ORRORNORNO)
)
)

® Quarter reservoir

(D Leave reservoir 1 empty.

@ Pour 2 bottles of Axiom™ Hold
Buffer into reservoir 2.

(3 Leave reservoir 3 empty.
@ Leave reservoir 4 empty.

P16 GeneTitan™ Scan tray on blue protective base

Peltier3 Reagent block, chilled to 4°C I | See Figure 27.
TL11 Pipette tips, i-Series 1,025 pL filter tips
(orange)
TL12 Pipette tips, i-Series 190 pL filter tips (green)

TL15 Pipette tips, i-Series 190 pL filter tips (green)

' Scan labware or reagent module barcode. Do not scan the image in this table.

Diluent

Figure 27 Reagent cold block for GeneTitan™ reagent preparation.
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Stage 6: Prepare GeneTitan™ reagents

10.

11.

Ligate
Sollétion

Ligate
Solution
2

Figure 28 Placement on reagents on 24-position tube rack for GeneTitan™ reagent preparation.

Check the deck layout to ensure that the labware, reagents, and samples are in the proper
locations.

For Sample Plate, make the appropriate selections from the dropdown lists under the deck setup
image.

Note: The Date dropdown list indicates the date that the "Transfer Samples to Hybridization Tray"
step was run and the Sample Plate Barcode dropdown list indicates the barcode of the sample
plate that is used during the amplification step (Sample_1).

Scan the labware and reagent barcodes.

Click Start to continue.
The GeneTitan reagent preparation step on the Biomek™ i7 Automated Workstation starts.

Prepare the GeneTitan™ MC Instrument.

During the reagent tray preparation on the Biomek™ i7 Automated Workstation, ensure that the
GeneTitan™ MC Instrument is ready for use by following the instructions that are given in “Stage
3—Ligate, wash, stain, and scan” on page 134, and summarized here.

a. Fill the Wash A, Wash B, and Rinse bottles with Axiom™ Wash Buffer A, Axiom™ Wash
Buffer B, and Axiom™ Water from Module 3 respectively.

b. Empty the Waste bottle.
c. Empty the trash bin.

d. Remove consumable trays and plates as instructed, except for the blue base. Leave the blue
array plate base in drawer 6 although the base is empty.

When message window appears indicating that the GeneTitan reagent preparation step is
complete, do not click OK yet.
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Chapter 4 Target preparation with the Biomek™ i7 Automated Workstation (method version 1.1, AB kit) ¥
Stage 6: Prepare GeneTitan™ reagents

Remove the 5 stain trays with reagents and the scan tray with Axiom™ Hold Buffer from the deck,
then examine each tray to ensure that:

* All the wells have been filled. If any wells do not contain reagents, then manually add reagents
to these wells.
* There are no air bubbles present. Puncture any air bubbles that you see using a pipette tip.

Cover the 5 stain trays and the scan tray with lids. If needed, see Figure 48 for information on
proper placement of the stain tray lids.

Immediately transfer the 5 stain trays and the scan tray to the GeneTitan™ MC Instrument and
load. See “Stage 3—Ligate, wash, stain, and scan” on page 134 to continue the process on the
GeneTitan™ MC Instrument.

Return to the Biomek™ i7 Automated Workstation, then clear the deck as instructed in the message
window.

Biomek Software

GeneTitan Reagent Prep is complete.

Do the following:

1. Continue processing reagent trays in the GeneTitan
2. Discard used labware and reagents

3. Discard used tips

4. Store unused tips

5. Store cold block at 4 deg C

3182018 7:39:58 PM

Complete the following tasks.

a. Store the unused BC1025F tips from deck position TL11 and unused BC190F tips from deck
position TL12.

b. Discard the tubes from the cold block at the Peltier3 deck position. Store the cold block at
4°C.

¢. Discard the tubes from the 24-Position Tube Rack at deck position P13. Store the 24-Position
Tube Rack.

d. Discard the remaining labware and tips on the deck. Store the reservoir frames. Click OK
when done.
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Workflow for Stage 6: GeneTitan™ reagent preparation

Transfer Axiom™ Hold Buffer to scan tray

170 pLiwell

O=d

Final volume = 170 pL/well

(D Axiom™ Hold Buffer (P15)
@ Scan tray (P16)

Prepare Stabilize Master Mix and stain tray

: 2x822 yL

2x
4°C

@ 2x98.7 uL 35 pL/well

2x

14,598.7 pL

»
®

@ Axiom™ Stabilize Diluent (Peltier 3)
@ Axiom™ Stabilize Soln (Peltier 3)
(3 Axiom™ Water (P14)

(@ Stabilize MM (P15)

@ Stabilize stain tray (P2)

4C L ®

Final volume = 35 pL/well
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V4 I

Transfer Axiom™ Wash A to Stain 1 & 2 Master Mix reservoirs

30,604.8 uL

®

15,782.4 uL

4
A

(1) Axiom™ Wash A (P14)
(2 Stain 1 MM (P14)
(3®) Stain 2 MM (P15)

Transfer Axiom™ Stain Buffer to Stain 1 Master Mix reservoir

C 2x318.8 uL
2x
4°C

Ol=4a

@ Axiom™ Stain Buffer (Peltier 3)
(2 Stain 1 MM (P14)

Transfer Axiom™ Stain 1-A & Axiom™ Stain 1-B to Stain 1 Master Mix reservoir

@ 2 x 159.4 pL

2Xx
4°C
@_ 2x159.4 L P
2Xx
4°C

() Axiom™ Stain 1-A (Peltier 3)
(2 Axiom™ Stain 1-B (Peltier 3)
(3 Stain 1 MM (P14)
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Stage 6: Prepare GeneTitan™ reagents

Transfer Stain 1 Master Mix to Stain 1 reservoir

Reservoir contents / I i

L

©, @
(D Stain 1 MM (P14)
() staint (P11)

Transfer Axiom™ Stain Buffer to Stain 2 Master Mix reservoir

®_ 2x164.4 uL m

2x
4°C

®

@ Axiom™ Stain Buffer (Peltier 3)
() Stain 2 MM (P15)

Transfer Axiom™ Stain 2-A & Axiom™ Stain 2-B to Stain 2 Master Mix reservoir

O— 2x82.2 L

2x W
4°C
@ 2x822uL

2x
4°C

®)

(1) Axiom™ Stain 2-A (Peltier 3)
(2) Axiom™ Stain 2-B (Peltier 3)
(3 Stain 2 MM (P15)
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Stage 6: Prepare GeneTitan™ reagents

Prepare Stain 1 stain trays

35 pL/well

35 pLiwell

Final volume = 35 uL/well

(@ staint (P11)
@ Stain 1-1 stain tray (P5)
@ Stain 1-2 stain tray (P6)

Prepare Stain 2 stain tray

35 pL/well

o0

Final volume = 35 uL/well

(1) Stain 2 MM (P15)
@ Stain 2 stain tray (P3)
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Prepare Ligate Master Mix & stain tray

10,357.2 pL
2x 2x1,027.5 uL
4°C
o=
2 x 246.6 L
2x|_| —
4°C 35 uLiwell
O—m
2x123.3 pL L] —7 ‘
2 | ©
M Final volume = 35 pL/well
C W inal volume = 35 plL/we
2 x 822 uL
2x L
4°C
2 x 822 uL
2 x
4°C

@ Axiom™ Ligate Buffer (Peltier 3)
@ Axiom™ Ligate Soln 1 (Peltier 3)
(3 Axiom™ Ligate Soln 2 (P11)

@ Axiom™ Ligate Enzyme (Peltier 3)
(5) Axiom™ Probe Mix 1 (Peltier 3)
(&) Axiom™ Probe Mix 2 (Peltier 3)
(@ Ligate MM (P15)

Ligate stain tray (P4)

Place stain and scan trays in the GeneTitan™ Multi-Channel Instrument.
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Process array plates with the
GeneTitan™ instrument

m Stage 1—Create and upload a GeneTitan™ Array Plate Registration file .................... 120
m Stage 2—Hybridize plates in the GeneTitan™ MC Instrument ............................. 122
B Stage 3—Ligate, wash, stain,and scan .......... . e e 134
B SCan WOrKIIOW . .. e 140
B Shut down the GeneTitan™ MC Instrument . ........ ...ttt i anens 141

Note: In this chapter and throughout the document, the instructions and consumables for the
GeneTitan™ MC Instrument are applicable to the GeneTitan™ MC Fast Scan Instrument.

IMPORTANT! For optimal GeneTitan™ MC Instrument performance, ensure that the maximum relative
humidity is 80% for temperatures up to 75.2°F (24°C), with a minimum humidity of 30 £7% relative
humidity. Operating outside the working environment specifications leads to higher static levels, and
results in the evaporation of reagents from stain trays.

IMPORTANT! Review Appendix A, “Recommended techniques for GeneTitan™ MC Instrument
operation” for details on array processing setup options and consumable handling.
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Stage 1—Create and upload a GeneTitan™ Array Plate Registration file

[N

Stage 1—Create and upload a GeneTitan™ Array Plate
Registration file

A batch registration file must be created and uploaded with GeneChip™ Command Console™ (GCC)
software before you start “Stage 2 —Hybridize plates in the GeneTitan™ MC Instrument” on page 122.
This file contains information critical for data file generation during scanning, and for tracking the
experimental results for each sample loaded onto an array plate. This file can be created at any time
before loading the array plate and hybridization tray onto the GeneTitan™ MC Instrument.

Note: When creating the GeneTitan™ Array Plate Registration file, you can scan the barcode of the
hybridization tray to implement sample traceability. If you do not upload the sample file names before
scanning the array plate barcode, the software assigns names to the samples.

The array plate barcode is scanned when you are ready to load the array plate and samples onto the
GeneTitan™ MC Instrument for processing.

1.

120

If you have already created, then saved a batch registration file but have not yet uploaded the file
to GCC, open the file, then go to step 6.

From the Launcher window, open GCC Portal » Samples » GeneTitan™ Array Plate
Registration.

In the GeneTitan™ Array Plate Registration window, from the GeneTitan Array Plate Type list,
select the plate type to be processed.

Click Download.

In the Samples tab of the GeneTitan™ Array Plate Registration file, enter a unique name for each
sample (Sample File Name) and any additional information.

Additional information on the GeneTitan™ Array Plate Registration file is in the GeneChip™
Command Console™ User Guide.

Scan the array plate barcode into the yellow Barcode field, column F.
See Figure 29.

Scan the barcode of the hybridization tray if the array plate registration file template includes a
column for the hybridization tray barcode.

Save the file.
By default, the file is saved in the Applied Biosystems Download folder.

Return to the GCC Portal GeneTitan™ Array Plate Registration page.
a. Click Browse, navigate to the array plate registration file, then click Open.

b. Under Step 3, click Upload, wait for the information to load, then click Save found at the
bottom of the next window that is displayed.
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= AL 3 G L 4 c - - . - =X
f @ EY GeneTitanArrayPlateRegistration_40.xlsx [Compatibility Mode] - Microsoft Excel non-commercial use
a

Inse Pagelayout  Formulas  Data  Review  View Aqobat @ - 7 x
T &

% Cut = —

! 3 || B EE | T AutoSum *
Arial -l - == -| | SEwrap Text Text - = 7 Iy | cmm T W
. [ [#-] | Swe - E B W = 5 O Sri- lﬁ
P romat panier || B LB [ || SMerge acenter - [ - % 0[5 2] e syese | o e T G kear e seeds
Clipboard {F] Font Pl Alignment (Fi Mumber {Fi Styles Cells Editing
[ a3 - fe | sample_an2
A B c D E F G H | J K
1 |Sample File Path Project Plate Type Probe Array Type Probe Arr Barcode Sample File Name Array Name Hyb Tray Barcode:*:Text Sample Tray Barcode:™:Text
2 Default 384 AIMS-384 384 AIMS AD1 "5504121127111111111000 Sample A01 Sample_A01 202757 2027123
3 Default 384_AIMS-384 384_AIMS A2 £504121127111111111000 ISamEIe A02 _lSamp\e_A[]E 202757 2027123
4 Default 384 AIMS-384 384 AIMS AD3 5504121127111111111000  Sample_A03 Sample_A03 202757 2027123
5 Default 384_AIMS-384 384_AIMS A4 5504121127111111111000  Sample_A04 Sample_A04 202757 2027123
6 Default 384 AIMS-384 384 AIMS AD5 5504121127111111111000  Sample_A05 Sample_A05 202757 2027123
[ Default 384_AIMS-384 384_AIMS A0B 5504121127111111111000  Sample_A06 Sample_A06 202757 2027123
8 Default 384 AIMS-384 384 AIMS AOT £504121127111111111000  Sample_A07 Sample_A0T 202757 2027123
9 Default 384_AIMS-384 384_AIMS A8 5504121127111111111000  Sample_A08 Sample_A08 202757 2027123
10 Default 384 AIMS-384 384 AIMS A0S £504121127111111111000  Sample_A09 Sample_A09 202757 2027123
11 Default 384_AIMS-384 384_AIMS A10 5504121127111111111000  Sample_A10 Sample_A10 202757 2027123
12 Default 384 AIMS-384 384 AIMS A1 5504121127111111111000 Sample_A11 Sample_A11 202757 2027123
13 Default 384_AIMS-384 384_AIMS A12 5504121127111111111000  Sample_A12 Sample_A12 202757 2027123
14 Default 384 AIMS-384 384 AIMS A13 5504121127111111111000  Sample_A13 Sample_A13 202757 2027123
15 Default 384_AIMS-384 384_AIMS A4 5504121127111111111000  Sample_A14 Sample_A14 202757 2027123
16 Default 384 AIMS-384 384 AIMS A15 5504121127111111111000  Sample_A15 Sample_A15 202757 2027123
17 Default 384_AIMS-384 384_AIMS A16 5504121127111111111000  Sample_A16 Sample_A16 202757 2027123
18 Default 384 AIMS-384 384 AIMS A1T £504121127111111111000  Sample_A17 Sample_A17 202757 2027123
19 Default 384_AIMS-384 384_AIMS Al 5504121127111111111000  Sample_A18 Sample_A18 202757 2027123
20 Default 384 AIMS-384 384 AIMS A9 5504121127111111111000  Sample_A19 Sample_A19 202757 2027123
21 Default 384_AIMS-384 384_AIMS A20 5504121127111111111000  Sample_A20 Sample_A20 202757 2027123
22 Default 384 AIMS-384 384 AIMS A21 5504121127111111111000 Sample_A21 Sample_A21 202757 2027123
23 Default 384_AIMS-384 384_AIMS A22 5504121127111111111000  Sample_A22 Sample_A22 202757 2027123
24 Default 384 AIMS-384 384 AIMS A23 5504121127111111111000  Sample_A23 Sample_A23 202757 2027123
25 Default 384_AIMS-384 384_AIMS A24 5504121127111111111000  Sample_A24 Sample_A24 202757 2027123
26 Default 384 AIMS-384 384 AIMS B01 5504121127111111111000  Sample_A25 Sample_A25 202757 2027123
27 Default 384_AIMS-384 384_AIMS B02 5504121127111111111000  Sample_A26 Sample_A26 202757 2027123
28 Default 384 AIMS-384 384 AIMS B03 £504121127111111111000  Sample_A27 Sample_A27 202757 2027123
29 Default 384_AIMS-384 384_AIMS B4 5504121127111111111000  Sample_A28 Sample_A28 202757 2027123
30 Default 384 AIMS-384 384_AIMS B05 5504121127111111111000  Sample_A29 Sample_A29 202757 2027123
N Default 384_AIMS-384 384_AIMS BO6 5504121127111111111000  Sample_A30 Sample_A30 202757 2027123
32 Default 384 AIMS-384 384_AIMS BO7 5504121127111111111000  Sample_A31 Sample_A31 202757 2027123
33 Default 384_AIMS-384 384_AIMS B03 5504121127111111111000  Sample_A32 Sample_A32 202757 2027123
M Default 384 AIMS-384 384_AIMS B09 5504121127111111111000  Sample_A33 Sample_A33 202757 2027123
35 Default 384_AIMS-384 384_AIMS B10 £504121127111111111000  Sample_A34 Sample_A34 202757 2027123
36 Default 384 AIMS-384 384_AIMS B11 5504121127111111111000  Sample_A35 Sample_A35 202757 2027123
37 Default 384_AIMS-384 384_AIMS B12 £504121127111111111000  Sample_A36 Sample_A36 202757 2027123
38 Default 384_AIMS-384 384_AIMS B13 £504121127111111111000  Sample_A37 Sample_A37 202757 2027123
39 Default 384_AIMS-384 384_AIMS B14 £504121127111111111000  Sample_A38 Sample_A38 202757 2027123
40 Default 384_AIMS-384 384_AIMS B15 £504121127111111111000  Sample_A39 Sample_A39 202757 2027123
M Default 384_AIMS-384 384_AIMS B16 £504121127111111111000  Sample_A40 Sample_A40 202757 2027123
42 Default 384_AIMS-384 384_AIMS B17 £504121127111111111000 Sample_A41 Sample_A41 202757 2027123
43 Default 384_AIMS-384 384_AIMS B18 5504121127111111111000  Sample_A42 Sample_A42 202757 2027123
44 Default 384_AIMS-384 384_AIMS B19 5504121127111111111000  Sample_A43 Sample_A43 202757 2027123
45 Default 384 AIMS-384 384 AIMS B20 5504121127111111111000  Sample_Ad4 Sample_A44 202757 2027123
M 4 » M| Samples %1 I_ Jil
Ready [EEEET e

Figure 29 Example of a GeneTitan™ Array Plate Registration file.

Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7 121



= Chapter 5 Process array plates with the GeneTitan™ instrument
Stage 2—Hybridize plates in the GeneTitan™ MC Instrument

Stage 2—Hybridize plates in the GeneTitan™ MC Instrument

Materials, labware, and reagents required

Reagents required
The following reagents from the Axiom™ 2.0 384HT Reagent Kit are required for the hybridization step.

Reagent Module
Axiom™ Wash Buffer A (both bottles, 1 L) Module 3,
Axiom™ Wash Buffer B Room temperature
Axiom™ Water Part No. 901472

Materials required

¢ Hybridization tray containing denatured samples.

Note: The denatured samples must be transferred to the hybridization tray only after the
GeneTitan™ MC Instrument is ready for loading, described in the “Load an array plate and
hybridization tray into the GeneTitan™ MC Instrument” on page 127.

* A human or non-human Axiom™ 384HT Array Plate or an Axiom™ myDesign™ Array Plate (384HT
format) is required for this step. Before inserting this plate into the GeneTitan™ MC Instrument for
hybridization, the array plate must be at room temperature.

Warm array plate to room temperature

The array plate must be at room temperature before setting up hybridization on the GeneTitan™ MC
Instrument.

1. Remove the array plate packaging from the 4°C refrigerated storage.

2. Open the array plate box, then remove the pouch containing the array plate and protective base.
Do not open the pouch.

3. Equilibrate the unopened pouch on the bench for at least 25 minutes.

4. At the end of the array warm-up time, open the pouch, then scan the array plate barcode into the
batch registration file.
See “Stage 1—Create and upload a GeneTitan™ Array Plate Registration file” on page 120.

WARNING! Do not remove the array plate from the protective base or touch the surface of any
arrays.
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Set up the GeneTitan™ MC Instrument

1. Select GCC GeneTitan Control from the GCC Launcher.
The system initializes. After initialization, the System Status tab is selected and the status of the
hybridization oven is displayed at the bottom of the Log panel. The status reads <Time of day>
System Ready.

Note: The instrument control software displays a warning message when a problem is detected
during the fluid dispense operations. The filters in the GeneTitan™ Wash A, Wash B, and Rinse
bottles must be replaced if the software displays such a warning.

IMPORTANT! Do not close the scanner application by right-clicking and selecting the Close
option. This method causes the scanner application to exit abnormally and delay in processing the
next plate. The correct way to close the application is described in “Shut down the GeneTitan™ MC
Instrument” on page 141.
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File  Tools  Help

-2 |

Stop Email Help

System Setup |

Setup Option ||Hyh-Wash-5can j

i~ Plate Infarmation

Barcode |5500324053357’U1 2609098

Plate Type

Pratocol Name

Location Load consumables on left side

—Waorkflow Steps

[ 17

late Barcode
Refill glass bottles with buffer
Ernpty trash hin
Remove consumable trays and plates
Load consumahkle trays and plates
Selectarrays ta scan
Start Processing

= Status

[

Flease selectthe protocal

Press the Next button to adwance to the next step.

Cancel | Hext |

Figure 30 System Setup tab

@ System Setup tab.
@ Setup Option: Access a dropdown list of the various options available for processing Axiom™ array plates.
@ Barcode: The array plate barcode. The barcode can be scanned or entered manually.

@ Protocol Name: The dropdown list of protocols that are displayed is based on the first six digits of the array
plate barcode. Only the protocols that are valid for the array plate type that is loaded are displayed.

@ Workflow Steps: This field displays an overview of the user actions that are required to process an array plate
that is based on the Setup Option selected.

@ Status: This field displays the actions that must be performed to prepare or unload the GeneTitan™ MC
Instrument for the Setup Option that has been selected.

After each action, click the Next button or to press the blinking blue confirmation button on the GeneTitan™ MC
Instrument to continue.

Select Hyb-Wash-Scan from the Setup Option dropdown list.

Other options available are described under “Setup options for array plate processing” on
page 149.

Click Next.

Note: A message is displayed when there is insufficient disk space. Delete or move .dat files to
another location to free up sufficient disk space for the data that are generated by 8 Axiom™ 384HT
Array Plates. One 384HT-array plate requires ~27 GB.
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4. Scan or manually enter the array plate barcode, then click Next.

The first six characters of the barcode identify the type of plate being loaded, the protocol
GeneTitan™ MC Instrument uses to process the plate, and the imaging device parameters required
for the plate.

Note: If an error message is displayed after entering the array plate barcode, do the following:
. Ensure that the library files for the type of array plate you are using are correctly installed.

. Library files must be installed before launching the GeneTitan™ MC Instrument. If a library
file must be installed, exit the GeneTitan™ MC Instrument, install libraries and relaunch the
GeneTitan™ MC Instrument.

. Try manually entering the array plate barcode.

5. Select a protocol from the Protocol Name dropdown list, then click Next.

6. Refill the bottles with Module 3 reagents.

* Wash A: fill with Axiom™ Wash Buffer A—keep at 2 L full.

¢ Wash B: fill with Axiom™ Wash Buffer B—use all 600 mL of Wash B from the reagent kit per
Axiom™ 384HT Array Plate. Fill to 1-L mark when processing two plates on the same day.

* Rinse: fill with Axiom™ Water—keep at 1 L full.

IMPORTANT! Always ensure that the GeneTitan™ bottles containing Wash A and Rinse are above
the 50% mark when setting up the system to process an array plate.

All 600 mL of the Wash Buffer B from the Axiom™ 2.0 384HT Reagent Kit must be emptied into the

GeneTitan™ Wash B bottle when setting up the system.

. Using all the Wash B contents from the reagent kit helps ensures that the GeneTitan™ Wash B
bottle is filled to more than the minimum requisite 35% of bottle volume.

. If you intend to load two array plates on the same day, fill the Wash B bottle to the 1-L mark (use
both bottles from the Axiom™ 2.0 384HT Reagent Kit).

Do not overfill the bottles.

. The maximum volume for the Wash B and Rinse bottles is 1 L. Fill to the 1-L mark only.

. The maximum volume for the Wash A bottle is 2 L.

We strongly recommend refilling these bottles every time you are prompted to do so. If the volume

in any of these bottles becomes too low during a run, a message is displayed. However, even if
you fill the bottle now, the instrument cannot complete the step that was in progress.

7. Empty the waste bottle.

8. Press the blue confirmation button on GeneTitan™ MC Instrument to continue.
A fluidics check is run (~1 minute).
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—Workflow Steps

Empty trash bin

Remove consumable trays and plates
Select arrays to scan

Start Processing

~ Status v—

Buffer botfles hawve been depressurized:
(:) Please refill buffer into the bottles
Ermpty the waste bottle
Press the Confirrmation button when done.
This is followed by a Fluidics check (™1 Minute..)

Cancel |

(D Workflow Step
@ Specific instructions for the current workflow step are displayed in the Status pane.

9. Empty the trash bin.
a. Open the trash bin and empty.

b. If already empty, the trash bin remains locked and the Status pane reads "Trash bin is empty".
c. Press the blue confirmation button to continue.

10. Remove consumable trays and plates.
a. Remove used trays and plates when drawers open.

b. If no consumables to remove, the Status window reads "Drawers are empty".
c. Press the blue confirmation button on the GeneTitan™ Instrument to continue.

11. Continue to “Load an array plate and hybridization tray into the GeneTitan™ MC Instrument” on
page 127 when prompted by the GCC software.
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Load an array plate and hybridization tray into the GeneTitan™ MC
Instrument

The steps in “Set up the GeneTitan™ MC Instrument” on page 123 must be completed before starting
the following procedure.

1. When drawer 6 opens, load the array plate and hybridization tray in the following manner:

a. Examine the wells of the hybridization tray for bubbles, then puncture any bubbles with a
pipette tip.

IMPORTANT! Removing bubbles at this step greatly reduces the chance of bubbles under
the arrays when the hybridization tray and the array plate are clamped. Bubbles under an array
can result in black spots on the array image.

b. Load the uncovered hybridization tray on the right side of the drawer.

¢. Remove the array plate and protective blue base from its package. For more information on
the array packaging, see “Array plate packaging” on page 143.

To avoid dust or other damage, leave the array plate packaged until ready to load onto the
GeneTitan™ MC Instrument. The array plate must be loaded on its protective blue base. The
white plastic shipping cover on top of the array plate should not be loaded in the GeneTitan™
MC Instrument.

Figure 31 Array plate components, as shipped.

@ Shipping cover to be discarded
@ Array plate protective base
@ 384HT array plate
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d. Load the array plate with the protective blue base on the left side of the drawer.

Figure 32 Array plate on protective blue base and the hybridization tray properly loaded into
drawer 6.

(D Array plate on protective base
@ Hybridization tray

IMPORTANT! Do not install a 3-plate stack of trays. Ensure that you have removed the white
plastic shipping cover.

CAUTION! The notched corner of each plate, cover, and tray must be aligned. When
loading onto the GeneTitan™ MC Instrument, the notched edge plates, covers, and trays
must be aligned as indicated by the Tray Alignment guide in the drawer.

An error message is displayed if the instrument has difficulty reading the barcode on the
plate. Plate barcodes must face the internal barcode reader in the back of the drawer.
Improper tray positioning can crash the GeneTitan™ MC Instrument, result in substantial
instrument damage, and loss of samples.

e. Press the blue confirmation button on the GeneTitan™ MC Instrument to continue.

Note: When an array plate is loaded on the left side of the drawer, the internal barcode reader
reads the barcode of the array plate. The barcode is compared with the barcode and the plate
type that is specified in the Barcode and Plate Type fields that were selected during the
Setup. If the information is correct, the application allows you to proceed to the next step. If
the instrument is unable to read the barcode, it pushes out the tray and prompts you to load
the correct plate with the proper orientation into the instrument.

If an error occurs, check the loading of the array plate and click OK to retry. Alternatively,

click Skip if the instrument continues to have problems after ensuring that the trays have been
loaded in the proper orientation.

2. Select the arrays to scan. By default, all arrays are selected.
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3. Click Next, then click OK in the Start Processing dialog box to start processing the samples.
The GeneTitan™ MC Instrument places the array plate on top of the hybridization tray (now
called the plate stack). The GCC software starts the process for placing the array plate onto the
hybridization tray. A Clamping in Progress dialog appears.

4. Press OK, then wait for the drawer to open completely before retrieving the array plate and
hybridization tray combination for manual clamping and inspection.
After clamping is complete in the instrument, drawer 6 opens and the Ensure Clamping dialog
appears. Do not click OK yet. The sandwich of the array plate and hybridization tray must be
manually clamped and inspected before the array processing can start.

A CAUTION! At this stage, the array plate does not latch securely to the hybridization tray. Always
&= grip plate stack from the hybridization tray (lower part) of the plate stack. Do not grip only the
array plate to remove the plate stack from the drawer of the GeneTitan™ MC Instrument.

5. Complete the following steps to clamp the array plate manually to the hybridization tray.

a. Grip the body of the hybridization tray by hand then remove the plate stack from drawer 6
right location of the GeneTitan™ MC Instrument.
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b. Place the plate stack on a flat surface of the table or the lab bench. Position the plate stack to
match the orientation as shown in the picture.

@ Chamfer/notched corner

c. Position the left and right thumb fingers on the location indicated in the picture. Press the
array plate downward until the clicking sound is detected.

1234 ==lBemmg 10 11 12 13 14 15 16 ===SE=== 31 23 23 24

d. With the plate stack resting on a flat surface, rotate the stack 90° clockwise. Position the
left and right thumbs on the locations that are indicated in the picture. Press the array plate
downward until the clicking sound is detected.
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6. Ensure the clamping of the plate stack to check that the array plate is securely fastened to the
hybridization tray. Using your thumbs, press the array plate downward following the positions that
are specified in Figure 33. No clicking sound indicates proper clamping.

Figure 33 Clamping verification steps.

7. Inspect the array plate for bubbles.

a. Keeping the plate stack level, inspect the bottom for bubbles under the arrays—do not tilt or
invert the plates.

b. If bubbles are present, gently tap the plate until the bubbles move out from under the arrays—
do not unclamp the plate stack.

8. Return the plate stack to the drawer with the notched corner facing you, then press the blue
confirmation button on the GeneTitan™ Instrument to proceed.

9. A message is displayed if plate orientation is not correct or if the hybridization tray barcode cannot
be read. If this message appears, complete one or both of the following actions.

* Check the loading of the array plate and click OK.

* C(Click Skip if the instrument continues to have problems reading the barcode and after
ensuring that the correct trays have been placed in the proper orientation.

10. Continue to “Load a second array plate and hybridization tray” on page 132.

Load a second array plate and hybridization tray onto the GeneTitan™ MC
Instrument

When a second array plate and hybridization tray can be loaded

After processing starts on the first plate stack, you have a specific length of time during which you can
load another array plate and hybridization tray. This length of time is displayed above the Hybridization
Oven Status pane (Figure 34). You cannot load another hybridization tray before or after this time.

IMPORTANT! The next array plate and hybridization tray must be loaded during the time frame of that
is displayed above the Hybridization Oven Status pane. You cannot load another hybridization tray
before or after this time. You are required to wait until the current process is finished, otherwise the
multiplate workflow will be disrupted.
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When the first plate is in the oven and the time spacing requirement is met, you can load another plate.
This time spacing requirement is to help ensure that the second plate does not have to wait for system
resources in its workflow. The time spacing is approximately equal to the scan time of the first plate.

[ Work Flow

Locatic
Left Po:

| Plats Type

Arap Tupe ISame plate lype

E/E/2018 7:40:36 PM — B/7/2018 1:05:16 PM Scan Awvailable _®

| Hybridization Oven Status

”Estimaled Time Window to Run Mext Hyb-vWash-Scan ——

Barcode 56041343648271011191

Estimated Time Remaining | 231 23101 _@

Barcode

Position 1

Position 2

Estimated Time Remaining

Owen Temperature
Current 47 .9C —4@

Taget 48 C
Laog
2:22:03 PM Place Ovent -

2:22:09 PM Move to rebracted at Dvenl

2:2217 PM Mowe to retracted at Owenl

2:2217 PM Mowe to Owenl_HtaHyb

2:2217 PM Oven doar open

2:22:21 PM Gripper Open

2:22:22 PM Retract Ovenl

2:22:22 PM Mowe to retracted at Owenl

2:22:28 PM Oven door close

2:22:27 PM Gripper Close

2:22:28 PM Move to Drawert_Unbiased

2:22:33 PM Retract Diawers

2:22:33 PM Mowe to retracted at Drawerg

2:22:34 P 5604134364827101119179moved to Oven1_HtaHyb

2:22:34 PM HYB (1410 minutes]

2:22:36 PM Hyb: 23:29 min

2:23:34 PM Hyb: 23:28 min

2:24:34 P Hyb: 23:27 min

2:26:34 PM Hyb: 23:26 min

PM Hyb: 23:25 min
H in

Figure 34 When to load a second array plate and hybridization tray based on oven status information.

@ This pane displays the amount of time during which another array plate and hybridization tray can be loaded.
Additional plates cannot be loaded before or after this time as the instrument is operating. In this figure, the system is
currently available.

@ Position of plate stack in the hybridization oven. Only 1 plate is being processed in this figure. As such, position 2 is
blank.

Position 1—left side of the oven
Position 2—right side of the oven

@ Green indicates that the current oven temperature is in the target temperature range. Yellow indicates that oven
temperature is outside of target temperature range.

Load a second array plate and hybridization tray

1. Select the System Setup tab.

2. Load an array plate and hybridization tray in the same manner as the previous plate and tray were
loaded.

a. Scan or manually enter the array plate barcode, then click Next.

b. Load the array plate with the blue protective base and the hybridization tray without the cover,
then press the confirmation button.
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c. Select the arrays to scan, then click Next.

d. Ensure that the plates are clamped securely when prompted, then press the blue confirmation
button.

e. Click OK when prompted to resume plate processing.

3. Select the System Status tab to view the status of the array plates in the Work Flow pane.

| T

—Work Flow
Barcode Flate Type Location Hyh. Status Fluidics Status Sican Status Estimated Cormpletion Time
5600324059357012609098 | 550032 Left Fosition | Funning Waiting Waiting 5/4/2009 171:20:42 A

5b0032 Right Posit.. |Running Waiting Waiting 5/4/2009 10:25:36 AW

Figure 35 Example of the Work Flow pane when 2 plates are loaded and are in the hybridization
oven.

Queue a second plate for scanning
Use the Scan option in the System Setup tab to start a second scan workflow. The software
automatically moves the second plate into the scanner when the first plate has completed scanning.

GeneChip™ Command Console™ v4.3 or later is required for this procedure.

1. Start the first scan workflow in the GeneTitan™ MC Instrument. Wait until the first plate is loaded
into the imaging device and scanning starts.

2. Go to the System Setup tab, then select Scan from the Setup Option dropdown list. The Setup
Option dropdown list is active only after the first plate starts scanning.

11 appliedbiosystemns - GeneTitan Instrument Control

File Tools Help

-2 ([ ? |

Stop Email Help
@ ey System Setup

@— Setup Option ~
. Hyb-Wash-Scan
Plate Information Hyb-Wash
Wash-Scan
Barcode Wash-Scan Resume
Plate Type Unload Plates
Wash

Protocol Name

Location

Figure 36 Scan setup option to process a second array plate.

@ System Setup tab @ Scan Option dropdown list
3. Click Next in the lower left section of the window under the Status pane.

4. Scan or manually enter the array plate barcode, then click Next.
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5. Follow the instructions in the Status pane and empty the trash bin if needed, then press the blue
confirmation button on the instrument to continue.

6. Place the array plate on top of a scan tray in the correct orientation such that notched corner of the
array plate and scan tray are aligned.

7. Load the array plate/scan tray combination in drawer 2 of the GeneTitan™ MC Instrument, on
the left or right side, as instructed in the Status pane. Ensure that the array plate/scan tray
combination is loaded in the correct orientation in the drawer. If needed, see Figure 41 for further
information on the proper alignment and loading of plates, covers, and trays in the GeneTitan™ MC
Instrument.

8. When ready, press the blue confirmation button on the instrument.

9. Select the arrays to scan in the Array Selection section in the upper right corner of the window,
then click Next.

10. In the Start Processing confirmation message, click OK to continue.
The second queued plate runs after the first scan finishes and the scanner is available.

Stage 3—Ligate, wash, stain, and scan

The GeneTitan™ tray loading process

134

When hybridization of an array plate is complete, a message window appears to alert you to resume the
workflow setup. Press OK to return to the System Setup tab.

This message window prompt to continue into the reagent load step occurs when hybridization is
complete. Estimated Time Remaining displayed in the Hybridization Oven Status pane can display a
time remaining of 0—30 minutes.
The GeneTitan™ MC Instrument allows reagent load to take place after either:

* The estimated time counts down to zero, or

* The actual real-world hybridization time (as indicated by the computer clock) indicates that the
hybridization is complete.

Note: The time estimate that is displayed on some systems can lag due to high CPU utilization. The
GeneTitan™ MC Instrument allows the workflow to synchronize with the system clock to compensate
for this situation during the final half hour of the hybridization time estimate. When the message window
prompt to resume the reagent loading step is displayed, there is no need to wait for the estimated time
to count down to zero.
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Load trays in GeneTitan™ Instrument

1. Follow the prompts in the Status pane.
a. Refill the reagent bottles, if needed.
¢ Wash Bottle A—2 L
® Wash Bottle B—Fill to 1-L mark only
* Rinse—Fill to 1-L mark only

b. Empty the trash bin.

c. Remove consumable trays and plates as instructed, except for the blue base. Leave the blue
array plate base in drawer 6 although the base is empty.

d. Press the blue confirmation button on the GeneTitan™ Instrument to continue.

2. Load consumable trays and plates in the following sequence. Follow the prompts in the Status
pane.

IMPORTANT! After trays are loaded onto the drawer, examine each cover for droplets of liquid.
Liquid on the cover can result in a capillary phenomenon. As a result, the tray can stick to the
cover and be lifted out of place inside the GeneTitan™ Instrument. If liquid is present on the cover,
remove the tray, clean the cover and top of the tray with a laboratory tissue, and reload the tray.

CAUTION! Orient trays as indicated by the guide inside the drawer. Improper orientation can
cause the run to fail. If needed, see Appendix A, “Recommended techniques for GeneTitan™ MC
Instrument operation” for a review of proper loading techniques.

a. When drawer 2 opens:

* Left side: Scan tray with cover. Remove the protective blue base from the scan tray
immediately before loading. Do not load the protective blue base.

* When complete, press the blue confirmation button on the GeneTitan™ Instrument to
continue.

Figure 37 Drawer 2: Scan tray with cover on left side.
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b. When drawer 3 opens:
® Left side: Stain 1 tray (white label) with cover.
* Right side: Ligation tray (yellow label) with cover.

* Press the blue confirmation button on the GeneTitan™ Instrument to continue.

Figure 38 Drawer 3 trays.

* |eft side: Stain 1 tray with cover (white label).
* Right side: Ligation tray with cover (yellow label).

c. When drawer 4 opens:
* |Left side: Stain 2 tray (blue label) with cover.
* Right side: Stabilization tray (green label) with Axiom™ Stabilize Soln and cover.
* Press the blue confirmation button on the GeneTitan™ Instrument to continue.

Figure 39 Drawer 4 trays.

* |eft side: Stain 2 tray with cover (blue label).
* Right side: Stabilization tray with Axiom™ Stabilize Soln (green label).
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When drawer 5 opens:

® Left side: Stain 1 tray (white label) with cover.

* Press the blue confirmation button on the GeneTitan™ Instrument to continue.

Figure 40 Drawer 5: Stain 1 tray with cover (white label) on left side.

3. At the WorkFlow Option window prompt, click Yes to load another array plate and hybridization

tray.

4. In Setup Option, select Setup Another Run, then click Next.

5. Scan or manually enter the array plate barcode, then click Next.

6. Select a protocol, then click Next.

7. When drawer 6 opens:

a.

b.

Remove the blue cover from the previous array plate.

Load a new array plate and new blue base on the left side of the drawer, then load a new
hybridization tray on the right side of the drawer.

Press the confirmation button.

Click OK to continue.

. When drawer 6 opens, ensure that the plate stack is securely clamped. For clamping

procedure review, see step 5 on page 129.

Press the blue confirmation button.
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GeneTitan™ MC Instrument internal array plate activity

The following is a description of array plate movements in the GeneTitan™ MC Instrument when a
multiplate workflow is performed.

1. The plate stack, which has finished hybridization, is temporarily moved from the hybridization oven
to drawer 1.
2. The new plate stack in drawer 6 is moved to the hybridization oven.

3. The plate stack temporarily in drawer 1 (step 1) is moved to the unclamping station where it is
unclamped and then moved into the fluidics section of the GeneTitan™ MC Instrument.

Note: At the end of a Hyb-Wash-Scan run, all plate and tray covers and the stabilization tray
cover must be in the trash.

The following figure is an example of how the System Status Workflow window appears when 3
array plates are being processed.
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, , |~ )
Stage 3—Ligate, wash, stain, and scan
System Status System Setup |
wyark Flow
Barcode Flate Type Location Hyhb. Status Fluidics Status Scan Status Estimated Completion Tir
hB00324059357012603058 550032 Left Fasition | Completed Funning Waiting 5472016 11:50:35 Ak
BE003E-plate 2o | 550032 Right Fasit... | Running Waiting Waiting 5472016 11:55:00 Ak
h50032 Left Position |Running Waiting Waiting B/4/2016 12:53:02 P
 Estimated Time Window to Fun Next Hyh-YWash-Scan
HT &nay Type ISame plate type j
System not available: processing 2 plates @
Hybridization Owven Status | | Fluidics Status |
Barcode ERN32-plate 0030000 Barcode 550032405935701 2609038
Puasition 1
Elieled i Bezlili 00: 58: 02 Pratocaol Mame BE0032 protocol
Estimated Time Remaining | 00 03: 26 n @
Barcode BE0032-plate ZdoePodd —azh B Temperature
Position 2
Estimated Time Remaining | Q0 Q0 00 Current 26.6C
Target Heater is OFF
— Owen Temperature 1
Current 48 .1C
Target 48 G Step | Task Time Status
Log

11:32:06 &M Unclamp completed 550032405335701 2609098 in Unclamp_Hta_;I
11:32:06 &M Step completed

11:32:06 AM UnclampStationPresentPlate

11:32:05 Ak 550032-plate 24000404400 wait for FluidicSpstem Gripper
113211 &M UnclampStationPrepareForPlatelnsertion

11:32:39 M WashELid open

11:32:43 M WashBLid open

11:32:55 AM Hub: 1:8 min

11:33:55 &AM Hyb: 1:7 min

11:34:02 AM washBLid close

11:34:43 AM WashBLid close

:

11:34:55 &M Hyb: 1:6 min | STAIMZ 00:00:30 | 00:00:30
11:35:37 &M WashBLid close A -
11°35:55 AM Hyb: 125 min 10 |'wWASHA 00:00:33 | 00:00:33
11:36:55 A0 Hyb: 1:4 min " STalMN4 00:00:30 | 00:00:30
11:37:55 40 Hub: 1:3 min

11:38:35 A WashELid open 12 WiASHA O0:00:33 | 00:00:33
11:38:39 AM WashBLid open . .
11:35:55 AM Hyb: 1:2 min 13 |STAINS 00:00:30 | 00:00:30
11:33:33 &M ‘wWashBLid close 14 |wiASHA 00:00:33 | 00:00:33
11:39:55 A0 Hub: 1:1 min

11:40:54 &M WashBLid cloze 15 [FIXING 00:00:10 | 000010

11:40:55 AM Hub: 1:0 min
1 H i

@ Work Flow pane displays the number of array plates being processed and where they are in the instrument. In this
example, 3 array plates are being processed: 2 are in the hybridization oven and 1 is in fluidics.

@ The status that is displayed indicates that another (fourth) plate cannot be added to the hybridization oven because
both oven slots are currently in use.

@ Estimated Time Remaining is displayed for the current process. Changes in the Estimated Time Remaining can
be due to process interruptions such as a drawer being opened.

@ The step that is currently executing in fluidics.
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@ Chapter 5 Process array plates with the GeneTitan™ instrument
-~ Scan workflow

Scan workflow

After a plate has completed the fluidics stage of the workflow, the GeneTitan™ Instrument moves the
plate to the imaging device.

When the scanning process starts, a Scan Control window displaying the scan image appears. This
window must remain open while the array plate is being scanned.

CAUTION! The Scan Control window must remain open while the array plate is being scanned. If
the window is closed, the scanning process halts. If needed, this window can be minimized without
interference to the imaging.

Do not manually, or through the GCC transfer utility, move data that are associated with the current
plate that is being processed/scanned. Transferring data dramatically slows scanning and can cause
the computer to freeze.

B GeneChip - HT Multi-Channel Scan Control - n

| Scanner Image |

| Plate Properties

| Current Status: Scanning subarrays...
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Shut down the GeneTitan™ MC Instrument

Shut down the GeneTitan™ MC Instrument

This procedure assumes that all the array plates that are loaded onto the GeneTitan™ MC Instrument
have been processed.

1. From the System Setup window, open the Setup Options dropdown list, then select Unload
Plates.

2. Unload all the consumables as prompted.
3. Power off the GeneTitan™ MC Instrument by opening Tools » Shutdown.

4. Exit the GCC software if it does not close automatically.

Note: If the instrument is processing an array plate, the software does not allow you to shut down
the system.
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Recommended techniques for
GeneTitan™ MC Instrument
operation

Array plate packaging . . ... ...t e 143
Proper tray alignment and placement . ......... .. e 143
Stain trays and COVEIS .. ...ttt e et e e e e 147
Label GeneTitan™ hybridization and reagenttrays ...............ooiiiieeiieeninnannn. 148
Setup options for array plate processing . ...t e 149
When to abort @ proCess .. ... .o e 152
Email notifications from the GeneTitan™ MC Instrument ................ccoviiiiiiiinnnn. 154
GeneTitan™ MC INStrument [amp . ... ..o e e 154

This chapter describes the recommended techniques and procedures to follow when using the
GeneTitan™ MC Instrument or the GeneTitan™ MC Fast Scan Instrument for the fluidics processing

and array scanning steps of the Axiom™ 2.0 Assay 384HT Array Format Automated Workflow. Being
familiar with these techniques helps to ensure the success of the assay. Detailed safety information and
instruction on using the GeneTitan™ MC Instrument is in the GeneTitan™ Multi-Channel Instrument User
Guide and the GeneChip™ Command Console™ User Guide.
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Appendix A Recommended techniques for GeneTitan™ MC Instrument operation
Array plate packaging

Array plate packaging

ltem Part No. Image Details

Axiom™ 384HT All array
Array Plate plates have
or custom the Part No.
Axiom™ 384HT 202091
myDesign™ Array | etched on the
Plate plastic

The array plate package includes the following:

* White plastic cover: The function of the white plastic
cover for the array plate is to protect the array plate
during transport. You can discard this after removing
the array plate.

* Array plate: The array plate must be protected at all
times from damage or exposure to dust. The array
plate must be in the blue array plate protective base
at all times.

* Protective base: The blue array plate protective base
in the package must be used to protect the array

(?) Shipping cover plate from damage.
(to be discarded) | o Desiccant pack: The desiccant pack can be

(® Array plate discarded after the array plate is removed from the
protective base pouch.

@ Array plate

Proper tray alignment and placement

Proper alignment and loading of plates, covers, and trays is critical when using the GeneTitan™ MC
Instrument. Each plate, cover, and tray has one notched corner. The notched corner of plates, trays,
covers, and bases must be in vertical alignment with each other and placed in position A1 per the Tray
Alignment guide inside each GeneTitan™ MC Instrument drawer.

CAUTION! Be careful not to damage the consumables or bend the blue scan tray protective base
cover posts or scan tray posts.

Note: Mark the notched corner of each plate, cover, and tray with permanent marker to help ensure
proper alignment when loading onto the GeneTitan™ MC Instrument.

IMPORTANT! The drawer bed is not notched, so it is mechanically possible to load the tray in the
wrong orientation. Be careful to avoid this mistake.
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Proper tray alignment and placement

Figure 41 Notched corners aligned.

@ The notched corner of array plate that is aligned with the notched corner of blue protective base.

N

r TRAY ALIGNMENT -

(2_— ‘_.

Figure 42 Notched corners marked and aligned with tray alignment guide.

@ The notched corners of array plate and base that are marked with permanent marker.

@ The notched corner of all plates, bases, and covers and must be seated in the front left corner of the drawer, as
indicated in the Tray Alignment guide.

@ Plates and trays must be seated in this groove.
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Appendix A Recommended techniques for GeneTitan™ MC Instrument operation 77

Proper tray alignment and placement

Figure 43 Array plate with blue protective base and the hybridization tray aligned properly loaded into
drawer 6.

(1) Array plate on blue protective base
@ Hybridization tray

Proper orientation of consumables

It is important that consumables be oriented properly when loaded into/onto the GeneTitan™ MC
Instrument. The barcodes face into the instrument.

Figure 44 Example shows consumables that must be rotated and loaded on the drawer so that the
barcodes face into the instrument.

@ Front of instrument (facing you).

@ Notched corners. The notched corners face out and left.

@ Barcodes. The barcodes face to the rear of the instrument where scanning by the internal barcode reader takes
place.
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777 Appendix A Recommended techniques for GeneTitan™ MC Instrument operation
Proper tray alignment and placement

Figure 45 Example of properly loaded GeneTitan™ tray consumables. A GeneTitan™ stain tray and the stain
tray cover are shown in this example.

@ Barcodes face the rear of the instrument.

@ Notches face out and left. "For Research Use Only" faces out.

Drawer tabs in the GeneTitan™ MC Instrument

The GeneTitan™ MC Instrument drawers have tabs, or fingers, that restrain the consumable. The fingers
retract when the drawer is open and extend when the drawer closes. When you load the plates or trays,
ensure that the fingers are retracted and place trays onto the instrument drawers only after the drawer is
fully extended. Ensure that the tray is not resting on the fingers. Notify your field service engineer if the
fingers do not retract automatically.

IMPORTANT! Do not place the consumables on top of the drawer fingers —this position prevents the
instrument from functioning correctly.

Figure 46 Location of drawer tabs, or fingers.

@ Drawer tabs, or fingers, in the GeneTitan™ MC Instrument.
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Appendix A Recommended techniques for GeneTitan™ MC Instrument operation
Stain trays and covers

1 |

Figure 47 Place trays on the drawer when the tabs, or fingers, are retracted.

(D Fingers retracted

Stain trays and covers

IMPORTANT! Always place the flat side of the cover against the stain tray.

Figure 48 Placement of covers on trays.
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Appendix A Recommended techniques for GeneTitan™ MC Instrument operation
Label GeneTitan™ hybridization and reagent trays

Label GeneTitan™ hybridization and reagent trays

When preparing the hybridization and reagent trays to be loaded onto the GeneTitan™ MC Instrument, it
is helpful to mark each tray in a way that identifies its contents.

IMPORTANT! It is critical that you write only on the proper locations of the proper sides of
hybridization and stain trays. Do not write in any other location, because writing can interfere with
sensors inside the GeneTitan™ MC Instrument and result in experiment failure. To support proper
placement of lids onto stain trays, and trays onto the GeneTitan™ MC Instrument, you can also mark the
notched corner of the trays and lids.

Label a GeneTitan™ 384 Layout Hybridization Tray

Label a GeneTitan™ 384 Layout Hybridization Tray on the front part of the short side of the tray, next to
the notch at the left, as shown in the following image. The proper section for labeling is nearest to the
notched corner, corresponding to the A1 through F1 wells.

Figure 49 Correct area to label a GeneTitan™ 384 Layout Hybridization Tray.

@ Do not label hybridization tray on the long side.
@ Notched corner of the hybridization tray faces the front.
@ Label the hybridization tray here.

CAUTION! Writing on the wrong side of the hybridization tray can interfere with the operation of the
sensors in the GeneTitan™ MC Instrument.

Label a GeneTitan™ 384 Layout Reagent Tray

You can label a GeneTitan™ 384 Layout Reagent Tray on the left side of the front of the tray as shown in
the following image. The correct side is nearest to the notched corner, corresponding to the A1 through
F1 wells.

IMPORTANT! This procedure is for noncolor-coded reagent trays. It is not necessary to label color-
coded reagent trays.
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Setup options for array plate processing

Figure 50 Correct area to label a GeneTitan™ 384 Layout Reagent Tray.

@ Do not label the reagent tray on the long side.
@ Notched corners of the reagent tray and cover must align and face the front.
@ Label the reagent tray here.

Setup options for array plate processing

There are 3 steps performed by the GeneTitan™ MC Instrument for array plate processing:
* Hybridization
* Wash and Stain
* Imaging (Scan)

The GeneChip™ Command Console™ software provides options to perform all these steps, or only
some of the steps. This section describes the System Setup options.

111 appliedbicsystems - GeneTitan Instrument Control

File  Tools Help

=l 4

=T

Stop Email Help
System Status System Setup
Setup Option v
i Hyb-Wash-Scan
Plate Information Hyb-Wash
Wash-Scan
Barcode Wash-5can Resume
Scan
Plate Type Urload Plates
Wash
Protocol Name

Location
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Setup options for array plate processing

Hyb-Wash-Scan

The Hyb-Wash-Scan setup option enables you to hybridize, wash-ligate-stain-stabilize, and scan an
array plate on the GeneTitan™ MC Instrument.

¢ Hyb: The array plate is moved to the hybridization oven inside the instrument. Each denatured
sample in the hybridization tray is hybridized to an array on the array plate.

— Time that is required for 384 samples = 23.5 hours

* Wash: Samples on arrays are ligated, washed, stained, and stabilized.
— Time that is required for 384 samples = ~5 hours

¢ Scan: The array plate is moved to the imaging device in the GeneTitan™ MC Instrument and each
array is scanned.

— Time that is required for 384 samples = ~5.5 hours
Hyb-Wash

When the Hyb-Wash setup option is selected, processing stops after the array has gone through
fluidics processing. Use this option if an array plate cannot be scanned on the same GeneTitan™ MC
Instrument as the one used for hybridization and fluidics processing.

1. If the array plate cannot be scanned immediately after the Hyb-Wash process is complete, store
the array plate following these steps:

a. Wrap the array plate (in the scan tray with black protective base) in aluminum foil to protect
from light.

No lid is required. Do not tilt or invert the plate stack. If tilted or inverted, the Hold Buffer spills
out of the tray. To prevent liquid spillage, keep the plate level when handling it. Do not touch
the bottom optical surface of the scan tray.

b. Store at 4°C.

c. Scan the array plate in 3 days or less.

2. When ready to scan, prepare the array plate following these steps:
a. Protect the plate from light.

b. Bring the plate to room temperature for approximately 50 minutes.

c. Remove the aluminum foil, then load the plate onto the GeneTitan™ MC Instrument.

Wash-Scan

Note: The Wash-Scan option is available in GCC version 6.1 or later.

Use the Wash-Scan option if:
* The array plate was hybridized in an oven separate from the GeneTitan™ MC Instrument.
* To bypass the hybridization step and perform only the wash/stain and scan steps.

Note: If the Wash-Scan option is selected, it usually takes 25-30 minutes to warm up the Wash B.
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Setup options for array plate processing

Note: Ensure that the Continuous Wash-Scan process is enabled. Contact your local FAS to perform
this procedure.

Wash-Scan Resume

Use the Wash-Scan Resume option if fluidics processing has been interrupted (for example, a power
failure at your facility). This allows you to resume an interrupted workflow at any point in the Wash
stage.

If a run is aborted during fluidics processing, the instrument places the aborted array plate into the scan
tray. To restart this process, remove the array plate from the scan tray then place the array in its blue
protective base.

The step at which the run was aborted is identified by:
* Viewing the System Status window if you are aborting the last plate through the fluidics system.
e Starting the Resume process.

Select Wash/Scan Resume from the System Setup tab, then follow the prompts to unload and reload
all drawers.

The trays are loaded. It is up to you to determine whether to load fresh reagents or reuse the trays
already in the GeneTitan™ Multi-Channel (MC) Instrument. Base your decision on the step where the
problem occurred.

To help ensure that the samples are processed correctly, we recommend that you:

* Load new stain trays with fresh reagents.
* |Load a new scan tray.

We do not recommend the use of trays without reagents or holding buffers for steps that have already
been executed.

Resume step

For Resume, select the step at which to resume plate processing. You can select any step that has not
yet been started.

For specific steps, you can enter a length in seconds (even if the step requires >1 hour to run, you must
enter the length in seconds). You can set a step for less time than normal length of time, but not for
longer than normal.

Scan

Use the Scan option for the following circumstances.

* To rescan an entire array plate or specific arrays on a plate that failed to scan for reasons such as
bubbles or gridding failure.

* To scan a plate that has already been hybridized, stained and washed on a different GeneTitan™
MC Instrument.
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Unload Plates

Use the Unload Plates option to unload plates and trays from the instrument when processing is
complete or has been aborted.

When to abort a process

If needed, the processing of array plates can be aborted.

If a plate is in the fluidics station, the abort process can take up to 3 minutes. The status window
displays “AbortRequested” and then changes to “Aborted”.

A clamped array plate/hybridization tray stack that is aborted while it is in the oven or in drawer 6 is
moved to drawer 1.

To retrieve the array plate and related consumables after the instrument aborts a process, take the
following actions as needed.

¢ Use the Unload Plates option.
* Start another run. That forces the system to unload the aborted plates.
An instrument-initiated abort can occur for the following reasons.

* The plates are improperly placed.

* The uninterruptible power supply (UPS) detects a long power interruption, draining the UPS to 75%
power.

* The equipment malfunctions.
When the system aborts the processing, follow the instructions that are displayed in the user interface.

The operator can initiate an abort on 1 plate and the gripper can continue to process other plates in the
instrument.

Abort a process

Use the following procedure to abort a process underway in the GeneTitan™ MC Instrument.

Note: If reagents are loading, do not use this method. Instead, click Cancel in the reagent load step.

1. Click Stop in the upper left corner of the Instrument Control window.

1 appliedbicsystemns - GeneTitan
File Tools Help

H 5

Stop Ermnail Help
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When to abort a process

2. In the Abort dialog box, select the array plate to abort, then click Abort.

-Ioix]

~ Plates Being Processed

Select | Barcode Plate Type Location
[V 5501035123457 8000000¢ | EN032 Lett Position
| T |560032-23456788:<00x | 550032 Right Pasit...

— Current Step

Flease select Flata(s) to abort
Press Abort buttan to abort
Press Cancel buttan to cancel

Abort | Cancel

3. In the confirmation box, click Yes.

4. Wait until the status of the array plate in the Work Flow pane in the Instrument Control display
changes from “AbortRequest” to “Aborted”.

Note: If reagents are loading, abort the plate by clicking Cancel in the reagent load step.

Note: If the gripper is required to complete the abort process, the plate remains in the
“AbortRequest” state until the gripper becomes available.

Work Flow
Barcode

| Plate Type Location Hyh. Status Fluidics Status Scan Status
h0032 Left Fosition |AborRequest.. |\Waiting Wiaiting

Works Flow

Location Hyh. Status Fluidics Status Scan Status
Left Fosition |Abored YWaitinc YWaiting

Figure 51 The Work Flow pane.
@ Shows that the abort has been requested.
@ Shows that the abort has been completed.
5. After the abort process is completed, do one of the following to retrieve the array plate and related
consumables.

* In the Setup Option list, select Unload Plates.
* Start to load a new array plate.
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Email notifications from the GeneTitan™ MC Instrument

Email notifications from the GeneTitan™ MC Instrument

You can configure the GeneChip™ Command Console™ software to send email notifications about the
GeneTitan™ MC Instrument status. It is critical that you know when the instrument requires attention for
sample handling or troubleshooting. Rapid notification can lessen the risk of sample loss.

The system can notify you when a process starts, completes, aborts, or encounters an error.

For instructions on setting up notifications, see the GeneChip™ Command Console™ User Guide.

GeneTitan™ MC Instrument lamp

154

The GeneTitan™ MC Instrument uses a xenon arc lamp system that is warranted to provide 500 hours of
illumination for imaging the array at 2 wavelengths. The xenon lamp has a limited lifetime and must be
replaced at regular intervals.

The GeneTitan™ Instrument Control software provides a timer that indicates the remaining useful life
of the bulb and notifies you when it requires replacement. It is important to adhere to the warnings
specified in the GeneTitan™ Multi-Channel Instrument User Guide.

See the user guide for the Lambda LS and Smart controller system. Never manually switch the lamp
and the controller on or off. The GeneTitan™ Instrument Control software manages the lamp activity
and switches the lamp on and off as required. It takes 10 minutes to warm up the lamp. In idle mode,
the lamp remains on for 2 hours before it is automatically switched off if there are no more plates
being transferred from the fluidics to the imaging station. This automatic switching is by design and is
intended behavior. Do not try to save the lamp life by powering off the switch on the lamp.

Note: The power switch on the shutter box must always be ON. The OPEN/CLOSE switch on the
shutter box must always be at the AUTO position.
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Fragmentation quality control gel
protocol

Equipment required

"MLS" indicates that the material is available from fisherscientific.com or another major laboratory

supplier.
ltem Source

Gel Imager MLS

Pipette, multichannel or single-channel P20 MLS

Plate centrifuge MLS

Vortexer MLS
E-Gel™ and reagents required

Unless otherwise indicated, all materials are available through thermofisher.com.

Item Source

E-Gel™ Power Snap Plus Electrophoresis Device G9110

iBright™ CL750 Imaging System A44116

Invitrogen™ E-Gel™ 48 Agarose Gels, 4% G800804

Applied Biosystems™ 25 bp DNA Ladder, or a similar product prepared as instructed by the 931343

manufacturer

Invitrogen™ Tracklt™ Cyan/Orange Loading Buffer 10482028

Invitrogen™ UltraPure™ DNase/RNase-Free Distilled Water 10977023
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Appendix B Fragmentation quality control gel protocol
Consumables required

Consumables required

Unless otherwise indicated, all materials are available through thermofisher.com.

Item Source

Adhesive film—use one of the following:

* Applied Biosystems™ MicroAmp™ Clear Adhesive Film e 4306311
* Microseal™ 'B' PCR Plate Sealing Film * Bio-Rad™, MSB1001
Pipette tips Same brand as pipettor

Prepare the gel diluent

A 100-fold dilution of the Tracklt™ Cyan/Orange Loading Buffer can be used in “Stage 4: Reassemble
Hybridization Ready Plate and perform sample QC” on page 86.

1. Add 500 pL of Tracklt™ Cyan/Orange Loading Buffer to 49.5-mL nuclease-free water. Total volume
50 mL.

2. Mix well.

3. Store at room temperature.

Run the fragmentation QC gel

Running one 48 lane E-Gel to sample a 384-well plate is recommended. A suggested sampling pattern
is to load the gel with the following wells from the 384-well Gel QC Plate:

* Row A—Odd-numbered columns
* Row E—Even-numbered columns
* Row J—0Odd-numbered columns

* Row N—Even-numbered columns

If processing multiple plates, sampling different wells from each plate can be helpful in monitoring assay
and instrument performance.

1. Tightly seal the Gel QC Plate that is produced during “Stage 4: Reassemble Hybridization Ready
Plate and perform sample QC” on page 86.

2. Vortex the plate for 1 second each corner and 1 second in the center at the maximum setting, then
centrifuge at 1,000 rpm for 30 seconds.

3. Power on the electrophoresis unit.
4. Place the E-Gel™ 48 Agarose Gel onto the electrophoresis unit.

5. Remove 2 combs from the gel.
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Appendix B Fragmentation quality control gel protocol
Run the fragmentation QC gel

Load 15 pL of samples from user-selected wells of the Gel QC Plate onto the gel.
Load 15 pL of 25 bp DNA ladder into the marker wells (M).

Load 15-uL nuclease-free water into any unused wells.

Run the gel for 19 minutes.

Capture a gel image.

25 bp ladder 25 bp ladder

125 bp

25 bp

125 bp

25 bp

Figure 52 Fragments fall between 125 bp and 25 bp on a successful gel image.
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Sample quantification after
resuspension

Equipment required

Unless otherwise indicated, all materials are available through thermofisher.com.

Quantity ltem Source

1 Multiskan™ SkyHigh Microplate Spectrophotometer A51119500C

Quantify the diluted samples

During target preparation, 2 plates of diluted samples are prepared: 1 for OD quantification and 1 for a
QC gel to check the fragmentation reaction.

For OD quantification, readings must be taken at wavelengths of 260 nm, 280 nm, and 320 nm. See
“Plate reader guidelines for sample quantification” on page 167.
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Appendix C Sample quantification after resuspension
Install Axiom™ OD methods on the Multiskan™ Sky Microplate Spectrophotometer

Install Axiom™ OD methods on the Multiskan™ Sky
Microplate Spectrophotometer

1. Launch the Skanlt™ software, then click New session.

2. In New Session pane, click Plate Layout then select ANSI/SBS Standard, 384-well from the
Plate template dropdown list.

New Session” - Skanit Softwar{| 5.0 for Microplate Readers — =
D=8

Home  View

Clear T | Preview | Add
all X Clear new
Edit | Prnt | Plate |
-

] New Session* x

s
‘;:) FE nNotes Plate template: | ANSI/SBS Standard, 96-well
= 7 |
Or 9 ==
qll L £
& E Protocol % 4 5 3 7 8 9 10 11 12
1 S
I Results
% ) Star] ¥ Favorites N
‘Eﬂ' Report £l Oco ANSI/SBS Standard, 96-well |
Oun |
¥Size: 96

[ Samg BD Falcon, clear bottom. white/black. 96-well _IE
BD Falcon, F-bottom, 96-well
ED Falcon, F-bottom, TC, 96-well
BD Falcon, F-bottom, UV, 96-well
BD Falcon, U-bottom, 96-well
BD Falcon, U-bottom, PP, 96-well
) BRAND, C-bottom, 96-well
I3 Multiskan Sky 1530-801003 . ;
e BBOE BRAND, clear bottom, white/black, 96-well
BRAND, F-bottom, 96-well
- BRAND, F-bottom, UV, $6-well
| 236°C
BRAND, U-bottom, 96-well
Corning, clear bottom, white/black, half area, 95-well

Incubator: Off

Corning, F-battom, 96-well
Corning, F-battom, half area, 36-well

EE Corning, F-bottom, half area, UV, 96-well v
= .- i

USSC1-JML6HM2\663.labuser

(@ Plate Layout.
@ Plate template dropdown list box.
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Appendix C Sample quantification after resuspension
Install Axiom™ OD methods on the Multiskan™ Sky Microplate Spectrophotometer

New Sess|pn” - Skanit Software 5.0 for Microplate Readers

o S “ [a
Undo Clear | Preview
all 4

Edit | Prnt ‘ Plate |

El New Session™ x

-
AT .
‘f{ [ Notes Plate template: | ANSI/SBS Standard, 384-wel - P Zoom e={ = [
@ = ] Plate Layout (9 Pipette content Nafne: [ Plate 1 | (i
all [ G| sample type:
3| k] protocol e (i“\";”:‘" ol [ T2[s]a[s[s[7]a]o[nw[n[u[u[u[s[w[n[v[w[a[a[z]zs]]
= g an|
'* Results u ~
= § Standard O
*%’ Report | O Control ]
@ ) Unknown [ ]
Sample name:
® Auto O List
prefix: [Un |
[ Replicates
Dilution factor: [ 1: 1
(@) Multiskan Sky 1530-801003 A
¢ 1530-801002 | [7) Use specific blank
Incubator: Off [T sample groups
l 36°C

USSC1-JIML6HM2\663 labuser

@ Plate Layout.
(2 Unknown.

@ Select small square to define all wells as unknown.

3. In New Session window, click Plate Layout, then select Unknown.

4. Cick to select the small square above the A and to the left of the 1 to assign all the wells as

"Unknown".

Click Protocol in the session tree pane on the left, then click Absorbance under the menu bar.
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Appendix C Sample quantification after resuspension =11
Install Axiom™ OD methods on the Multiskan™ Sky Microplate Spectrophotometer

6. Assign 260 nm, 280 nm, and 320-nm wavelengths to be measured.

Mew Session® - Skan|  Software 5.0 for Microplate Readers - o x
~ B 2

& Run Piate In

& Ii\ Ofineticloop =

i Area Selection | 11
Absorbance Absorbance

Spectrum ¥ Run Plate Out
Photometry | Contral Actions
[l New Session* x =
Ol - & Notes
¢ L Wavelengths € Measurement mode
g | Plate Layout
3| -] protocot V] Multipie wavelengths ® Fst
'EEE v.cngin o 200 ER hd Warsengin (om) O precision
=] Resuits

L @ Absorbance 1

“[E5 Report

[7) Pathlength carection @

@ Advanced parameters

Figure 53 Assign wavelengths.

@ Multiple wavelengths checkbox. @ Add.
@ Wavelength [nm] field. @ Wavelengths [nm] box.
a. Check the Multiple wavelengths checkbox.

b. Enter "260" in the Wavelength [nm] field, then click Add.
After clicking Add, 260 appears in the Wavelengths [nm] box in the middle of the screen.

7. Repeat step 6 to add 280 nm and 320-nm wavelengths. When complete, 260, 280, and 320
appears in the Wavelengths [nm] box.

MNew Session® - Skanlt Software 5.0 for Microplate Readers

Kinetic Loop  g=Shake = Run Plate In
-

88 Area Selection | |l Pause
Absorbance Absorbance

Spectrum W Run Plate Out
Photometry Control I Actions

E New Session™ X

<)
L Notes
E Wavelengths:

e Plate Layout

5
n
K E Protocol ) W Multiple wavelengths .

Absorbance 260/280/32( Wavelength [ar: | @ 320 = . Wavelength [nm]

e -
L r'q Absorbance 1 L
~|=T Report N %

@ Wavelengths added appear in Wavelengths [nm] box.

8. Click Absorbance 1 in the session tree pane, then rename it "Absorbance 260/280/320".
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Appendix C Sample quantification after resuspension
Install Axiom™ OD methods on the Multiskan™ Sky Microplate Spectrophotometer

9. Add a calculation to the New Session.

Home View

-B =5 [+ -] 1:X Dilution Factor I -
5] X =13 [ |
96 Normalization
Blank Average, 5D, Basic Standard
Subtraction CVe Caleulation Pathlength Correction |  Curve
Basic Curves
E Mew Session* x
= P
I:%' ~|=| MNotes SE) Calculation type:
= X
2| HEE piate Layout 2| () Subtraction (A-B)
K &
& "E Protocol & (@ Ratic (A/B)
L & Absorbance 260/280/320 S| O Multiplication (A%)
o=
— Results % (") Division (A/x)
W Absorbance 260/280/320 S
4
e Data source:
—|=7" Report
A B I
: |'
i B |

a. Under Results in the session tree pane, click Absorance 260/280/320.

b. Click Basic Calculation to calculate 260 nm/280 nm ratio for each sample, then select Ratio

(A/B).
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c. Define the Data source:

Appendix C Sample quantification after resuspension
Install Axiom™ OD methods on the Multiskan™ Sky Microplate Spectrophotometer

* For A, select Absorbance 260/280/320 and for Wavelength select 260.
* For B, select Absorbance 260/280/320 and for Wavelength select 280.

New Session™ - Skanlt S

Add Calculations

1:X Dilution Factor

%% Mormalization

Standard
Curve

Clz

Curves Reduction

-B - [ +]-]
ks X = 5]
Blank Average, 5D, Basic
Subtraction V% Calculation
Basic
Bl Mew Session® x
2
;} Notes
- Plate Layout
[}
2 &
[ —,EI Protocol
1 |

¥ Absorbance 260/280/320

= Results

’~ W Absorbance 260/280/320

Eﬁ' Report

= Basic Calculation 1 i

@l : :

- Caleulation type:

E-]

2| O Subtraction (A-B)
s

2| @ Ratio (A/B)
S| ) Multiplication [(A™)
]

2 7) Division (A7)
a

o

k-

Data source:

A | Absorbance 260/280/320 n Wavelength: | 260 n

B: | Absorbance 260/280/320 n: Wavelength: | 280 n

10. Click Basic Calculations 1 in the left pane, then rename it "Ratio 260/280".

11.

Define the calculation for the DNA yields in each well.

a. Click the Custom Formula button under the menu bar, then click the Define Variables button

in the middle pane.

b. In the Define Variables window, define a variable that is named "A260".

1. In the Variable Name field, enter "A260".
2. In the Source Steps dropdown list, select Absorbance 260/280/320.
3. For Wavelengths, select 260, then click Add.

After clicking Add, the new A260 variable and definition move to the right side of the

Define Variables window.
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[F=%  Appendix C Sample quantification after resuspension
Install Axiom™ OD methods on the Multiskan™ Sky Microplate Spectrophotometer

c. Define a variable named "A320".

In the Variable Name field, enter "A320".
In the Source Steps dropdown list, select Absorbance 260/280/320.

For Wavelengths, select 320, then click Add.

After clicking Add, the new A320 variable and definition move to the right side of the
Define Variables window. Click OK to close the window and return to the Custom
Formula screen.

oo N~

Variable Name: |
| Absorb: |4t samples on wavelength 260nm| x

= ance |
Source Step: ﬂ | Absorbance 260/280/320 | All samples on wavelength 320nm| x

@ Al samples
() Sample average
() Sample replicate

oK Cancel

Figure 54 Define Variables window with 2 new variables added.

d. In the Custom Formula screen, enter the following DNA yield equation. Use the purple A260
and A320 buttons to enter them into the equation.

* ((A260-A320)/0.29)*120*50*0.05

e. In the left pane, click Custom Formula 1, then rename it "Yield (ug)".

Propel 384 260-280-320

-B = [+]-] +X pilution Factor
] X B8
9% Normalization
Blank  Average, SD,  Basic Standard
Subtraction  CV%  Calculation ection | Curve
Basic Curves | Reduction
[B Propel 384 260-260-320 x
L;) Notes ) sample grovps: | Group 1 -l
g Plate Layout g
i JF | protocol 8| # Define variobles |
L % Absorbance 260/280/320 g
Results K ((A2607A320)/D.29)‘120‘50*0.05‘
¥ Absorbance 260/280/320 cE—
- BB Ratio 260/280 A260 | A320
AR B e
B hepon ‘ @
4|s]s 1 E BEE
1]z2]3 [ «
0 =f-

Ez Multiskan Sky 1520-801003
¢ 1530-801003
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Appendix C Sample quantification after resuspension

Install Axiom™ OD methods on the Multiskan™ Sky Microplate Spectrophotometer

f. Click Report in the left pane. Results of the calculation are provided in either Plate or List
format. Click Plate to change the results to List format.

MNew Session” - Skanlt Software

Q &=

New Session™ - Skanit Software §

& m

to Preview  Print

Q &

o 1o o to Preview  Print
POF  Excel XML TXT POF  Excel XML TXT
Export Print | Export Print |
Bl New Session* x Bl New Session® x
’:; [ Notes Select inchuded report sections ’:; [ Notes Select inchuded report sections
el I Plate Layout [+ ] Report sections i} 5l [ Plate Layout | v ) Report sections o
E [ M Protocol v W Resuits E | M Protocol v W1 Results
L Absorbance 260/280/320 [¥) Absarbance 260/280/320  Plate L f Absorbance 26012801320 ] Absarbance 260/280/320  List
7] Ratio 260/280  Piase — _:—I] Results 7] Ratio 260/280  Piate

':—I] Results
W Abcorbance 260/280/320
}» BB Ratio 260230
- f Yield (ug)

@ Multiskan Sky 1530-801003
® 1530-801003

x
(=1v]

Incubator: Off
| z36°C

(D Plate format.
@ List format.

|

¥ Vield (ug)  Plate
1 Result summary
W1 General information
1 Session information
1 instrument infarmation
) Protocol parameters
W Run log
" Layout definitions

Automatic export after execution
(7] Print to default printer
(7] Send Excel repert via email to:

(7] Save to file:

©)

BB Ratio 260230

}» W Abcorbance 260/280/320
- f Yield (ug)

@ Multiskan Sky 1530-801003
® 1530-801003

x
(=1v]

Incubator: Off
| z36°C

|

¥ Vield (ug)  Plate
1 Result summary
W1 General information
1 Session information
1 instrument infarmation
) Protocol parameters
W Run log
" Layout definitions

Automatic export after execution
(7] Print to default printer
(7] Send Excel repert via email to:

(7] Save to file:

12. Click the Home tab, then click Save.

13. In the Save As session window, select or create a folder to save it to, and then enter a Session

14.

Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7

name.
Select folder: “ New folder

¥ @l Skanit Software
Demeo Sessions
¥ @l Thermo Scientific

Session name:

Propel 384 260-280-320

Click Save.

The session is available to be used to read the Axiom™ 384-well OD QC Plates.
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Appendix C Sample quantification after resuspension
Use a Multiskan™ Sky session

Use a Multiskan™ Sky session

See the Skanlt™ Software for Microplate Readers User Manual, Pub. No. N16243, for further details.

1. In the Skanlt™ software, click the file icon tab to the left of the Home tab in the upper left of the
window.

2. Open a session using one of the following methods.

¢ Click Open and navigate to the filepath of the session.

* (Click on the session name in the Open recent session section on the right side of the

window. The session can be pinned to the Open recent session window by clicking on the pin
icon on the right.

Propel 384 260-280-320 - Skanlt Software 5.0 for Microplate Readers

: &)
] s Create new session Open recent i
Propel 304 260-260-220 < ( : )
H saveas Newiecssinn D Multiskan Sky
& Import Multiskan Sky
= e ® Other instrument types
{3 Settings
Information
X et
@ File icon tab
(2) Saved session list
(®) Pin

OD yield evaluation guidelines

The measurement of the yield of DNA after resuspension of the pellets is an important QC checkpoint

in the Axiom™ 2.0 Assay 384HT Array Format Automated Workflow. If the median yield for the plate is
<525 pg DNA per sample:

* Pause the protocol.

* Evaluate all steps that are performed to that point to determine the possible source of the low
yields.

This DNA vyield corresponds to an Asgg-Asog value of approximately 0.53.
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Appendix C Sample quantification after resuspension
Plate reader guidelines for sample quantification

Plate reader guidelines for sample quantification

When performing sample quantification, the plate reader must be calibrated to help ensure accurate
readings.

The total yield in pg per well can be calculated as:
(A - C)'D*V*'E/P
Where:
* A =the observed ODyg.
® (C =the observed ODj35( (an estimate of a blank reading).
* D =120 (the net dilution factor when preparing the OD QC Plate).
* V =50 (the volume of the sample in L after the resuspension step).
* E =0.05 (the extinction coefficient of duplex DNA at 260 nm).
* P =the optical path length for the plate type and plate reader used.

If your plate reader does not record the OD35q, the ODogq of a blank solution of water only must be used
for the parameter "C".

The optical path length depends on the type of plate and can depend on the spectrophotometer
used. Check the recommendations for the path length for your instrument and plate type or for
recommendations on how to measure this quantity.
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Register samples in GeneChip™
Command Console™

GeneTitan™ Array Plate Registration file

A GeneTitan™ Array Plate Registration file is a Microsoft™ Excel™ spreadsheet that includes information
on the samples that you are processing on a single array plate. This information includes the array plate
format, the array plate barcode, and the sample file names for tracking the samples that are loaded
onto a particular array plate.

Note: The GeneTitan™ Array Plate Registration file uses the *.xIs Microsoft™ Excel™ file extension. Do
not use the *.xlIsx file extension.

Create a GeneTitan™ Array Plate Registration file

1. In GCC Portal, click Samples » GeneTitan Array Plate Registration.

Search Files By: B [Aray Name v
HOME DATA SAMPLES ADMINISTRATION HELP

Add Barcode

Batch Edit Upload

GeneChip

Command Console”
Software

2. Create a new template in GCC that includes fields required for sample traceability.

3. Select the array plate to be processed on the GeneTitan™ MC Instrument.

4. Select the newly created template that contains the fields that are required for traceability.

5. Select the GeneTitan Array Plate Type from the dropdown list.

6. Select the project where the sample registration data and all associated data files are saved.

7. Click Download.
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Appendix D Register samples in GeneChip™ Command Console™
Create a GeneTitan™ Array Plate Registration file

8. Click the Microsoft™ Excel™ icon to open the spreadsheet.

GeneTitanArrayPlateRegistratio

xlsx [Compatibility Mode] - Microsoft Excel non-commercial use

e I Pagelﬁyout For\as -. @ - = x
I} (mm CL e - V.
iz; Arial o A W[ Siiwrap Text Text - ij ﬁjﬁ g == (& E:tfs.m %? o
I Fomat aimter || B 2 W 7| i[O A S merge mCenter~ |8 = Yo 0 || b W) D et s || o T | 20ert  Fiter- seet
Clipboard & Font LE] Alignment LE] Number = Styles Cells Editing
[ G3 v Jfx | sample_a02
A B c D F G H | J K '=|
1 |Sample File Path Project Plate Type Probe Array Type Probe Arr Barcode Sample File Name Array Name Hyb Tray Barcode:*:Text Sample Tray Barcode:*:Text
2 Default 384_AIMS-384 384_AIMS Al1 '6504121127111111111000 Sample A01 Sample_A01 "202757 20274123
3 Default 384 _AIMS-384 384 _AIMS A02 5504121127111111111000 ISamEIe A2 _ISamp\eiAOQ 202757 2027123
4 Default 384_AIMS-384 384_AIMS A03 5504121127111111111000  Sample_AQ03 Sample_A03 202757 2027123
5 Default 384 _AIMS-384 384 _AIMS A04 5504121127111111111000 Sample_A04 Sample_A04 202757 2027123
6 Default 384_AIMS-384 384_AIMS AlS 5504121127111111111000  Sample_A05 Sample_AD5 202757 2027123
7 Default 384 _AIMS-384 384 _AIMS A0B 5504121127111111111000 Sample_A06 Sample_A06 202757 2027123
8 Default 384_AIMS-384 384_AIMS A0T 5504121127111111111000  Sample_AQ07 Sample_A07 202757 2027123
9 Default 384 _AIMS-384 384 _AIMS A08 5504121127111111111000 Sample_A08 Sample_A08 202757 2027123
10 Default 384_AIMS-384 384_AIMS A09 5504121127111111111000  Sample_A09 Sample_A09 202757 2027123
i1 Default 384 _AIMS-384 384 _AIMS A10 5504121127111111111000 Sample_A10 Sample_A10 202757 2027123
12 Default 384_AIMS-384 384_AIMS Al 5504121127111111111000  Sample_A11 Sample_A11 202757 2027123
13 Default 384 _AIMS-384 384 _AIMS Al2 5504121127111111111000 Sample_A12 Sample_A12 202757 2027123
14 Default 384_AIMS-384 384_AIMS A13 5504121127111111111000  Sample_A13 Sample_A13 202757 2027123
15 Default 384 _AIMS-384 384 _AIMS Ald 5504121127111111111000 Sample_A14 Sample_A14 202757 2027123
16 Default 384_AIMS-384 384_AIMS AlS 5504121127111111111000  Sample_A15 Sample_A15 202757 2027123
17 Default 384 _AIMS-384 384 _AIMS Al6 5504121127111111111000 Sample_A16 Sample_A16 202757 2027123
18 Default 384_AIMS-384 384_AIMS AT 5504121127111111111000  Sample_A17 Sample_A17 202757 2027123
19 Default 384 _AIMS-384 384 _AIMS Al8 5504121127111111111000 Sample_A18 Sample_A18 202757 2027123
20 Default 384_AIMS-384 384_AIMS A19 5504121127111111111000  Sample_A19 Sample_A19 202757 2027123
21 Default 384 _AIMS-384 384 _AIMS A20 5504121127111111111000  Sample_A20 Sample_A20 202757 2027123
22 Default 384_AIMS-384 384_AIMS A21 5504121127111111111000  Sample_A21 Sample_A21 202757 2027123
23 Default 384 _AIMS-384 384 _AIMS A22 5504121127111111111000 Sample_A22 Sample_A22 202757 2027123
24 Default  384_AIMS-384 384_AIMS A23 5504121127111111111000  Sample_A23 Sample_A23 202757 2027123
25 Default 384 _AIMS-384 384 _AIMS A24 5504121127111111111000  Sample_A24 Sample_A24 202757 2027123
26 Default  384_AIMS-384 384_AIMS B01 5504121127111111111000  Sample_A25 Sample_A25 202757 2027123
27 Default 384 _AIMS-384 384 _AIMS B02 5504121127111111111000 Sample_A26 Sample_A26 202757 2027123
28 Default  384_AIMS-384 384_AIMS B03 5504121127111111111000  Sample_A27 Sample_A27 202757 2027123
29 Default 384 _AIMS-384 384 _AIMS B04 5504121127111111111000 Sample_A28 Sample_A28 202757 2027123
30 Default  384_AIMS-384 384_AIMS B0 5504121127111111111000  Sample_A29 Sample_A29 202757 2027123
i Default  384_AIMS-384 384_AIMS BO6 5504121127111111111000  Sample_A30 Sample_A30 202757 2027123
32 Default  384_AIMS-384 384_AIMS BO7 5504121127111111111000  Sample_A31 Sample_A31 202757 2027123
33 Default  384_AIMS-384 384_AIMS B08 5504121127111111111000 Sample_A32 Sample_A32 202757 2027123
34 Default 384_AIMS-384 384_AIMS B09 5504121127111111111000  Sample_A33 Sample_A33 202757 2027123
35 Default  384_AIMS-384 384_AIMS B10 5504121127111111111000  Sample_A34 Sample_A34 202757 2027123
36 Default 384_AIMS-384 384_AIMS B11 5504121127111111111000  Sample_A35 Sample_A35 202757 2027123
37 Default  384_AIMS-384 384_AIMS B12 5504121127111111111000 Sample_A36 Sample_A36 202757 2027123
38 Default 384_AIMS-384 384_AIMS B13 5504121127111111111000  Sample_A37 Sample_A37 202757 2027123
39 Default  384_AIMS-384 384_AIMS B14 5504121127111111111000 Sample_A38 Sample_A38 202757 2027123
40 Default 384_AIMS-384 384_AIMS B15 5504121127111111111000  Sample_A39 Sample_A39 202757 2027123
41 Default  384_AIMS-384 384_AIMS B16 5504121127111111111000 Sample_A40 Sample_A40 202757 2027123
42 Default 384_AIMS-384 384_AIMS B17 5504121127111111111000  Sample_A41 Sample_A41 202757 2027123
43 Default  384_AIMS-384 384_AIMS B18 5504121127111111111000 Sample_A42 Sample_A42 202757 2027123
44 Default 384_AIMS-384 384_AIMS B19 5504121127111111111000  Sample_A43 Sample_A43 202757 2027123
45 Default  384_AIMS-384 384_AIMS B20 5504121127111111111000 Sample_A44 Sample_A44 202757 2027123
H 4 » ¥ | Samples < ¥] [ m
Ready ‘ (/[0 |00z (=)————0) (%)
9. In the Sample File Name column, enter a unique name for each sample and any additional
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information, such as array plate barcode.

Note: The array plate's barcode can be scanned into the Barcode field. The barcode is stored in
the sample file for each array.

10. Complete one of the following:

If you are ready to load the array plate onto the GeneTitan™ MC Instrument, scan the array
plate barcode into column F, then proceed to step 11.

If you are not ready to load the array plate onto the GeneTitan™ MC Instrument, proceed to

step 11.

11. Follow these steps to save the file:
a. Click File » Save As.

b. Enter a name for the array plate registration file.
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Appendix D Register samples in GeneChip™ Command Console™
Create a GeneTitan™ Array Plate Registration file

c. Click Save.

12. Follow these steps when you are ready to load the array plate onto the GeneTitan™ MC Instrument.
a. Click Browse, navigate to the GeneTitan™ Array Plate Registration file, then click Open.

b. Scan the array plate barcode, if it has not already been scanned, and save the registration file.

c. Click Upload, wait for the information to load, then click Save found at the bottom of the next
window that is displayed.

[ Register Gene Titan Array Plate - Windows Internet Explorer

@,\., ¥ |di http:flocalhost: G000 AFFyWeb/RegiskerHTArr ayPlate, aspx

D
File Edt Wiew Favortes Tools Help @ Convert - [ select
7 windows Live .- What'sMew  Profle  Mal  Photos  Calendar  MSN Share R = IS Sign in
— N —————————f( .. — . »
o [88%] il Register GeneTitan Array Plate [Ji Register GeneTitan Array. .. x] l -8 =~ |-k page ~ () Tooks -
Search Files By: H AmayName v | | (Use * for wildcard) Bl Advanced Search 5]

HOME DATA SAMPLES ADMINISTRATION HELP
GeneTitan Array Plate Registration d 4

Step 1: Create a blank GeneTitan Array Plate registration file with the desired attributes

Select the templates with the attributes you wish to use for the sample files. @
» [IMIAME Sample Information
» O Pedigree Template

GeneTitan Array Plate Type (Required): | PharmacoFocus-384  ~|
Project where to create samples:

Download

Step 2: Enter the values for the sample (.ARR) files in the GeneTitan Array Plate registration file.

Enter values for the attributes using Excel. Additional columns for new attributes can be added to the spreadsheet at any time. @

Step 3: Upload the GeneTitan Array Plate registration file to create new sample (.ARR) files.

Enter the path, or click Browse to find the GeneTitan Array Plate registration file. If a plate barcode is not provided in the excel file being
uploaded, one MUST be provided in the plate barcode field below.

GeneTitan Array Plate registration file (Required):|

|[ Browse.. |
GeneTitan Array Plate Barcode: \
Upload
Mouse over I for tips on step.
Done 8 Local intranet Eo100% v
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Troubleshooting

Biomek™ i7 Automated Workstation

If a hardware problem is encountered when running the Axiom™ target preparation methods on the
Biomek™ i7 Automated Workstation, you can do the following:
* See these documents:
— Biomek™ i-Series Automated Workstation Hardware Reference Manual, Beckman Coulter™
Pub. No. B54474AA

— Biomek™ i-Series Automated Workstation Instructions for Use, Beckman Coulter™ Pub. No.
B54473AA

* For information on recovering a run, contact your Thermo Fisher Scientific field application
scientist.

* For additional information on Biomek™ i7 Automated Workstation hardware, error messages, or to
request service, contact Beckman Coulter™. Be sure to have the serial number of your workstation
available.
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Appendix E Troubleshooting
Runtime errors

Runtime errors

Note: If an error persists after following the troubleshooting guidelines, contact your field application
scientist.

Observation Possible cause Recommended action

Barcode not entered A barcode has not been | Enter missing barcodes to proceed.
entered in one or more

The following barcodes were not entered: fields.
Sample_1

Cold Tubes - Module 1 #1
Cold Tubes - Module 1 #2

Reagent barcodes are not correct Ensure that the correct reagent module

W t modul
rong reagent module bags are being scanned and try again.

; part numbers were
Cold Tubes - Reagent Module 1, Lot 1 barcode not valid. P/N #901711 expected.
Cold Tubes - Reagent Module 1, Lot 2 barcode not valid. P/N #901711 expected. entered,

This error can occur when the Verify Reagent
Module Barcodes option is enabled.

Duplicate sample plate barcode The same custom Ensure that a unique sample plate is
barcodes were used being entered.

Details: One or more records in the log files
more than once.

were found to contain barcodes from the
current plate set.

If the original barcode is not correct,
press Cancel to enter in the correct

e i T o barcode.
o

If you decide to keep the duplicate
barcode, press OK to proceed with the
Press OK to archive previous entry and proceed or press Cancel

tn edit the harcodes. run.

Duplicate sample plate barcodes were found in log file. W

[ ok [ Conl | Note: By selecting to keep the
duplicate barcode, the log file is
archived and saved in the Archive

This error can occur at the DNA folder. The current log indicates
amplification, fragmentation and precipitation, (Duplicate Plate Set) Record removed
reSUSpenSiOI’l and hybr|d|zat|0n preparation, by user plus the date, and continues
plate reassembly and QC, transfer samples appending future runs to the current
to hybridization tray, and GeneTitan™ reagent log file.

preparation steps.
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Runtime errors

Observation

Possible cause

Recommended action

Duplicate sample plate barcode

Details: One or more records in the log files
were found to contain barcodes from the
current plate set.

e
e —-——
E————

Duplicate sample plate barcodes were found in log file.

Press OK to archive previous entry and proceed or press Cancel
tn edit the harrodes.

[

H Cancel ]

This error can occur at the DNA

amplification, fragmentation and precipitation,
resuspension and hybridization preparation,
plate reassembly and QC, transfer samples
to hybridization tray, and GeneTitan™ reagent
preparation steps.

(continued)

A run was reprocessed.
For example, when
recovering from an
aborted run.

If the original barcode is not correct,
press Cancel to enter in the correct
barcode.

If you decide to keep the duplicate
barcode, press OK to proceed with the
run.

Note: By selecting to keep the
duplicate barcode, the log file is
archived and saved in the Archive
folder. The current log indicates
(Duplicate Plate Set) Record removed
by user plus the date, and continues
appending future runs to the current
log file.

Sample plate barcode not found

Details: No record of the input sample plate
barcode was in the log file.

| JavaScript Confirm -

Sample plate barcode [ TestBC11111 ] not found in log file.
Unable to verify amplification incubation time.
Press OK to proceed or cancel to rescan.

[ OK |[ Cancel ]

This error can occur at the fragmentation and
precipitation step.

The sample plate
was processed on a
different instrument.

Confirm that the correct sample plate
barcode has been entered, otherwise,
press Cancel to edit the barcode.

If the sample plate was amplified on a
different instrument, press Cancel, and
process it on the instrument where the
sample was originally processed.

If you decide to use the unfound
sample plate barcode, press OK to
proceed with the run.

A sample plate that was
never amplified was
used.

Confirm that the correct sample plate
barcode has been entered, otherwise,
press Cancel to edit the barcode.

If you decide to use the unfound
sample plate barcode, press OK to
proceed with the run.

DNA amplification less than 22 hours

Sample plate [ TestBC ] amplification incubation less than 22 hours. Unable to continue.

This error can occur at the fragmentation and
precipitation step.

Fragmentation and
precipitation is
attempted for the
sample plate that
has not completed
the minimum 22
hours of amplification
incubation.

Select Abort and wait for the
amplification incubation to finish (at
least 22 hours).
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Runtime errors

Observation

Possible cause

Recommended action

Precipitation barcodes are identical on one or
more of the plates

The following precipitation plates do not have unique barcodes:

Labware [Precip_1-Q1]
Labware [Precip_1-Q2]

In the example above, plates in the
Precip_1_Q1 and Precip_1_Q2 labware
positions are identical. This error can occur at
the fragmentation and precipitation step.

A plate is accidentally
double-scanned.

Verify that the precipitation plate
barcodes are all unique.

If all 4 barcodes are visually unique
but the error persists, try scanning

all 4 into Notepad (or any text

editor). Use the information in the text
editor to confirm that the scanned
barcodes match what is seen visually.
If not, enter the barcode manually
throughout this and subsequent steps
then proceed with the run

Custom barcodes are
used more than once.

Verify that the precipitation plate
barcodes are all unique.

If all 4 barcodes are visually unique
but the error persists, try scanning

all 4 into Notepad (or any text

editor). Use the information in the text
editor to confirm that the scanned
barcodes match what is seen visually.
If not, enter the barcode manually
throughout this and subsequent steps
then proceed with the run

The precipitation plates do not match the
order identified in the fragmentation and
precipitation step

Place plates with correct barcodes as indicated below.
[Line 901 12/13/2017,11:49:12 jacob.peete Resuspension and Hyb Prep,Complete

Position [ P17 ] requires barcode [ 4351635253 ]
Position [ P13 ] requires barcode [ 4351635252 ]
Position [ P18 ] requires barcode [ 4351635251 ]

This error can occur at the resuspension
and hybridization preparation, and plate
reassembly and QC steps.

Deck is loaded with
precipitation plates from
multiple fragmentation
and precipitation runs.

Gather and confirm that all 4
precipitation plates are associated
with the desired DNA Amplification
Sample_1 plate.

Follow the instructions in the error
message to place the correct plates on
the deck then proceed with the run.

The plates were from
the same fragmentation
and precipitation run,
but were placed in

one or more incorrect
positions on the deck.

Follow the instructions in the error
message to place the plate in the

correct position on the deck, then
proceed with the run.

Unable to verify precipitation plates

Details: No record of any of the scanned
precipitation plate barcodes was found in the
log file.

Unable to verify precipitation plates. Barcode query retumed no results.

This error can occur at the resuspension
and hybridization preparation, and plate
reassembly and QC steps.

Plates that were
processed on a
different instrument are
being used.

The only option is to select Abort to
abort the run.

1. If the plates were processed
on a different instrument, run
the plates on the instrument
where the samples were originally
processed.

2. Ensure that the correct
precipitation plate barcodes
are entered. Make necessary
corrections, then proceed with the
run.

174

Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7




Appendix E Troubleshooting

GeneTitan™ MC Instrument support files for troubleshooting

Observation

Possible cause

Recommended action

Sample plate barcode shows listed as
[Unknown]

v ||06/07/2018 v || — SAMPLE PLATE BARCODE — v |

Sample Plate [ALL USERS] [ SAMPLE PLATE BARCODE — ¥
— SAMPLE PLATE BARCODE —

1) Set up reagent reservoirs and tubes as indicated below

This error can occur at the GeneTitan reagent
preparation step.

The preceding
transfer samples to
hybridization tray step
was run with a sample
barcode which could
not be found in the log
file.

In the first drop-down list, select
Manual Entry, and type in a sample
plate barcode.

Samplg Plate | — SELECT USER — v || — DATE — v || — SAMPLE PLATE BARCODE — v
—SELECT USER —
1) Set up reagent [ALL USERS)] licated below

2) Enter or scan pl LA M=) bbove (Barcode Tracking enabled)

Stain tray barcodes invalid

Details: Part number on the stain trays are
not correct.

Stab P1 (Slnbéi_z'e} stain tray barcode not valid. P/N #501396 expected.
$2_P1 (Stain 2) stain tray barcode not valid. P/N #501394 expected.

Lig_P1 (Ligation) stain tray barcode not valid. P/N #501398 expected.
51-1 (Stain 1-1) stain tray barcode not valid. P/N #501279 expected.
51-2 (Stain 1-2) stain tray barcode not valid. P/N #501279 expected.

This error can occur when Verify GeneTitan
labware setup option is enabled.

Placement of one or
more stain trays is not
correct.

Verify the deck layout and ensure
that the stain trays are in the correct
position.

The stain tray type
being used is not
correct.

Verify that the deck layout is correct
and ensure that the correct stain tray
type is being used in each position.

Peltier is not reaching the target temperature

Details: This error is detected visually
when the temperature display on the
Peltier controller does not match the target
temperature.

Peltier does not have
sufficient cooling fluid.

See the INHECO™ user guide for
instructions on checking and filling the
cooling fluid.

Contact Beckman Coulter™ technical
support.

GeneTitan™ MC Instrument support files for troubleshooting

Log files

The different GeneChip™ Command Console™ (GCC) components generate log files. The logs provide
a record of the tasks performed by the different components, such as the migration tools and installer.
These log files provide useful information for troubleshooting problems. Sometimes these files are
required by your field application scientist (FAS), field service engineer (FSE), or the Thermo Fisher
Scientific call center to help with troubleshooting.

GeneChip™ Command Console™ log files

The following files are generated by the GeneTitan™ MC Instrument. All the GCC log files are from the
following path: C: \Command Console\Logs.

Log file type

Description

Systemlog.xml

XML file with system information.

DEC. log

Text file with information on the use of the Data Exchange Console (DEC).

DECError.log

Text file with information on errors created while using DEC.
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GeneTitan™ MC Instrument support files for troubleshooting

Other GeneChip™ Command Console™ files

The following GCC files and requests are sometimes used by FAS or FSE for troubleshooting.

* Library files (*.PARAMS, *.MASTER, *WORKFLOW, *.SMD, *.MEDIA) in
C:\Command Console\Library, excluding the large analysis library files (CDF, PSI, GRC).

* Provide a list of all sub folders and their contents under the library files folder that is in
C:\Command Console\Library. Ensure that there are no duplicate library files, as these files
can cause problems

* GCC system configuration file that is found at
C:\Command Console\Configuration\Calvin.System.config.

* Pending job order files that are in C: \Command Console\Jobs

* (Other GCC related information, such as
— The number of files under C: \Command Console\Data, including sub directory.
— If the system is a networked system or a stand-alone system.

— Other applications that are installed on the system, such as antivirus application, Microsoft™
Office™ , and Internet Explorer® versions.

GCC log files for GeneTitan™ MC Instrument systems

Log files for the GeneTitan™ MC Instrument control processes are placed in subdirectories of the
C:\Command Console\Logs\ folder. Thermo Fisher Scientific sometimes requests the following files
for troubleshooting.

GeneTitan™ MC Instrument fluidics

¢ C:\Command Console\Logs\96F\
— Subdirectories are named by date (for example, Log7-29-2016)
Collect all dated directories and contents from the time the GeneTitan™ application was
started, not just from the date of the event. Some logging goes into files from the date the
application started so these files can be critical for troubleshooting.

All the log directories from the date the run was started to the date of the event are essential.

® C:\Command Console\Logs\96F\FluidicErrorLog - all files in this directory.

GeneTitan™ MC Instrument imaging device

® C:\Affymetrix\GeneChipHTScanControlMC\Log - collect all dated directories and contents
from the time the GeneTitan™ application was started.

® C:\Affymetrix\GeneChipHTScanControlMC\RunLog - collect all dated directories and
contents from the time the GeneTitan™ application was started.
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Troubleshooting the GeneTitan™ MC Instrument

Troubleshooting the GeneTitan™ MC Instrument

This section provides instructions on how to identify and solve simple problems with the GeneTitan™
MC Instrument. If a problem or error occurs that is not listed in this chapter, contact Thermo Fisher
Scientific Technical Support for help.

For software errors that do not involve hardware crashes, the most common solution is to close or
exit the application, then restart it. If the same error occurs, close the application and power off the
computer, then restart. If the error still occurs, power off the GeneTitan™ MC Instrument, then restart.

Observation

Possible cause

Recommended action

Plate trapped in
the GeneTitan™
MC Instrument

Plate (or plate with lid)
not properly loaded in
drawer.

Notched edge of lid and

plate not aligned.

Gripper failed to retrieve

plate.

System requires
adjustment.

1. Restart the GeneTitan™ MC Instrument by unplugging
and reconnecting power cord.

2. Run the Unload Plates setup option.

3. If the plate remains trapped in the instrument, call
Thermo Fisher Scientific support.

Computer frozen

Too many processes
running.

Attempting to transfer
data while an array
plate is being scanned
(imaged).

Restart the computer and unload all of the plates.

* Plates in the hybridization station: finish hybridization off
line.

* Plate in the scanner: rescan using Scan Only function.

* Plate in fluidics: use Wash/Scan Resume to resume the
fluidics process.

IMPORTANT! Do not manually, or through the GCC
transfer utility, move any data associated with the current
plate that is being processed/scanned.

Hybridization
aborted

System-initiated abort:

power loss.
User-initiated abort:
— User error

— Other

If the array plate and hybridization tray are still clamped,
contact your local field service engineer with information on
the workstation model.

If the plate stack is moved to drawer 1:

Remove the plate stack and finish hybridization offline.

2. Return the hybridized array plate stack to the
GeneTitan™ MC Instrument and finish processing using
the Wash/Scan process.

Fluidics aborted

System-initiated abort:

power loss.

User-initiated abort:
incorrect protocol
selected.

Follow the recommendations and instructions under “Wash-
Scan Resume” on page 151.
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Troubleshooting the GeneTitan™ MC Instrument

Observation

Possible cause

Recommended action

Homing recovery
of gripped item

Indicates that an item is

in the gripper, and normal
startup of the GeneTitan™ MC
Instrument is not possible.
The item must be removed
from the instrument before
you can start processing
array plates.

Recommendation: click Yes.

If you click No, nothing occurs. Homing will not complete and
you will not be able to use the system.

The item that is held by the gripper is moved to either:
* Drawer 2—plates and trays

®* Trash Bin—covers

The drawer names reflect the location (left or right) and the
drawer number (1 through 6).

Examples:
Drawer2L_Hta_DOWN = Scan tray on left side of drawer 2
HtaHyb = Clamped hybridization tray and array plate

Drawer(n)L/R_Hta_DOWN where n is the drawer number and
L or R to indicate the left or right side.

The _Hta_ (second term) indicates that the item

held. An example is drawer1R_HtaHyb_DOWN indicating

it is an array plate with a hybridization tray or
Drawer2L_ScanHta_Pk_DOWN indicating it is an array plate
with a scan tray

Drawer not
retracted error

The drawer that is listed
in the message is not fully
closed.

Manually push the drawer back into the instrument until it is
fully closed. There are 2 stop positions with audible clicks.
Push until you hear the second click and the drawer is fully
seated.

Array registration
error message

The protocol file for the array
plate barcode could not be
found.

Check that the array plate barcode has been entered
correctly.

Ensure that the library files required for the type of array plate
you are using have been installed, and are installed in the
correct directory.

Restart the GeneTitan™ Instrument control software after
library files have been installed.

Insufficient disk
space notice

This message
appears when
you first initialize
the software
and instrument,
or when you
select arrays for
imaging.

There is not sufficient
memory on the computer
hard drive to save the data
from an array plate.

Free up sufficient disk space before starting imaging with the
GeneTitan™ MC Instrument.
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GeneTitan™ MC Instrument fluidic diagnostic messages

GeneTitan™ MC Instrument fluidic diagnostic messages

Observation

Possible cause

Recommended action

Failed prime

FAILED PRIME

Rinse failed on plate: S50032-]a0FEE N

[ Retry ][ Cancel ]

If this message is displayed during a
water wash step, array processing has
been compromised.

If this message is displayed during
cleanup, array processing is okay, but
cleanup will not be complete.

The fluid level is either too
low or the bottle is empty.

Always ensure that the GeneTitan™
bottles containing Axiom™ Wash
Buffer A and Axiom™ Water are above
the 50% mark when setting up the
system to process an array plate.

We recommend that all 600 mL of the
Axiom™ Wash Buffer B from the Axiom™
2.0 384HT Reagent Kit be emptied into
the GeneTitan™ Wash B bottle when
setting up the system to process a
plate. Using all 600 mL of the Axiom™
Wash Buffer B helps ensure that the
bottle is filled to more than the requisite
35% of Wash B bottle volume.

Fluidics diagnostic dispense error

HT96CC FLUIDIC DIAGNOSTIC gl

Filinkisznsorstate Failare on valve group BUFFERB_TO_WASHA
Prime ran out during fil operation:BUFFERE_TO_WASHA

Plate: 550032-345678922 000

Tirne: 6{16/2009 3:59:24 P

Fluidic process: CleanThenFilWashawithBuffers

*Possible causes for dispense failure include:

Bottle empty or fluid level too low. {Replenish bottle)

Bottle cap not secure, {Check al bottle caps are secure)

Clogged Filter. { Replace fiiter™);

Continuing due to time critical nature of the process. Fil cannot be quarantasd. Underfil was likely.

BUFFERXx = Buffer bottle A, B, or Rinse.

WASHx = Wash A or B reservoir in the
fluidics station.

i x|

PulseUntilSensorState Faiure on group PRIME_RINSE
Plate: S50032-34567892 2wy

Time: 6/16/2009 4:05:12 PM

Fluidic process: CleanThenFillw ashawithRinse

"Possible causes For dispense Failure include:

Eottle empty or Fluid level koo low. (Replenish battle)
Bottle cap not secure. (Check all bottle caps are secure)
Clogged filter.  Replace filker");

Reagent bottle is empty or
too low.

Replenish fluid level in the Rinse or
Wash Bottle B to the 1-L mark. Do not
overfill.

IMPORTANT! Only replenish bottles
when prompted by the UI.

Replenishing during fluidic processing
can cause system malfunction including
overflowing inside the system and more
problems. The only thing to do when a
plate is running is to ensure that bottle
caps are secure.

Replenish fluid level in Wash Bottle A to
2L

GeneTitan™ reagent bottle
cap is loose.

Fasten the bottle cap.

The GeneTitan™ reagent
bottle filter is clogged.

Replace the filter. See “Bottle filter
replacement” on page 182.
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GeneTitan™ MC Instrument fluidic diagnostic messages

Observation Possible cause Recommended action
Loss in CDA pressure The instrument experienced | Ensure that all lines are connected and
a loss in Clean Dry Air turned on.
i _
(CDA) pressure. Ensure that the facility CDA or the
142042010 10:09:45 Ak I .
System lnst CDA. pressure. portable CDA compressor is in working
Verify lines are connected and turned OM. . . .
System serial number: HT96Fidic-0000000 condition. See the GeneTitan™ Multi-
Channel Instrument Site Preparation
4 Guide for the portable compressor

model that has been verified with the
GeneTitan™ MC Instrument.

Contact your local field application
specialist and notify the engineer about
the error message.

Leak detected * System malfunction. Contact Thermo Fisher Scientific
I;ealﬁcc;?::ztzrgupe::én;re]d '?:n o e The GCC application su!oport. The system gannot be useq for
ppl p yu L being manually closed fluidic processing until the problem is
fluidic process, such as priming, filling, ing Windows™ Task | resolved.
draining, is performed. Leak detection is using Yvin O\_NS "’.‘S
a hard-wired sensor that shuts off fluid Manager during a fill
flow without software control. Leaks are operation resulting in
normally confined to the drip pan found an application exit
inside the system. without stopping flow.
W1 FE22:59 Leak monitor
.
g:;zz ?:E\B;:';!dmﬂré g::ﬁ:w:;.de of the system has either detected a leak, is unpowered or requires adjustment
e e e ot o o o s
ST g 5% e
W LEAK DETECTED
Filter change required error message One or more reagent bottle | Change all 3 reagent bottle filters, even
The software displays warning messages | filters are clogged or worn | if only 1 is reported as problematic. See
for the filter in each reagent bottle when | ot “Bottle filter replacement” on page 182.

it detects a problem or shows a trend

of increased fill times during fluid fill
operations. When an error is detected,

a message box is displayed along with
the information on the specific operation
(dispense-related check or fill-related
check).
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GeneTitan™ Multi-Channel
Instrument care

Overview

This chapter provides instructions on caring for and maintaining the instrument and on troubleshooting
if problems arise.

® The GeneTitan™ Multi-Channel (MC) Instrument must be positioned on a sturdy level bench away
from extremes in temperature and away from moving air.

* Always run a Shutdown protocol when the instrument is off or unused overnight or longer to
prevent salt crystals from forming in the fluidics system.

* Always use deionized (DI) water to prevent contamination of the lines. Swap out old buffers with
freshly prepared buffer at each system startup.

IMPORTANT! Before performing maintenance power off the instrument to avoid injury if an electrical
malfunction occurs.

Maintenance

The GeneTitan™ family of instruments requires little in the way of customer maintenance. The
instruments must be kept clean and free of dust. Dust buildup can degrade performance. Wipe the
exterior surfaces clean using a mild dish detergent solution in water. Do not use ammonia-based
cleaners or organic solvents such as alcohol or acetone to clean the system because they can damage
the exterior surfaces.

The following tasks must be performed regularly to help ensure that the imaging device remains in
working order.

Monthly

Wipe down the outer surface of the imaging device with a dry cloth.

Every 6 months
1. Replace the cooling fan air filters at the rear of the instrument.

2. Replace the Micropore™ filters in the Wash A, Wash B, and Rinse bottles. If you run 4-8
plates/week, then replace the Micropore™ filters more frequently.
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Outer enclosure fan filters

Outer enclosure fan filters

Cleaning schedule

The GeneTitan™ fan filter cartridge must be cleaned at least every 90 days of service. Note that in
some service locations, the presence of excessive dust or particulate matter can require cleaning the
cartridge more often than 90 days.

A plugged filter cartridge can cause excessive temperatures in the machine that can cause unwanted
evaporation of GeneTitan™ reagents.

Y

Figure 55 GeneTitan™ fan filter cartridge.

Clean the GeneTitan™ MC Instrument fan filter

Contact your field service engineer for GeneTitan™ fan filter ordering information when new filters are
required.

Number of filters that are required per GeneTitan™ MC Instrument: 3

1. Slide the filter cartridge from the fan filter cartridge at the rear of the GeneTitan™ MC Instrument.
2. Submerse the filter in clean DI water. Rinse, then agitate gently to dislodge material.
3. Remove from water and dry with clean compressed air or towels.

4. When the filter cartridge is dry to the touch, reinstall the cartridge in the GeneTitan™ MC
Instrument.

Bottle filter replacement

The bottles that are used in GeneTitan™ MC Instrument contain a filter to remove particulates that can
exist in the buffers and DI water. The filters in the 3 GeneTitan™ fluidics bottles (Wash A, Wash B, and
Rinse) must be replaced when the filters are clogged.

When the instrument detects an increase in the amount of time that is required to perform the

fill operations, a Filter Change Required message window opens. The message window provides
information on fluid dispense errors that were detected for any of the bottles during a dispense
operation. All 3 filters must be changed when a warning is displayed for any of the 3 filters.
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Bottle filter replacement

Note: The reagent bottles are depressurized when this warning message is displayed. It is safe to
change the filters in all 3 fluidic bottles when this message is displayed.

After changing the filters in all 3 bottles using the procedure that is described in this section, press

the Yes button to continue. If you select to ignore the error message, press the No button. This
warning message is displayed each time GeneChip™ Command Console™ instrument control software
is launched. You can also experience data quality problems when particulate matter is not trapped by
the filters because they are clogged.

We recommend having 3 spare filters on hand in the event the filters must be replaced.

Figure 56 Components of the reagent buffer supply line and filter.

@ Buffer supply line
() Filter holder

() Filter

Remove and inspect the reagent bottle filters
1. Loosen, then remove the cap on the bottle.
2. Carefully remove the filter from the end of the filter body (see Figure 56).

3. Visually inspect the filter. If one of the filters appears to have a concentration of dirt or contaminate
in it, discard it. Replace the filter in all 3 reagent bottles with a new one.

4. Replace the cap on the reagent bottle when finished.
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Xenon lamp replacement in the GeneTitan™ MC Instrument
Replace fluidics bottle filter

GeneTitan™ Fluidics Bottle Filter part details:
Thermo Fisher Scientific Cat. No. 01-0671

1. Loosen the reagent bottle cap, then remove the draw tube.
2. Carefully remove the filter from the end of the filter bodly.
3. Insert a new filter into the end of the filter holder.

4. Replace the cap on the reagent bottle, then tighten it.

5. Repeat these steps for each bottle.

IMPORTANT! Replace 1 filter at a time to ensure the correct connection of the buffer supply tube
to its respective bottle. The color of the buffer supply tubing matches the bottle color code.

Xenon lamp replacement in the GeneTitan™ MC Instrument

This section applies to the GeneTitan™ MC Instrument.

After the normal life expectancy of the lamp has expired, the software application alerts you to the

requirement to replace the lamp. The lamp replacement procedure is simple but good health and safety
precautions must be followed.

CAUTION! Do not try to replace the lamp when a plate is being processed either in the fluidics or
scanner system.

\

Lamp life/imaging device status notices

The Imaging Device Status pane displays lamp life and imaging device status notices for the
GeneTitan™ MC Instrument.

In normal operation, the pane displays the hours of life that is left in the lamp.

Imaging Device Status

Barcode

Estimated Time Remaining

Lamp Life Remaining 163 hours

A red or yellow notice is displayed when the lamp life is getting short.
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Appendix F GeneTitan™ Multi-Channel Instrument care
Xenon lamp replacement in the GeneTitan™ MC Instrument

Imaging Device Status

Barcode

Estimated Time Remaining

A red notice is also displayed when the imaging device is offline.

Imaging Device Status

Barcode

Estimated Time Remaining

Note: The 300-watt xenon lamp in the GeneTitan™ MC Instrument is warranted for 500 hours. The
instructions to remove and replace the lamp are found in “Remove the xenon lamp” on page 186, and
“Replace the xenon lamp” on page 187. After changing the lamp, you must manually reset the lamp life
clock.
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Xenon lamp replacement in the GeneTitan™ MC Instrument

Remove the xenon lamp

A
/ \\\ WARNING! Power off the lamp using the switch in the rear of the unit and then disconnect the
—_— power cord. Allow to cool before attempting to replace the lamp.

1. Unscrew the 4 retaining bolts with your fingers.

WARNING -- HIGH VOLTAGE

DISCONNECT POWER BEFORE

REMOVING LAMP ACCESS PANEL

(1) Remove these 4 bolts.
2. Remove, then set aside the warning cover to reveal the xenon lamp that is contained inside.

3. Place a hand on each side of the blue plastic flange, then lift out the lamp in a vertical motion.
Both hands must be used to remove the lamp. Apply equal pressure on each side of the lamp and
gently lift.
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Appendix F GeneTitan™ Multi-Channel Instrument care
Xenon lamp replacement in the GeneTitan™ MC Instrument

Replace the xenon lamp

A new Cermax™ Xenon Arc Lamp (Cat. No. 01-0740) is required for this procedure.

IMPORTANT! Ensure that you install the lamp in the correct orientation.

1. Hold the lamp by the blue plastic flanges. Ensure that the lamp bulb faces inward toward the rear
heat sink on the unit, and then vertically lower the lamp to install.

®

@ Xenon bulb faces away from the fan and towards the heat sink.
@ Heat sink on the Lambda LS unit.

2. Replace the warning cover, then hand tighten the bolts.
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Appendix F GeneTitan™ Multi-Channel Instrument care
Xenon lamp replacement in the GeneTitan™ MC Instrument

Reset the lamp life counter

Using the GCC GeneTitan Instrument Control module accessed from the Launcher window, you
must alert the software that the lamp has been replaced so that the hours of the lamp counter are reset.
This menu option is only available when the system is not processing any plates.

1. Select Tools » Reset Counter for Lamp Life Remaining.

Bl GCC GeneTitan Instrument Control
File | Tools | Help

Shutdown System
Check Available Disk Space

S

Reset Counter for Lamp Life Remaining |
System Siatus [ SwstemSetup |

[ Wark Flow

" Barcode | Plate Type | Location | Hyh. Status |

2. Click Yes in the message window to reset the counter.

188 Axiom™ 2.0 Assay 384HT Array Format Automated Workflow User Guide— Biomek™ i7



Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.
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Appendix G Safety
Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with
sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer
cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack
and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the
cover fastened and the handles locked in the upright position.
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Appendix G Safety
Biological hazard safety

Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
cdc.gov/labs/bmbl

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Publication

Document Description
number
Axiom™ 2.0 Assay 384HT MANO0O017556 Provides guidance on reagents, instruments, and supplies
Array Format Automated required to run the Axiom™ 2.0 Assay 384HT Array Format
Workflow Site Preparation Automated Workflow on the Biomek™ i7.
Guide—Biomek™ i7
Axiom™ 2.0 Assay 384HT MANO0019790 An abbreviated reference for the target preparation step of the
Array Format Automated Axiom™ 2.0 Assay 384HT Array Format Automated Workflow
Workflow Quick Reference— on the Biomek™ i7, running the Biomek™ method v1.1. This
Biomek™ i7 Method v1.1 document is for experienced users.
Axiom™ 384HT and Mini 96 MANO0017719 An abbreviated reference on the genomic DNA sample
gDNA Sample Preparation preparation protocol. This document is for experienced users.
Quick Reference
GeneTitan™ MC Protocol for MANO0017596 An abbreviated reference for processing Axiom™ 384HT Array
Axiom™ 384HT Array Plate Plates with the GeneTitan™ MC Instrument. This document is
Processing Quick Reference for experienced users.
GeneTitan™ Multi-Channel MANO0027694 The GeneTitan™ Multi-Channel (MC) Instrument automates
Instrument User Guide array processing from target hybridization to data generation by
combining a hybridization oven, fluidics processing, and state-
of-the-art imaging device into a single benchtop instrument.
This document detailing the use, care, and maintenance for the
GeneTitan™ MC.
GeneTitan™ Multi-Channel MANO0025571 Provides guidance on creating and maintaining the proper
Instrument Site Preparation environment required for the GeneTitan™ MC Instrument.
Guide
Recommended Alternative MANO0019853 A quick reference document identifying recommended

Microarray Consumables
Quick Reference

alternative replacement consumables for use in microarray
assays.
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Appendix H Documentation and support
Related documentation

(continued)
Document Publication Description
number
Software and analysis

GeneChip™ Command MANO0027771 This user guide provides instructions on using Applied

Console™ User Guide Biosystems™ GeneChip™ Command Console™ software (GCC)
used to control GeneChip™ instrument systems. GeneChip™
Command Console™ software provides an intuitive set of tools
for instrument control and data management used in the
processing of GeneChip™ arrays.

Axiom™ Analysis Suite User MANO0027928 Axiom™ Analysis Suite advances genotyping data analysis

Guide with a single-source software package to enable complete
genotyping analysis of all Axiom™ arrays. This document
provides instructions on using the software to automate the
Best Practices Workflow to deliver accurate results in a single
step for export in PLINK, VCF, or TXT formats.

Axiom™ Genotyping Solution MANO0018363 This guide provides information and instructions for analyzing

Data Analysis User Guide

Axiom™ genotyping array data. It includes the use of Axiom™
Analysis Suite, Applied Biosystems™ Analysis Power Tools
and SNPolisher R package to perform quality control analysis
(QC) for samples and plates, SNP filtering before downstream
analysis, and advanced genotyping methods.

Beckman Coulter™ and other

third-party documentation

Biomek™ i-Series Automated
Workstation Hardware
Reference Manual

B54474AA

Biomek™ i-Series Automated
Workstation Instructions for
Use

B54473AA

Biomek™ i-Series Automated
Workstation Tutorials

B54475AA

Reference documents related to using and troubleshooting
the Biomek™ i7 Automated Workstation. After installing the
Biomek™ Software, these documents are found by clicking
Start » All Programs » Beckman Coulter Manuals.

Zebra™ DS9808 Digital
Scanner Product Reference
Guide (Barcode Scanner)

72E-112999-11

Reference document for using the Zebra™ DS9808 Digital
Scanner. A PDF version is available from the Zebra website.
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Appendix H Documentation and support
Customer and technical support

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers

* Product support information
- Product FAQs

— Software, patches, and updates
— Training for many applications and instruments
® Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and its affiliates warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/
home/global/terms-and-conditions.html. If you have questions, contact Life Technologies at
www.thermofisher.com/support.
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